# TABLE OF CONTENTS

1. ABOUT FILEHOLD .................................................................................................................. 1

2. ACCESSING FILEHOLD ........................................................................................................ 1
   2.1. FILEHOLD DESKTOP APPLICATION (FDA) .............................................................. 1
   2.1.1. FDA CONNECTION OPTIONS .............................................................................. 2
   2.1.2. LOGGING INTO THE FDA ................................................................................... 3
   2.1.3. FDA MENUS AND TOOLBARS ........................................................................... 4
   2.1.4. FDA SHORTCUT KEYS ...................................................................................... 5
   2.1.5. SHARING INBOXES ........................................................................................... 6
   2.2. WEB CLIENT .................................................................................................................. 6
       2.2.1. WEB CLIENT MENUS AND TOOLBARS .......................................................... 7
   2.3. LOGGING IN WITH MULTI-FACTOR AUTHENTICATION ............................................ 9
   2.4. MICROSOFT OFFICE APPLICATIONS ...................................................................... 12
       2.4.1. WORKING WITH DOCUMENTS USING MICROSOFT OFFICE APPLICATIONS ...... 13
   2.5. LOST OR FORGOTTEN USERNAME AND/OR PASSWORD .......................................... 14

3. UNDERSTANDING ROLES, PERMISSIONS, AND ACCESS TO THE LIBRARY ...................... 17
   3.1. DOCUMENT PERMISSION ICONS .............................................................................. 21

4. LIBRARY TREE OVERVIEW .................................................................................................. 23

5. INBOX (SEND TO LIBRARY) .................................................................................................. 25

6. MY FILEHOLD ......................................................................................................................... 27
   6.1. MY FAVORITES ............................................................................................................. 27
   6.2. CHECKED OUT DOCUMENTS ..................................................................................... 27
   6.3. DOCUMENT ALERTS .................................................................................................... 27
   6.4. DOCUMENT REMINDERS .......................................................................................... 27
   6.5. RECENTLY ADDED AND RECENTLY ACCESSED ..................................................... 28
   6.6. CALENDAR .................................................................................................................. 28
   6.7. RECENT FOLDERS ....................................................................................................... 29

7. SEARCHING ............................................................................................................................. 30
   7.1. HOW TO ACCESS SEARCH......................................................................................... 30
   7.2. HOW FILEHOLD SEARCHES FOR DOCUMENTS ....................................................... 31
       7.2.1. GENERAL USAGE ............................................................................................. 32
       7.2.2. NOISE WORDS ................................................................................................. 32
       7.2.3. FULL TEXT SEARCH - WILDCARD SEARCH LIMITATION SETTING ................. 33
# Table of Contents

7.3. **SEARCH REQUEST TYPES** ......................................................................................................................... 33
7.3.1. **WORDS AND PHRASES** ........................................................................................................................ 35
7.3.2. **AND CONNECTOR** ................................................................................................................................. 35
7.3.3. **OR CONNECTOR** ....................................................................................................................................... 35
7.3.4. **W/N CONNECTOR (PROXIMITY SEARCH)** ............................................................................................. 35
7.3.5. **NOT AND NOT W/NUMBER (PROXIMITY SEARCH)** ................................................................................ 36
7.4. **SIMPLE SEARCHES (FULL TEXT SEARCH)** ................................................................................................. 36
7.5. **ADVANCED SEARCHES** ............................................................................................................................ 37
7.6. **SEARCH OPERATOR SELECTORS** ............................................................................................................... 42
7.7. **SAVED SEARCHES** ...................................................................................................................................... 43
7.7.1. **REGULAR SAVED SEARCHES** ................................................................................................................ 44
7.7.2. **QUICK SEARCHES** ................................................................................................................................... 44
7.7.3. **EMPTY SEARCH TEMPLATES** .................................................................................................................. 45
7.8. **USING FASTFIND** ........................................................................................................................................ 46
7.9. **SEARCHING FOR PREVIOUS VERSIONS OF A DOCUMENT** ........................................................................ 47
7.10. **SEARCHING FOR DOCUMENTS IN A WORKFLOW** .................................................................................... 47
7.11. **INTEGRATE FILEHOLD SEARCH WITH AN EXTERNAL APPLICATION** .......................................................... 47

8. **VIRTUAL FOLDERS** ....................................................................................................................................... 52

9. **THE LIBRARY STRUCTURE** ............................................................................................................................ 54
9.1. **CABINETS** .................................................................................................................................................... 55
9.2. **DRAWERS** .................................................................................................................................................... 55
9.3. **FOLDER GROUPS** ......................................................................................................................................... 55
9.3.1. **CALCULATING THE FOLDER GROUP STATISTICS** ..................................................................................... 57
9.4. **FOLDERS** ..................................................................................................................................................... 57
9.4.1. **VIEWING THE FOLDER STATISTICS** ......................................................................................................... 62
9.4.2. **CREATING AUTO-TAGGED FOLDERS** ....................................................................................................... 62

10. **DOCUMENT ACTIONS AND FUNCTIONS** .................................................................................................... 64
10.1. **ADDING DOCUMENTS TO FILEHOLD** ...................................................................................................... 69
10.2. **DRAGGING AND DROPPING DOCUMENTS** ............................................................................................... 69
10.3. **ADDING DOCUMENTS DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION** ................................. 70
10.4. **ADDING DOCUMENTS THROUGH THE FILEHOLD WEB CLIENT** ............................................................ 71
10.5. **ADDING DOCUMENTS FROM MICROSOFT OUTLOOK** ............................................................................... 72
10.6. **ADDING DOCUMENT FROM MICROSOFT OFFICE APPLICATIONS** ............................................................. 75
10.7. **ADDING OFFLINE DOCUMENTS** ............................................................................................................... 76
10.8. **EXPORTING DOCUMENTS IN A VIEW TO A CSV FILE** ............................................................................... 77
10.9. ENTERING METADATA FOR A DOCUMENT ............................................................... 78
  10.9.1. ENTERING METADATA FOR A SINGLE OR MULTIPLE DOCUMENTS ......................... 80
  10.9.2. ENTERING METADATA USING CLICK TO TAG ...................................................... 83
  10.9.3. ENTERING METADATA USING DATABASE LOOKUPS ............................................. 87
  10.9.4. EDITING METADATA ............................................................................................. 90
  10.9.5. COPYING METADATA ............................................................................................ 90
  10.9.6. USING THE DOCUMENT URls ................................................................................. 90
  10.10. SETTING THE DESTINATION FOLDER ....................................................................... 91
  10.11. DELETING FILES ................................................................................................... 92
  10.12. CHECKING IN AND CHECKING OUT DOCUMENTS .................................................. 92
  10.12.1. CHECKING IN DOCUMENTS ................................................................................ 93
  10.13. COPYING OR MOVING FILES .................................................................................. 94
  10.14. MAKING A LOCAL COPY ........................................................................................ 95
  10.15. EMAILING, AND EMAILING AND CHECKING OUT DOCUMENTS ............................ 95
  10.16. LINKING DOCUMENTS ............................................................................................ 98
  10.17. CHANGING THE DOCUMENT VERSION OWNER ...................................................... 100
  10.18. CREATING SHORTCUTS TO DOCUMENTS ............................................................... 100
  10.19. RENAMING DOCUMENTS ....................................................................................... 101
  10.20. EXPORTING DOCUMENTS IN THE FDA .................................................................. 101
  10.21. DOWNLOADING DOCUMENTS TO A LOCAL FOLDER ............................................. 102
  10.22. VIEWING VERSION HISTORY .................................................................................. 103
  10.22.1. VIEWING PREVIOUS VERSIONS OF A DOCUMENT ................................................ 103
  10.22.2. DELETING PREVIOUS VERSIONS .......................................................................... 103
  10.22.3. REINSTATING A PREVIOUS VERSION AS THE LATEST VERSION .......................... 104
  10.22.4. VIEWING EDITS TO METADATA FOR OLDER DOCUMENT VERSIONS ................ 105
  10.22.5. VIEWING THE DOCUMENT USAGE OF DOCUMENT VERSIONS ............................ 105
  10.22.6. VIEWING THE SIGN OFF SHEET .......................................................................... 105
  10.22.7. VIEWING WORKFLOW REVIEWS AND APPROVALS .......................................... 106
  10.23. SETTING DOCUMENT ALERTS AND REMINDERS .................................................. 107
  10.23.1. MANAGING ALERTS AND REMINDERS .............................................................. 107

11. LIBRARY ARCHIVE ....................................................................................................... 110

12. USING THE DOCUMENT TRAY .................................................................................... 111

13. USING THE DOCUMENT VIEWERS ............................................................................... 113
  13.1. FULL AND PARTIAL SCREEN VIEWS IN THE FDA ..................................................... 113
  13.2. PDF/IMAGE VIEWER ................................................................................................ 114
13.2.1. MODIFYING A PDF OR TIFF FILE ................................................................. 116
13.2.2. MODIFYING AN IMAGE FILE ................................................................. 117
13.2.3. OTHER ACTIONS OF THE PDF/IMAGE VIEWER ......................................... 118
13.3. FILEHOLD VIEWER LEVEL 1 AND 2 ............................................................ 118
13.3.1. FILEHOLD VIEWER LEVEL 1 AND 2 – PAGE MANIPULATION ....................... 120
13.3.2. FILEHOLD VIEWERS LEVEL 1 AND 2 – HIGHLIGHT SEARCH RESULTS ........... 123
13.3.3. FILEHOLD LEVEL 2 VIEWER – ANNOTATIONS ........................................ 124
13.3.4. FILEHOLD VIEWERS LEVEL 1 AND 2 – PUBLISH AS PDF ............................ 126

14. ASSEMBLING DOCUMENTS .............................................................................. 127
   14.1. USING TAGS WHEN ASSEMBLING DOCUMENTS ........................................... 131
   14.2. BATCH JOBS REPORT ..................................................................................... 133
   14.3. HOW TO MANIPULATE THE BATCH JOB REPORT VIEW ................................. 134

15. SETTING PREFERENCES ................................................................................. 135
   15.1. USER PREFERENCES ...................................................................................... 136
   15.2. VIEW PREFERENCES .................................................................................... 142
       15.2.1. CREATING AD-HOC VIEWS ................................................................. 145
   15.2.2. SHOWING THE REVIEW OR APPROVAL STATUS IN THE FOLDER VIEW .... 146
   15.2.3. SETTING THE DEFAULT CABINET DRAWER, FOLDER GROUP, VIRTUAL FOLDER, OR SAVED SEARCH VIEW ... 146
   15.3. ALERT PREFERENCES .................................................................................... 147
   15.4. WORKFLOW PREFERENCES .......................................................................... 148
   15.5. FASTFIND PREFERENCES ............................................................................. 148
       15.5.1. CHANGING THE FASTFIND KEYBOARD SHORTCUTS ............................... 150
   15.6. RESET MY PASSWORD (WEB CLIENT) .......................................................... 150

16. WORKING DOCUMENTS .................................................................................... 152

17. WATCHED FOLDERS ....................................................................................... 154

18. VIEWING ALL FILES IN TRANSFER ............................................................... 156

19. REFRESHING THE FILEHOLD SYSTEM ......................................................... 157

20. ACCESSING SYSTEM AND LIBRARY ADMINISTRATION .................................. 157

21. VIEWING FILEHOLD REPORTS ....................................................................... 157

22. FILEHOLD HELP .............................................................................................. 158

INDEX .................................................................................................................. 159
1. ABOUT FILEHOLD

FileHold is a document management software system that is easy to use, easy to install, and is affordable for small to large organizations. It integrates with existing applications and enriches Microsoft SharePoint deployments. Features include web access, search, version control, tagging, workflow, secure user rights, mark up and annotations, redaction, scanning, and OCR and indexing.

Records Management features allow records to be converted to archives, put into legal hold, or be scheduled for final disposition.

2. ACCESSING FILEHOLD

You are able to access FileHold many ways:

- **Web Client** via a web browser.
- **FileHold Desktop Application** (FDA)
- **Microsoft Office applications** including Word, Excel, Outlook, and PowerPoint
- **Mobile FileHold** through your mobile device such as an iPhone or Android

Access to files can be gained through any of the methods by users with a valid FileHold account.

Access via the web client can occur using LAN, WAN, an Intranet or over the Internet. Working with files via the web client does not require installation of our document management software. However, to access the system via the FileHold Desktop Application (FDA) or Microsoft Office applications, users will be required to install FDA on their computer.

The web client and the FDA interface are very similar. You can use either to access the document Library but it is recommended that you generally use FDA as it is faster than going over the web and has more advanced functions than the web client. See a list of differences between the Web Client and FDA.

2.1. FILEHOLD DESKTOP APPLICATION (FDA)

The FileHold Desktop Application (FDA) has a very simple, intuitive and familiar Library structure similar to your traditional filing cabinets (cabinets > drawers > folders > documents) and Microsoft Windows Explorer folder hierarchy.
You may have your connection settings set to automatically log into FileHold when you start the FDA. If you have not selected that option, you will need to login manually.

2.1.1. FDA Connection Options

In order to connect to the FileHold server via the web client, FDA, or Microsoft Office applications, you must ensure that you have entered the correct connections settings. The connection settings are set in the FDA. You must have your username, password, know whether it is a locally managed account or domain (Active Directory) account, and the URL path to the FileHold server.

TO SET THE FDA CONNECTION SETTINGS

1. Open the FileHold Desktop Application (FDA) and select File > FileHold Connection Options.

2. Select the following options that you want to enable:
   - Automatically run FileHold application when I logon to Windows — This option will automatically start up FileHold after you log into your computer.
   - Automatically logon to FileHold Library when Desktop Application starts — This option will automatically log you in after you launch the FDA. You do not need to enter your username and password.
• Remain logged in even if no activity is performed — This option keeps your account logged into the system even if you are not using it. This is dependent upon the settings made by the system administrator. This option can only be set when logged into the FDA and may be locked down by a system administrator.

3. Select one the following options:
   • Always prompt for credentials — You will always need to log in with a username and password.
   • Use my windows account username and password to logon — This uses your Microsoft Windows account username and password to login. You will need to ask your system administrator which type of account you are using.
   • Use the following username and password to logon — Your system administrator will provide you with a username and password. Enter the username and the password twice.

4. Select the default domain:
   • Local FileHold Account — Select this option if a username and password was provided by your system administrator.
   • “Domain Name” — Select this option if you are using your Microsoft Windows user account to login to FileHold.

5. Enter the FileHold Server URL. The URL will be given to you by your system administrator and should be in the format
   http://yourcompanyservenamername/FH/FileHold
   or
   https://yourcompanyservenamername/FH/FileHold

6. Enter the number of maximum simultaneous transfers. This is the number of documents that can be uploaded or downloaded at a time. This number should be kept at 1. **NOTE:** This option may be locked down by your system administrator.

7. Select the Share my Inbox with others check box if you want to share your Inbox with other users of the same local computer. See Sharing Inboxes for more information.

8. Click Test URL. If the server URL is correct, you will receive a “Connection Successful” message.

9. Click Test Logon. If the username and password are correct, you will receive a “Logon Successful message.”

10. Click OK.

2.1.2. Logging into the FDA

Ensure that the **connection options** have been configured prior to logging in. You may have your connection settings set to automatically log into FileHold when you start the FDA. If you have not selected that option, you will need to login manually.

Two-factor authentication may have been configured for your system. See **Multi-Factor Authentication** for more information on how to log in if this has been enabled for your system.

**TO LOG INTO FDA**

1. Open the FDA. If there is not a shortcut to FDA on your desktop, go to **Start > Programs > FileHold > FileHold Desktop Application**.

2. Select one of the following options:
• Go to File > Logon to FileHold Server as username — This uses your stored Microsoft Windows or locally managed username and password.

• Go to File > Logon to FileHold Server as... — This allows you to login using an alternative user name and password than the one that is stored in the connection options. Enter a username, password, and select a domain. Click OK.

3. You are now logged into FileHold. Click OK to close the Welcome Screen.

• Select the check box on the Welcome Screen to not display this screen when FDA starts. You can re-enable this screen in the User Preferences.

2.1.3. FDA Menus and Toolbars

The FDA has several methods in which functions can be performed.

• The FileHold toolbar that can be used to perform operations on single or batch (many documents at once) documents such as check out or get a local copy.

• A right-click context sensitive menu where only those functions that can be performed will be available to use.

• The main menu bar where other functions of the FDA can be performed.

The following table describes the functionality of the FDA FileHold Toolbar buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Add File]</td>
<td>Add a file to Library</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td>![Make a local copy]</td>
<td>Makes a copy of the documents to the local user computer.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>![Check out]</td>
<td>Checks out a document for editing.</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Description</strong></td>
<td><strong>Permissions Needed</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td><img src="Image" alt="Link documents" /></td>
<td>Creates a link between two or more documents.</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td><img src="Image" alt="Delete" /></td>
<td>Deletes a document from the Library. Deleted documents can be recovered by a library administrator before a set amount of time. See the <em>Library Administration Guide</em>.</td>
<td>Users with Publisher plus Delete rights or higher.</td>
</tr>
<tr>
<td><img src="Image" alt="Email" /></td>
<td>Emails the document as an attachment or as a link in the body of an email.</td>
<td>Users with Publisher rights or higher and email settings have been enabled by the library administrator.</td>
</tr>
<tr>
<td><img src="Image" alt="Check out and Email" /></td>
<td>Checks the document out and sends it in an email attachment or as a link in the body of an email.</td>
<td>Users with Publisher rights or higher and email settings have been enabled by the library administrator.</td>
</tr>
</tbody>
</table>

### 2.1.4. FDA Shortcut keys

The following are a list of the hotkeys (shortcut keys) found in the FileHold Desktop Application.

<table>
<thead>
<tr>
<th><strong>Shortcut Key</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + L</td>
<td>Performs a database lookup. Can only be used when the metadata panel is in edit mode and the Lookup button is available.</td>
</tr>
<tr>
<td>Alt + N</td>
<td>Saves the metadata values and moves to the next document in the list (Save and Next). Can only be used when the metadata panel is in edit mode.</td>
</tr>
<tr>
<td>ALT + Shift + S</td>
<td>Saves the metadata in the metadata pane.</td>
</tr>
<tr>
<td>Alt + T</td>
<td>Invokes Click To Tag when in the metadata panel.</td>
</tr>
<tr>
<td>CTRL + C</td>
<td>Copies information about selected documents from the documents grid to Clipboard.</td>
</tr>
<tr>
<td>CTRL + Shift + O</td>
<td>Adds an offline document</td>
</tr>
<tr>
<td>CTRL + Shift + R</td>
<td>Opens the report viewer.</td>
</tr>
<tr>
<td>CTRL + Shift + V</td>
<td>Opens the document viewer.</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Adds files from the Clipboard to the current folder or Inbox. Files can be selected in Windows Explorer and copied using CTRL + C (the source files will not be deleted after uploading) or CTRL + X (the source files will be deleted).</td>
</tr>
<tr>
<td>Shortcut Key</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CTRL+Double-Click</td>
<td>Opens the document in its native application and checks out the document from the Library at the same time.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Cursor moves to simple “Google” like Search bar.</td>
</tr>
<tr>
<td>CTRL+Shift+A</td>
<td>Adds a file to the Library.</td>
</tr>
<tr>
<td>CTRL+Shift+F</td>
<td>Adds a folder to the Library.</td>
</tr>
<tr>
<td>CTRL+Shift+L</td>
<td>Logoff from FileHold.</td>
</tr>
<tr>
<td>CTRL+Shift+P</td>
<td>Show/hide metadata and properties pane.</td>
</tr>
<tr>
<td>CTRL+Shift+T</td>
<td>Show/hide the document tray.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Opens a document in its native application but does not check it out.</td>
</tr>
<tr>
<td>F5</td>
<td>Refreshes the screen.</td>
</tr>
</tbody>
</table>

2.1.5. Sharing Inboxes

When importing documents into FileHold, you can now share the contents of your Inbox with other users if you have sufficient rights.

Documents in the Inbox can be shared between users on the same computer. Sharing your Inbox allows others to file the contents of your Inbox on your behalf. For example, if there is a dedicated scanning station with several people scanning documents to be added into FileHold, all users who can log into the Windows environment of that scanning station will be able to file all the scanned documents in the Inbox. This is because the Inbox is shared between all the users who can log in with a Windows user account.

You can set whether you want to share your Inbox in the Connection Options window. Note that if you change this setting, it won’t take effect until you log off and then log back in.

**NOTE:** The Shared Inbox check box option is only available to users who have at least the Write permission to the common application data folder (usually “C:\ProgramData”), which normally defaults to members of the Administrators group only. See the Manage Imports Tool in the Library Administrator Guide or the Knowledge Base for more information.

2.2. WEB CLIENT

To access the FileHold web client, you will need to use a valid web browser. See the browsers that FileHold supports.

Two-factor authentication may have been configured for your system. See Multi-Factor Authentication for more information on how to log in if this has been enabled for your system.
The interface of the web client is similar to that of the FDA. Most functions are identical but there is more end-user functionality in the FDA.

Library Administration and System Administration functions are performed through the web client as well using the Administration Panel.

**TO LOG INTO THE FILEHOLD WEB CLIENT**

1. Open a web browser and enter the URL for the FileHold login screen. This should be provided by your system administrator. It is usually in the format:

   \[http(s)://yourcompanyservername/FH/FileHold/WebClient/LoginForm.aspx\]

   **TIP**: It is recommended that you create a bookmark, favourite, or shortcut to the web client URL for easy access.

2. Enter your username, password, and select the domain.

3. Click Log In.

   **NOTE**: If you are using Active Directory in conjunction with FileHold, your administrator may have configured the web browser for authentication. If this is the case, click the Logon with Windows Authentication link on the login page.

**2.2.1. Web Client Menus and Toolbars**

The Web Client has two methods in which functions can be performed.

- The FileHold Toolbar that can be used to perform operations on single or batch (many documents at once) documents such as check out or get a local copy. To select multiple documents, select the check box next to the document name.

- A context-sensitive menu where only those functions that can be performed will be available to use. The context-sensitive menu is accessed by right-clicking on a document name or a level in the library tree.
The following table describes the functionality of the Web Client FileHold toolbar buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get a copy</td>
<td>Makes a copy of the documents to the local user computer.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Check out</td>
<td>Checks out a document for editing.</td>
<td>Users with Document Publisher rights or higher.</td>
</tr>
<tr>
<td>Edit metadata</td>
<td>Opens the metadata pane for editing.</td>
<td>Users with Document Publisher rights or higher.</td>
</tr>
<tr>
<td>Link</td>
<td>Creates a link between two or more documents.</td>
<td>Users with Document Publisher rights or higher.</td>
</tr>
<tr>
<td>Move/copy</td>
<td>Moves or copies the document from one area in the Library to another.</td>
<td>Users with Document Publisher rights or higher and have ownership of the document.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes a document from the Library. Deleted documents can be recovered by a library administrator before a set amount of time. See the Library Administration Guide.</td>
<td>Users with Document Publisher plus Delete rights, Publisher plus Delete rights, and Organizers, who have ownership of the document, Organizer plus Delete and higher roles.</td>
</tr>
<tr>
<td>Convert to offline</td>
<td>Converts the document to an offline document. Offline documents are those documents that are stored outside the FileHold repository, such as a library, file room or filing cabinet.</td>
<td>Users with cabinet administrator rights or higher and are owners of the cabinet.</td>
</tr>
<tr>
<td>Send to &gt; Tray</td>
<td>Adds the document to your document tray.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Send to &gt; Virtual folder</td>
<td>Sends the document to a Virtual folder. A Virtual folder must be available or created.</td>
<td>All users with access to the folder.</td>
</tr>
</tbody>
</table>
### Button Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send to &gt; Email</strong></td>
<td>Emails the document as an attachment or as a link in the body of an email.</td>
<td>All users with access to the document and email settings have been enabled by the library administrator.</td>
</tr>
<tr>
<td><strong>Send to &gt; Email and check out</strong></td>
<td>Checks the document out and sends it in an email attachment or as a link in the body of an email.</td>
<td>Users with Document Publisher rights or higher and email settings have been enabled by the library administrator.</td>
</tr>
<tr>
<td><strong>Send to &gt; Library archive</strong></td>
<td>Sends the document to the Archive.</td>
<td>Users must be a member of the system administrators / Senior library administrators group OR a member of the library administrators group which is the owner of the cabinet where the document belongs.</td>
</tr>
<tr>
<td><strong>Send to &gt; Existing Workflow</strong></td>
<td>Adds main or supporting documents to an existing workflow.</td>
<td>Users with Document Publisher role or higher. User must have access to all added documents and be owner of the document version when adding main documents.</td>
</tr>
</tbody>
</table>
| **Initiate Workflow > workflow template name** | Allows you to select the workflow template name from the list and start a workflow. Selecting more than one document will start a multiple document workflow. | Users with Document Publisher rights or higher and is owner of the document.*  
*Unless the ‘Allow non document version owner to initialize workflow” permission setting is enabled. See the System Administration Guide for more information. |

### 2.3. LOGGING IN WITH MULTI-FACTOR AUTHENTICATION

If you need additional security when accessing the FileHold application, the multi-factor authentication feature strengthens access security by requiring two methods to verify a user’s identity. FileHold supports multi-factor authentication (MFA) with the Duo (www.duo.com) “Trusted Users” service. Each user of FileHold may be required to create a Duo account in order to login to the system.

All FileHold clients supports MFA including: FileHold Desktop Application (FDA), web client, mobile web client, and Courier client.

An administrator needs to set up the Duo account at www.duo.com prior to configuring MFA in FileHold. This is the responsibility of the customer, not FileHold. See the System Administration Guide for details on how to configure two-factor authentication.

**TO LOGIN USING TWO-FACTOR AUTHENTICATION WITH DUO**

1. Open a FileHold client and login using your FileHold credentials.
2. If a Duo account has not been set up for the user, you are prompted to start the account setup process. Click Start Setup.
3. Follow the prompts to set up your selected device for authentication.
4. Click **Continue to Login**.

5. Select your method of authentication:
   - **Duo Push** – Pushes a login request to your phone or tablet (if you have Duo Mobile installed and activated on your iOS, Android, or Windows Phone device). Just review the request and tap Approve to log in.
   - **Call Me** – Authenticate via phone callback.
   - **Passcode** – Log in using a passcode, either generated with Duo Mobile, sent via SMS, generated by your hardware token, or provided by an administrator.
Example of Duo Push authentication method – notification sent to iOS Duo app

6. You are automatically logged into FileHold once your Duo account has been authenticated.
2.4. MICROSOFT OFFICE APPLICATIONS

FileHold software has tight integration with Microsoft Word, Excel, Outlook, PowerPoint, Visio, or OneNote (2010 and greater) applications to provide a comfortable work environment. The FileHold Office Client (FOC) window is used when opening, browsing, getting a copy, checking in/out, adding attachments, or approving or reviewing documents from within Microsoft Office applications.

The Desktop Application must be installed, running and a user must be logged onto the document management system in order for the FileHold Office Toolbar icons or Menus options to be active.

Using the FileHold Toolbar and menu commands you can browse the Library, add a document, check in a document, send for approval or review (workflow) and in Microsoft Outlook you can add an attachment to an email from FileHold. See the table below for details.
<table>
<thead>
<tr>
<th>Button/Menu item</th>
<th>Description</th>
<th>Permissions Needed</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Browse" /> / Browse</td>
<td>Opens the Get From FileHold window where you can select which document you want in the Library.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Send to FileHold &gt; Add Document</td>
<td>Opens the Add Document to FileHold window where you can select the location in the Library and enter metadata for the document.</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td>Send to FileHold &gt; Check In Document</td>
<td>Opens the Check Document Back Into FileHold window where you can check your document back into the Library.</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td>Send to FileHold &gt; Send Review / Approval Feedback</td>
<td>Allows you to select the document you are reviewing or approving and enter any comments and feedback.</td>
<td>Users with Publisher rights or higher.</td>
</tr>
<tr>
<td>Add Attachment from FileHold</td>
<td>Opens the Get From FileHold window where you can select which document you want in the Library to add as an attachment to an email.</td>
<td>All users with access to the folder.</td>
</tr>
</tbody>
</table>

### 2.4.1. Working with Documents using Microsoft Office Applications

The FileHold Office Client (FOC) window allows users to browse the library, get a copy of documents, check them out or into the document management system. Users can also add new files, add approvals or reviews (workflow), or add attachments to emails.

In the FOC window, the Library tree looks and performs the same as it does in the web or desktop applications. Users can also see the associated metadata. In the Get From FileHold window, you can perform various functions such as get a copy of a document, check it out, rename, delete, view version history, and open the file after it has been downloaded.

In the Add Document to FileHold window (shown below), you can select the location in the Library structure for the document, fill out the metadata, close the document before adding to the repository, delete the local copy, and email folder members to notify them that a document has been added to the folder.

To change the document name, click on the name of the document and type a new one.
When opening FileHold from a Microsoft Office application, the Library tree looks and performs the same as it does in the web or desktop applications. Users can also see the associated metadata. In the Get From FileHold window, you can perform various functions such as get a copy of a document, check it out, rename, delete, view version history, and open the file after it has been downloaded.

2.5. LOST OR FORGOTTEN USERNAME AND/OR PASSWORD

In the event that a locally managed user has forgotten their user ID or password, the system administrator can configure FileHold so that two links can be made available on the web client login screen and FDA login screen.

If a user has forgotten their user ID, they are asked to enter their email address. An email containing their user ID is emailed to them.

If a user has forgotten their password and wants to reset it, then the user is prompted to enter their email address and is sent a time-sensitive link in which they will need to use in order to reset their password. Once the link is clicked, the user is prompted to reset their password in the web client. If the time limit on the email expires, then the user will need to resend the reset password request from the login page.

An additional security measure can be put into place using a two-step verification process via a mobile phone. This will send a text message to the user’s mobile phone containing a PIN code. This code is needed to reset the password. See your system administrator for details.

If a mobile phone number is required to reset the password for the user, it can be set by a user in the User Preferences > Contact Information tab > Mobile field.

If your system administrator has not configured these options, you will need to contact them directly.
TO REQUEST A FORGOTTEN USER ID
1. From the web client or FDA login screen, click the I forgot my user ID link.
2. Enter your email address and click Recover.
3. The message “If the address matches a local account in the system you will be sent an email with your user id” displays. Click OK.
4. Your user ID is sent to the email address provided.

TO RESET A FORGOTTEN PASSWORD
1. From the web client or FDA login screen, click the I forgot my password link.
2. Enter your email address and click Recover.
3. The message “If the address matches a local account in the system you will be sent a time limited email with password reset instructions” displays. Click OK.
4. An email is sent to the address provided. The email contains a time sensitive link to reset the password. If the link provided in the email is not used with a certain time period, the link expires and you will need to click I forgot my user ID link to be sent another password reset link email. See your system administrator for time limit details.
5. In the email, click or copy and paste the link provided into a browser window.
6. If you are not using the two-step mobile phone verification process:
   • Enter your User ID.
   • Enter your Password twice and click Save. You will now be logged into FileHold with your new password.

7. If you are using the two-step mobile phone verification process:
   • Enter your User ID.
   • Enter your Password twice.
   • Select the Phone Number to be sent the verification code and click Continue. Only a partial phone number is shown in the list.
Enter the 4-digit PIN that was sent to your phone and click **Save**. You will now be logged into FileHold with your new password.
3. UNDERSTANDING ROLES, PERMISSIONS, AND ACCESS TO THE LIBRARY

Only users with the correct role can use and manage certain parts of the Library structure. Your system administrator assigns users to groups and a role to each group. Your library administrator will have created the Library structure and assigned group membership to the cabinets, folders, and document schemas. The role assigned to the group will determine what permissions you have in terms of functions in the system and accessing cabinets, folders, and documents.

All roles provide document emailing capability. Roles higher than Document Publisher have the Courier functionality. These functions can be disabled on a role by role basis by a System Administrator in the FileHold Groups area. See the System Administrator Guide for more information.

NOTE: You can be logged into FDA and the Web Client at the same time but you cannot be logged into two FDAs or web clients at a time. Only one user account can log into FileHold at a time.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Limited   | A user assigned to a group with a “limited” role has restricted access to the system. Users can only get a copy or view documents in the library. Groups assigned to a “limited” role are used for when multiple people can share the same username and password to log into FileHold to see the same documents in the library. For example, documents such as newsletters, forms, or corporate policies may need to be accessible to all company employees but they do not require a full registered user license and full functionality. There are two user account types that can be assigned to a limited role:  
- Limited Registered user accounts can log into FileHold using a single username and password.  
- Portal Alias user account types are used in conjunction with the Anonymous portal and require no login. Using limited registered or anonymous portal user account types are a cost-effective way for many people to view documents in the repository but with very limited functionality. User accounts assigned a role of “limited” consume “Limited concurrent sessions”. Limited concurrent sessions are the number of users that can log into FileHold at the same time using a limited registered or portal alias account. For example, 30 people may have the same login credentials but only 20 can use FileHold at the same time because there are only 20 limited concurrent sessions. If multiple people log into FileHold with the same user name, the log files record the same user name regardless of the actual person that logged into the system. Groups assigned the limited role restrict users from downloading or printing documents in the group properties. |


<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>A Read-Only user role may only download or open and read documents from FileHold. They cannot edit, delete, or create documents. They can email documents if given this functionality by system administrators. Read-only users may be restricted from downloading or printing documents. Read-only users can participate in workflows but cannot initiate workflows.</td>
</tr>
<tr>
<td>Document Publisher</td>
<td>Document Publisher user role can read, get a copy, add, check-in/check-out, edit documents, and metadata. They can move documents that are owned by them. They cannot delete any documents including those which they have added to the system. Document publishers can initiate workflows, participate in workflows, and initiate Courier transmissions.</td>
</tr>
<tr>
<td>Document Publisher + Delete</td>
<td>Document Publisher Plus Delete user role can do everything a Document Publisher can do and delete their own documents. They must be the owner of the document in order to delete it. To see the owner of a document, you can look at the version properties in the metadata pane.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher user role can do everything a Document Publisher can do plus: Create new folders and folder groups. Copy or move folders that they have already created. Clone folders and folder groups created by other users and become the owners of the folders / folder groups. Publishers cannot delete existing documents, folders or folder groups including those which they have added /created. All documents and folders created by the Publisher will be owned by them and they cannot change the ownership.</td>
</tr>
<tr>
<td>Publisher + Delete</td>
<td>Publisher plus Delete user role can do everything that a Publisher can do plus delete documents, folders and folders group owned (created) by them.</td>
</tr>
<tr>
<td>Role Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Organizer          | The Organizer role is for users who are responsible for organizing documents that are scanned or imported into the system or who are assigned to organize documents added by other users. For example, organizers would move the documents generated by scanner operators to their correct folder in the library. Only trusted personnel should be given this role. Organizer role user can:  
  - Move all documents (which they have an access to) in other places in the library including documents which they do not own. In other words, they can move documents that are owned by other users.  
  - Move, copy or clone all folders and folder groups regardless of their ownership. In case of cloning they will become the owners of folder / folder groups. In case of copying and moving the original ownership of folders / folder groups is preserved.  
  - Change folder properties regardless of ownership.  
  - Add folders / folder groups (in which case they will become their owners) and rename folders and folder groups.  
  - Delete documents that they own.  
  - Change document owner regardless of ownership  
  - Convert offline documents to electronic documents  
  - Export documents |
| Organizer + Delete | Organizer plus Delete role can do everything that Organizers can do plus delete all documents, folders and folder groups regardless of their ownership. This organizer and delete role can only do this within Cabinets, Folders and Schemas that they are a member of.  
  This role should be used by trusted personnel only. |
<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Cabinet Administration    | Cabinet Administrators can only administer the cabinets that they own; they cannot create cabinets for themselves. They can:  
  • Create, edit, and delete drawers, folder groups and folders and manage their properties (i.e. membership structure).  
  • Access all documents (in Publisher and Delete capacity) from anywhere in the library structure unless they are restricted from that area of the library structure. If they do not have access to the Cabinet and Folder they will not be able to access the documents.  
  • Delete and move electronic records as long as they are owners of the cabinet. Electronic records can only be moved to another Cabinet in which they own.  
  • Move documents between cabinets as long as they are owners of the Cabinet. If users need to move documents between Cabinets that they do not own, then use an organizer role instead.  
  • Have access to all document schemas.  
  • Change document owner for documents in the cabinets that they own.  
  • Convert electronic documents to electronic records and vice versa for cabinets that they own.  
  • Convert electronic documents to offline documents for cabinets that they own.  
  • Manually move document to and from the library archive as long as they are the Cabinet owner in the library archive.  |
| Library Administration    | Library administrators can perform, within their cabinets, the same functions as Cabinet Administrators plus:  
  • Create cabinets for which they will be the owner of and manage them in the Library.  
  • Access to Library Administration functionality where they can manage metadata fields, schemas, events, set up workflow templates, manage numerous global settings (i.e. viewer permissions, search engine settings, reporting services permissions and more), perform various managerial functions such (as check-in for user, change document owner, recover deleted document etc.) and access many useful reports and usage logs for the cabinets that they own.  
  • Library administrators cannot create cabinets for Cabinet Administrators to own. If a library administrator creates a cabinet, then they are the owners.  |
<p>| Senior Library Administration | Senior library administrators have full control of the FileHold library itself and library administration area. Senior library administrators can create cabinets to be managed by any Library Administrator or Cabinet Administrator. |</p>
<table>
<thead>
<tr>
<th>Role Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Administration</td>
<td>System administrators have complete control of the system. They can perform all of the functions of all other roles. However, the main tasks of the system administrators are to add users to the system (including assigning the initial password and setting requirements for all new passwords and ability to self-register), assign users to their appropriate groups, enable document control numbers and version control numbers, manage user accounts, user groups and the system license pool. The system administrator also has access to various global settings (outbound e-mail, system wide configurations for managing the various documents format conversion permissions etc.) and as well as user activity reports.</td>
</tr>
</tbody>
</table>

**NOTE:** All roles provide document emailing capability. This can be disabled on a role by role basis by a system administrator in the FileHold Groups area. See the *System Administration Guide* for more information.

### 3.1. DOCUMENT PERMISSION ICONS

The permission icon to the left of the document indicates the degree of access you have to a file in the document management system. The permission that you have to the document is dependent upon the role you were assigned.

Descriptions for permission icons are outlined below in order from most flexible to most restrictive access to the document.

<table>
<thead>
<tr>
<th>Permission Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Red, Yellow and Green Dots indicates that the user has full access to that file in the document management system and is able to read, edit or delete the document. This document is being stored as an electronic document type and not as an electronic record and can therefore have multiple versions associated with it.</td>
</tr>
<tr>
<td></td>
<td>Red and Yellow Dots indicate that the user can only read or edit the document.</td>
</tr>
<tr>
<td></td>
<td>Red Dot indicates that the user has Read-Only access to the document. This could indicate that the user has read-only permissions, the document is checked out by another user, or under workflow.</td>
</tr>
<tr>
<td></td>
<td>Gray Dot indicates that the document is an electronic record and not an electronic document type. This means that there will only be one version of this file and there are very strict restrictions for all users for the deletion of this document.</td>
</tr>
<tr>
<td>Permission Icon</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Rectangle with Dot</td>
<td>Indicates an external/physical document (called an &quot;off-line document&quot;) for which metadata is available but there is no electronic file associated with it in the documents management system.</td>
</tr>
<tr>
<td>&quot;H&quot;</td>
<td>Indicates that the document version is hidden while it is undergoing a workflow. The &quot;H&quot; is only seen by those that are observers or participants of the workflow.</td>
</tr>
<tr>
<td>&quot;!&quot;</td>
<td>Indicates that the current document is under workflow. Only previous versions are available at this time. The &quot;!&quot; is seen by those who are not observers or participants of the workflow.</td>
</tr>
<tr>
<td>Purple dot</td>
<td>Indicates an electronic document is in the library archive. Electronic records in the archive keep a grey dot.</td>
</tr>
</tbody>
</table>
4. LIBRARY TREE OVERVIEW

The Library structure view of FileHold provides a familiar and intuitive means to view and search for content held in the document management system. When users first logon to FileHold the file structure appears on the left side. The upper folders, including the My FileHold group, act as a personal space for users to organize and work with items retrieved from the system. The rest of the tree represents the hierarchical arrangement of the entire document management system. The library is at the top and is divided into cabinets, drawers, folder groups and folders. The following is an overview of each major section of the Library file structure.

- **Inbox (Send to Library) Folder** - The Inbox folder contains a list of documents that are queued for processing prior to being sent to FileHold. Note: The Inbox view is only available to users accessing the document management system using the FileHold Desktop Application software. The FileHold Desktop Application is designed to streamline the importing of legacy files into the document management system by removing the bottlenecks associated when adding and classifying files en masse.

- **My FileHold** - The My FileHold section provides users with personalized views of files. The files located in the My FileHold area is local to the user's machine and login credentials.

- **Reviews & Approvals** - See the review or approval tasks you have been assigned and the workflow status report.

- **Recent Folders** – A list of the last 10 used folders is displayed in the tree in FDA, the Select Destination windows, and FileHold Office Client window. The Recent Folders list is not displayed in the Web Client. This is useful for viewing and keeping track of what areas of the document management system you are using and quick access to the documents in those folders.

- **Search** - Provides access to saved search results.

- **Virtual Folders** - Virtual Folders are personalized custom folders that allow users to reference to files located in different folders throughout FileHold without the need for duplicating the files. This allows users to logically group and organize documents for individual use without compromising security or clogging up the document management system with personal folders full of nothing more than duplicates.
• **Reports** (if configured) - Provides easy access to various custom reports developed by the IT department using SQL Server Reporting Services.

• **Library** – Where active documents are stored. FileHold provides a completely customizable hierarchy to store and manage electronic documents and records using a cabinet / drawer / folder group / folder metaphor. Research shows that filing documents 3 to 4 levels deep is the most organized means to store files and provide for efficient retrieval. By expanding the various levels of the library or library archives users are able to browse down to the various folders in the system.

• **Library Archive** – Located at the bottom of the file structure is usually a clone of the library structure. It is meant to be the long-term storage space for records or other important documents which are no longer active and were moved to the Library Archive manually or by an automated process based on the document life cycle policies defined by library administrator(s).
5. INBOX (SEND TO LIBRARY)

The FileHold Desktop Application’s (FDA) Inbox is designed to streamline the importing of many documents into the library by removing the bottlenecks associated when adding and classifying files en masse. The Inbox is a queue or list of files that have not yet been copied to the FileHold Server.

The Inbox is specific to each user's FileHold Desktop Application (FDA) on their workstation and user account profile unless you share your Inbox. Sharing your Inbox allows others to file the contents of your Inbox on your behalf. For example, if there is a dedicated scanning station with several people scanning documents to be added into FileHold, all users who can log into the Windows environment of that scanning station will be able to file all the scanned documents in the Inbox. This is because the Inbox is shared between all the users who can log in with a Windows user account.

The Inbox is the first category visible in the library structure. The Inbox acts as a staging area for documents that are queued for processing on the client machine prior to be sent to the Library. All documents in this list remain on the client machine until they are sent to the library. Files located in the Inbox will only be ready to be sent to the Library once they have both required metadata (tags) values entered and a destination folder associated with each file.

Users can quickly add all the files from a network folder to the Inbox to prepare for filing. Files in the Inbox that still need to have their metadata or destinations set will have a status of "Info Required". This information is necessary before they can be filed in the Library.

**NOTE**: The Inbox is not available in the Web Client interface.

The status column lets users know if more information is required before the file can be sent to the document management system. A status of "Info Required" indicates that the required metadata or a destination have not been set. Once all the required information is set, the status changes to "Ready to Send" and file can then be uploaded by clicking the Send or Send All (used when multiple files are ready to be sent to the Library). The documents are then sent to their destination folders and are removed from the Inbox.

The Inbox can be sorted by document name, type, coming from, or going to by clicking on the column header name. The columns can be sorted in ascending or descending order by clicking on the arrow button next to the header name.

The following table describes the functions of the Inbox:
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ (Add documents)</td>
<td>Adds documents from outside the document management system.</td>
</tr>
<tr>
<td>Remove from Inbox</td>
<td>Removes the selected document(s) from the Inbox.</td>
</tr>
</tbody>
</table>
| Edit Metadata       | Allows you to enter the metadata for the selected documents...
|                     | Select multiple documents to be filed under the same schema and click Edit Metadata. You can set all the metadata fields to the same value. |
| Edit Destination    | Allows you to select the destination folder for documents. Select multiple documents to be filed under the same folder and click Edit Destination. You can set the destination to the same folder. |
| Send                | Sends a single document to the Library. The metadata and the destination must be set in order to send a document to the repository. |
| Send All            | Sends all documents that have set metadata and destination to the library. |
| Auto-File           | Automatically files documents in folders. This needs to be configured. See the Library Administration Guide for information on auto-filing. |
6. MY FILEHOLD

The My FileHold area of FileHold provides views of documents that are unique to each user. In other words, it is a personal document workspace for you. This area allows you to access the documents that you use most frequently, documents that you have checked out, documents that are awaiting your review and/or approval, and any alerts or reminders that you have set on documents.

![My FileHold Menu]

6.1. MY FAVORITES

My Favorites is a list of files that the user has flagged as favorites. To make a document a “favorite”, click the star next to the document name so it turns yellow. A yellow star indicates a favorite document and will show up in the My Favorites list.

![Yellow Star Indicate Favorite]

6.2. CHECKED OUT DOCUMENTS

Checked Out Documents are a listing of documents that the user has checked out of the system. For more information on how to check a document in and out, see Checking In/Out.

![Checked Out Documents]

6.3. DOCUMENT ALERTS

Document Alerts is a list of notifications received about documents or folders users have subscribed to. For more information on setting document alerts, see Setting Document Alerts and Reminders.

6.4. DOCUMENT REMINDERS

Document Reminders is a list of reminders to check on certain documents at a set time. For more information on document reminders, see Setting Document Alerts and Reminders.
6.5. RECENTLY ADDED AND RECENTLY ACCESSED

Recently Added is a list of files that the user recently added to any location in the document management system in the last 2 weeks.

Recently Accessed is a list of files recently accessed (opened, checked out/in, reviewed, etc.) to any location in the document management system in the last 2 weeks.

6.6. CALENDAR

The Calendar helps keep you organized by showing all of your tasks, reminders, and event schedules so you can become more proficient at accomplishing your document management goals.

The Calendar is shown in the My FileHold area of the Library tree in the FileHold Desktop Application (FDA). The Calendar is not available in the Web Client.

TO ACCESS THE CALENDAR

1. In FDA, go to My FileHold > Calendar.

2. The Calendar can be viewed by the Month, Week, Day, or today (current date). You can also scroll through the months, weeks, days, and years using the scroll arrows.

3. Click Today to bring you back to the current date (today’s date).

4. You can click on a day in the Month or Week view to see the details for the day.

5. Click on a task or a reminder in the Day view to open the document in the My Tasks view for tasks or in the My Document Reminders View for reminders.
You can view the following items in the Calendar:

- Active, overdue, and completed workflow tasks:
  - Completed tasks are in a light green background.
  - Due tasks are in a green background with bold text and then number of tasks due in brackets.
  - Overdue tasks are shown in red with bold text and the number of overdue tasks in brackets. A task is considered overdue the day after the task is due. Note that this shows that there is only one task overdue but two tasks were due on that day. Only one task was completed.

- Reminders are displayed in cyan background. Active reminders that have not been marked as read are bolded with the number of active reminders listed in brackets (). Active reminders that have been marked as read will be unbolded. Only the current days’ reminders are considered active. Lapsed and future reminders are not active.

- Scheduled events when the Include Events button is selected. Only users with library administrator roles and above can access this feature. Events are for when documents are set to be archived, converted to a record, disposed, or a user defined event. Events are displayed in yellow background.

6.7. RECENT FOLDERS

The Recent Folders area displays a list of the last 10 used folders is displayed in the tree in FDA, the Select Destination windows, and FileHold Office Client window. The Recent Folders list is not displayed in the Web Client. This is useful for viewing and keeping track of what areas of the document management system you are using and quick access to the documents in those folders.
7. SEARCHING

You can find a document in FileHold using the powerful and robust search capabilities. There are three methods of searching for documents in FileHold:

- **FastFind** — Use predefined hot keys to search within FileHold from third party applications.
- **Simple Search** — The Simple Search feature is a “Google-like” toolbar that uses a full-text search. FileHold has the ability to recognize, index text and allows users to search content of all your favorite document types including PDF, Microsoft Office, Zip and many more. When searching using the full text search, the system searches both the metadata associated and the content of the document for matches. Full text search is particularly useful for general searches of files stored in a records management system. For example, searching the system for all files that make reference to Sarbanes Oxley.

**TIP**: In order to do partial word searches, you need to use a wildcard (*) before or after the word you are searching for.

- **Advanced Search** — The Advanced Search allows users to use the metadata associated with a document to help locate the file. This is particularly useful when users have a specific piece of information they would like to search for. Up to ten search parameters can be used in an advanced search.

### Advanced Search

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board Minutes</td>
<td>Equals</td>
<td>Board Minutes</td>
</tr>
<tr>
<td>Document Type</td>
<td>Equals</td>
<td>FileHold 13</td>
</tr>
<tr>
<td>Library Location</td>
<td>Equals</td>
<td>...</td>
</tr>
<tr>
<td>Date Last Modified</td>
<td>Between</td>
<td>6/21/2013 - 6/24/2013</td>
</tr>
</tbody>
</table>

7.1. HOW TO ACCESS SEARCH

There are several methods in accessing the Search function.

- Click **Search**, **My Saved Searches**, or **Public Saved Searches** in the Library Tree. Using **Search** will search all documents in the Library tree.

- Using the “Google”-like search toolbar located in the top right of the window. Click the down arrow next to the search toolbar to access the Advanced Search screen.
7.2. HOW FILEHOLD SEARCHES FOR DOCUMENTS

Users can only retrieve documents to which they have access. Access is based on user rights and permissions. Therefore, in order for a user to see a document in their search results they would have to be a member of the cabinet, folder, and schema that the document belongs to.

The following are how the document management system conducts searches for documents:

- When using the operator “Contains in FTS” or “Does not contain in FTS”, it searches all metadata, file properties, document name, and content (full text indexing) of the documents.
- When using the operator “Contains in DB” or “Does not contain in DB”, it searches the metadata (databases) only. The content of the documents (full text indexing) is ignored.
- FileHold searches for whole words only. Partial words need wildcards (*, ?) (think of “Google”).
- Metadata searches will return the most relevant of results. Metadata searches also return faster search results as it searches the Microsoft SQL database only.
- When the user invokes search functionality on a cabinet, drawer, folder group, or folder, the search will be restricted to the portion of the file structure from which the search was invoked.
- The contents of the Library Archive are NOT included in the search. To expand the search to include the Library Archive, select the Include in Archive check box in the Advanced Search options.
- Documents that have been deleted from the system are not included in the search.
- Only the latest version of a document is searched. The document usage history and document version history are not included in the search scope. To expand the search to include all document versions, select the Include All Document Versions check box in the Advanced Search options.
- My FileHold, Search, Saved Searches and Virtual Folders contents are not searched because these are links to documents and not where the documents reside.

- Metadata field names that have been edited or deleted are not searched. To search using old metadata field names, select the Search Using Historical Metadata Fields check box in the Advanced Search options.

### 7.2.1. General Usage

1. Avoid searching for two (2) letter words alone; instead use three (3) letter words or simply use a wildcard * before or after the 2 letters. Two letter word searches are not searchable for several technical reasons:

   - The two letters you are searching for can appear in a portion of a word, or very commonly on their own, these if used in the search engine criteria, would greatly slow down and impede the performance of the FileHold search system.

   - In addition, they can also affect the quality of search results because they can appear inside a larger word or on their own with great frequency. This throws off search quality to unacceptable levels. The document management system is designed to ignore common words or characters as they tend to slow searches without improving the quality of the results. See the table below on Noise Words.

2. Use whole words when searching for words inside of documents. Simple search acts like a "Google" search and partial words may not return the results you are looking for or may not return any results. If you need to use partial words, use a wildcard (*, ?) with the search.

3. If you use a very generic search term, then the search engine may time out. Try to look for unique words or terms or limit the search to a specific area in the Library. See Full Text Search – Wildcard Search Limitation Setting for more information.

### 7.2.2. Noise Words

A noise word is a word such as "the" or "if" that is so common that it is not useful in searches. To save time, noise words are not indexed and are ignored in index searches. All single letters are ignored and include the list of words in the table below.

<table>
<thead>
<tr>
<th>Letter</th>
<th>Noise Words</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>a, about, after, all, also, an, and, another, any, are, as, at</td>
</tr>
<tr>
<td>B</td>
<td>be, because, been, before, being, between, both, but, by</td>
</tr>
<tr>
<td>C</td>
<td>came, can, come, could</td>
</tr>
<tr>
<td>D</td>
<td>did, do</td>
</tr>
<tr>
<td>E</td>
<td>each, even</td>
</tr>
<tr>
<td>F</td>
<td>for, from, further, furthermore</td>
</tr>
<tr>
<td>G</td>
<td>get, got</td>
</tr>
<tr>
<td>H</td>
<td>had, has, have, he, her, here, hi, him, himself, how, however</td>
</tr>
<tr>
<td>I</td>
<td>i, if, in, indeed, into, is, its</td>
</tr>
<tr>
<td>J</td>
<td>just</td>
</tr>
<tr>
<td>L</td>
<td>like</td>
</tr>
<tr>
<td>M</td>
<td>made, many, me, might, more, moreover, most, much, must, my</td>
</tr>
</tbody>
</table>
### 7.2.3. Full Text Search - Wildcard Search Limitation Setting

When a wildcard search (*) is performed or is used in conjunction with the “contains” or “does not contain” operators in an Advanced search, using a common term in the repository may return a very large number of intermediate search results that must be processed. A parameter limitation can be set on the number of results returned when a search like this has been performed. Care should be taken not to set a value that makes any typical searches impractical. For most users this value does not need to be changed from the default which returns all specified results that can be found before the full text search timeout expires.

The new entry in the web config file in C:\Program Files\FileHold Systems\Application Server\FullTextSearch is under `<appSettings>`:

```
<add key="LimitNumberOfEntriesToReturn" value="0" />
```

If the value is set to 0, then the limitation is disabled. It is disabled by default.

If a wildcard full text search exceeds the limit set in the web config file then a message is displayed:

> "Your search with the CONTAINS operator would consume more server resources than allowed by your system administrator. Consider narrowing your search conditions to reduce the possible results. Your search would have returned {x} documents and your system administrator has set a limit of {x} documents."

### 7.3. SEARCH REQUEST TYPES

FileHold supports different types of search requests:

- An "any words" search is any sequence of text, like a sentence or a question. In an "any words" search, use quotation marks around phrases, put AND in front of any word or phrase that is required, and NOT in front of a word or phrase to exclude it. Note that the operators + and – are not supported. Examples include:
  - banana pear "apple pie"
  - "apple pie" NOT salad AND "ice cream"
- An "all words" search request is like an "any words" search except that all of the words in the search request must be present for a document to be retrieved. Example:
• *FileHold Systems* will find all documents with the words FileHold and systems
• A "Boolean" search request consists of a group of words, phrases, or macros linked by connectors such as AND and OR that indicate the relationship between them. Examples include:

<table>
<thead>
<tr>
<th>Search Request</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>apple AND pear</td>
<td>Both words must be present</td>
</tr>
<tr>
<td>apple OR pear</td>
<td>Either word can be present</td>
</tr>
<tr>
<td>apple w/5 pear</td>
<td>Apple must occur within 5 words of pear</td>
</tr>
<tr>
<td>apple NOT w/12 pear</td>
<td>Apple must occur, but not within 12 words of pear</td>
</tr>
<tr>
<td>apple AND NOT pear</td>
<td>Only apple must be present</td>
</tr>
<tr>
<td>apple w/5 xfirstword</td>
<td>Apple must occur in the first five words</td>
</tr>
</tbody>
</table>

*Noise words*, such as “if”: and “the”, are ignored in searches.

Such operators and logics including: stemming, fuzzy, synonym and phonic can be used with "contains" or ‘does not contain” type searches. Because the stemming, fuzzy, synonym and phonic search methods can impact search performance the ability to search using Fuzzy, Synonym and Phonic searching is a global setting configured by the library administrators. See the *Library Administration Guide* or the *Knowledge Base* for more information. However, individuals can search using these logics for individual full text searches. Search terms may include the following special characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Matches any character.</td>
<td>appl? would match apply and apple but not apples</td>
</tr>
<tr>
<td>=</td>
<td>Matches any single digit.</td>
<td>N=== would match N123 but not N1234 or Nabc</td>
</tr>
<tr>
<td>*</td>
<td>Matches any number of characters. Use to search for a term where the spelling is in question or there are multiple possible spellings. Note: Use of the * wildcard character near the beginning of a word will slow searches somewhat.</td>
<td>appl* would match apple, application, etc.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>cipl</em> would match principle, participle, etc.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ap*ed would match applied, approved, etc.</td>
</tr>
<tr>
<td>%</td>
<td>Fuzzy search. The number of % characters you add determines the number of differences the search engine will ignore when searching for a word. The position of the % characters determines how many letters at the start of the word have to match exactly.</td>
<td>ba%nana: Word must begin with ba and have at most one difference between it and banana.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b%%anana: Word must begin with b and have at most two differences between it and banana.</td>
</tr>
<tr>
<td>Character</td>
<td>Meaning</td>
<td>Examples</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>#</td>
<td>Phonic search. Phonic searching looks for a word that sounds like the word you are searching for and begins with the same letter.</td>
<td>Put a # in front of the word in your search request. Example: #smith will also find Smithe and Smythe.</td>
</tr>
<tr>
<td>~</td>
<td>Stemming. Stemming extends a search to cover grammatical variations on a word.</td>
<td>Add a ~ at the end of words that you want stemmed in a search. Example: apply~ also finds applying, applies, and applied. A search for fish would also find fishing.</td>
</tr>
<tr>
<td>&amp;</td>
<td>Synonym search. Synonym searching finds synonyms of a word that you include in a search request.</td>
<td>Put a &amp; at the end of the words you want to use in your search request. A search for fast&amp; would also find quickly.</td>
</tr>
</tbody>
</table>

### 7.3.1. Words and Phrases

To search for a phrase, use quotation marks around it, like this: “fruit salad”

If a phrase contains a noise word, the search engine will skip over the noise word when searching for it. For example, a search for statue of liberty would retrieve any document containing the word statue, any intervening word, and the word liberty.

Punctuation inside of a search word is treated as a space. For example:

- can’t would be treated as a phrase consisting of two words: can and t.
- 1843(c)(8)(ii) would become 1843 c 8 ii (four words).

### 7.3.2. AND connector

Use the AND connector in a search request to connect two expressions, both of which must be found in any document retrieved. For example, apple pie and poached pear would retrieve any document that contains both phrases.

A search for banana and pear w/5 grape would retrieve any document that (1) contains banana, AND (2) contains pear within 5 words of grape.

### 7.3.3. OR Connector

Use the OR connector in a search request to connect two expressions, at least one of which must be found in any document retrieved. For example, apple pie or poached pear would retrieve any document that contained apple pie, poached pear, or both.

### 7.3.4. W/N Connector (Proximity Search)

Use the W/N connector in a search request to specify that one word or phrase must occur within N words of the other. For example, apple w/5 pear would retrieve any document that contained apple within 5 words of pear.

The following are examples of search requests using W/N:

- apple or pear w/5 banana
• apple w/5 banana w/10 pear
• apple and banana w/10 pear

The xfirstword term is useful if you want to limit a search to the beginning of a file. For example, apple w/10 xfirstword would search for apple within 10 words of the beginning of a document.

7.3.5. NOT and NOT W/Number (Proximity Search)

NOT allows you to exclude documents from a search. For example: apple sauce AND NOT pear would return all documents with term apple sauce but exclude any that had pear.

NOT standing alone can be the start of a search request. For example, NOT pear would retrieve all documents that did not contain pear.

If NOT is not the first connector in a request, you need to use either AND or OR with NOT such as apple OR NOT pear or NOT apple w/5 pear.

The NOT W/ (“not within”) operator allows you to search for a word or phrase not in association with another word or phrase. For example: apple NOT w/20 pear.

Unlike the W/ operator, NOT W/ is not symmetrical. That is, apple NOT w/20 pear is not the same as pear NOT w/20 apple. In the apple NOT w/20 pear request, it searches for apple and excludes cases where apple is too close to pear. In the pear NOT w/20 apple request, it searches for pear and excludes cases where pear is too close to apple.

CAUTION: “NOT” cannot be used in conjunction with the search parameter “Folder name”. For example, Folder name contains “not procedures” is not a valid search string.

7.4. SIMPLE SEARCHES (FULL TEXT SEARCH)

Simple Search (also called full text searches) in FileHold uses a “Google-like” toolbar to return full-text search results. FileHold has the ability to recognize, index text and allows users to search content of all your favorite document types including PDF, Microsoft Office, Zip and many more. When searching using the full text search, the system searches both the metadata associated and the content of the document for matches. Full text search is particularly useful for general searches of files stored in a records management system. For example, searching the system for all files that make reference to Sarbanes Oxley.

There are three locations where you will find the Simple Search screen:

• Click Search in the Library hierarchy. The simple search form that appears allows users to search the contents of the entire documents management system using the full text search engine.

• The Search field located in the top right-hand corner of the FileHold Desktop Application user interface.

• In a folder view of the Web Client.
The search results returned have a relevance ranking. The relevance value (expressed as a percentage) is an approximation of how close the document is to the search criteria.

**TO DO A SIMPLE (FULL TEXT) SEARCH**

1. In the simple search bar, enter the search term and click Search. The search results are displayed.

**7.5. ADVANCED SEARCHES**

Advanced Search allows you to search by specific metadata fields and other system recorded information about the document.

Users can combine searches in order to filter results. Users can also choose to search by metadata only, search the archive, include all versions and search using historical metadata fields by checking the boxes at the bottom of the advanced search form.

The parts of an advanced search include:

- Metadata Field Selector – Allows users to select the metadata field they want to search the document management system with.

- Search Operator Selector – Allows users to select an operator to accompany a selected metadata field. The list of operators are: Equal to, Between, Greater than >, Less than <, Greater than or equal to >/=, Less than or equal to </=, In the list, or Is Blank. The list of available operators is dependent on the type of Metadata field selected. See Search Operator Selectors for more information.

- Search Criteria Value Select – Allows users to enter a specific search criterion based on the metadata field and operator selected. The value field is based on the type of metadata field selected. By default, there is only one value field for each operator. The only exception is the “between” operator that allows users to search between two values such as dates or numbers.

- Add or Remove Search Rows – The [ - ] and [ + ] buttons to the right of each row allow users to remove or add (respectively) rows from the search criteria. Multiple search rows are joined automatically joined using the AND operator. Up to 10 rows can be used.

**TO ACCESS THE ADVANCED SEARCH FORM**

- From the 'Search and Saved searches' simple search, click the Advanced link to the right of the search button.

- To access the advanced search from the folder of the document management system view, click on the gray down arrow to the right of the search field icon in the top right corner of the folder view.
• Clicking on a Saved Search.
• Right-clicking on the file structure and selecting Search. Remember that the search will automatically be set to start at the library, cabinet, drawer, folder group of folder level depending on where the user right clicks.

**TO DO AN ADVANCED SEARCH**

1. In the Advanced Search screen, use the following table to build search queries. You can use up to 10 search filters to build the search query.

<table>
<thead>
<tr>
<th>Search option</th>
<th>Description</th>
<th>Available search operator selectors</th>
</tr>
</thead>
</table>
| File or Metadata    | Allows users to add a full text search value to their metadata search criteria. This hybrid approach can be used to combine the best aspects of full text and metadata only searching. The same full text search operators apply to this field as in Full Text Searching. | Contains in FTS  
Does not contain in FTS |
| Document Name       | Searches the system for a file by the name in the search criteria.           | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal     |
| Checked Out Status  | Search by the checked out status of:                                         | Equals                                                   |
| Person              | Allows users to search by:                                                   |                                                 |
|                     | • Owned By Me  
• Owned By Someone Else  
• Checked Out By Me  
• Checked Out Be Someone Else |                                                |
<table>
<thead>
<tr>
<th>Search option</th>
<th>Description</th>
<th>Available search operator selectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Date</td>
<td>File Data menu allows users to search by:</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td>• Date Last Modified</td>
<td>Not Equals</td>
</tr>
<tr>
<td></td>
<td>• Creation Date</td>
<td>In the List</td>
</tr>
<tr>
<td></td>
<td>• Approval Date (for workflow)</td>
<td>Not In the List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Between</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt; (greater than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; (less than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt;= (greater than or equal to)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;= (less than or equal to)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At least</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No older than</td>
</tr>
<tr>
<td>Workflow Status &gt; Approval</td>
<td>Search by the workflow status of:</td>
<td>Equals</td>
</tr>
<tr>
<td>Approval Status</td>
<td>• Approved</td>
<td>Does not equal</td>
</tr>
<tr>
<td>Workflow Status &gt; Review</td>
<td>Search by the workflow review status of:</td>
<td>In the list</td>
</tr>
<tr>
<td>Status</td>
<td>• Reviewed</td>
<td>Not in the list</td>
</tr>
<tr>
<td>Status &gt; Review Status</td>
<td>• Pending review</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Not submitted for review</td>
<td></td>
</tr>
<tr>
<td>Library Location</td>
<td>Allows users to restrict searching to a specific cabinet, drawer, folder</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td>group or folder in the document management system.</td>
<td>Does not equal</td>
</tr>
<tr>
<td>Document Log Action</td>
<td>Search for documents that have been checked out, downloaded, checked in,</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td>copied, moved, archived, viewed, printed, published, added, linked, emailed,</td>
<td>Does not equal</td>
</tr>
<tr>
<td></td>
<td>etc.</td>
<td>In the list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not in the list</td>
</tr>
<tr>
<td>Search option</td>
<td>Description</td>
<td>Available search operator selectors</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Document Log Date</td>
<td>Search for documents that have had actions performed on them within a date or date range.</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does Not Equal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not In the List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Between</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt; (greater than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; (less than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt;= (greater than or equal to)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;= (less than or equal to)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At least</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No older than</td>
</tr>
<tr>
<td>Special Fields</td>
<td>Folder name – Search using part of a folder name when the “Contains” operator is selected. Note that no wildcards or dtSearch keywords can be used for this option.</td>
<td>Contains in DB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not contain in DB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not equal</td>
</tr>
<tr>
<td>File Type</td>
<td>The File Type extension list is dynamically updated and sorted alphabetically. A new file extension entry is dynamically added to the initial standard list upon adding a document with a new file extension for the first time. The list is not updated in FDA until the user logs in and out. Multiple file extensions can be selected when the qualifier is set to “In the list”.</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not equal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not in the list</td>
</tr>
<tr>
<td>FileHold ID</td>
<td>The unique ID number given to every version of a document. See Entering Metadata.</td>
<td>Equals</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Does not Equal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Not In the List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Between</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt; (greater than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; (less than)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt;= (greater than or equal to)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;= (less than or equal to)</td>
</tr>
</tbody>
</table>
## Search option

<table>
<thead>
<tr>
<th>Search option</th>
<th>Description</th>
<th>Available search operator selectors</th>
</tr>
</thead>
</table>
| Document Control No. – Specialized metadata field used to track specific document numbering requirements. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Version Control No. – Like document control numbers, used to track specific document numbering requirements. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Has Markup – User can find documents that have been "Marked Up" using the Brava Viewer Markup Tool. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Has Link – Users can find all documents that have been linked with other documents. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Is Favorite – Provides a list of documents that are marked as favourites. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Document Format – Select Electronic Document, Electronic Record, or Offline Document type. | Contains in FTS  
Does not contain in FTS  
Contains in DB  
Does not contain in DB  
Equals  
Does not equal | |
| Common MD (metadata) Fields | Allows users to search by common metadata fields – i.e. “Customer Name”. The list of possible metadata field options is customized based on how the library administrator has defined the document classification standards for the FileHold server. | Depends on metadata field type. See Search Operator Selectors for more information. |
| Search by Document Schema | Allows users to restrict their search by document schemas and the associated metadata. The list of possible document schemas and associated metadata fields is customized based on how the library administrator. | Depends on metadata field type. See Search Operator Selectors for more information. |
| Search by Metadata Field Name | Depending on the document schemas selected, the associated metadata fields are available to search by. | Depends on metadata field type. See Search Operator Selectors for more information. |

2. Select any of the following advanced search options:
   - **Search Metadata Only** – Searches the metadata only and not the contents of a document (full-text search).
• Include Archive in Search - Searches the documents in the Library archive and includes any matches in the results. FileHold will search only the Library (current documents) if this option is not selected.

• Include All Document Versions - Searches all versions of the document. FileHold will only search the latest version if this option is not selected.

• Search Using Historical Metadata Fields - If metadata field names and values have been changed over time, you can still search these "historical" items as FileHold keeps track of any changes that have been made.

3. The above options can be saved by clicking the Save icon so they are kept for every advanced search performed.

4. Click Search. The search results are returned. You can continue to add or modify the advanced search criteria, save the search, or export the results to a CSV file.

7.6. SEARCH OPERATOR SELECTORS

The available search operator selectors are:

• Contains in FTS – Searches the full text search index which includes the metadata, document name, file properties, and contents of the document and contains an exact match of the value.

• Does not contain in FTS – Searches the full text search index which includes the metadata, document name, file properties, and contents of the document and the value is not present.

• Contains in DB – Searches only the metadata and contains an exact match of the value. The contents of a document are ignored (full text search index).

• Does not contain in DB – Searches only the metadata and the value is not present. The contents of a document are ignored (full text search index).

• Equals – Matches the specified value.

• Not equal – Does not equal the value specified.

• Is Blank – The value has been left empty (blank).

• Below – Matches anything below a certain level in a drill down menu type field

• > (greater than) – Is larger than the specified value.

• < (less than) – Is less than the specified value.

• >= (greater than or equal to) – Is larger than or equal to the specified value.

• <= (less than or equal to) – Is less than or equal to the specified value.

• In the list – Matches all values entered in the list. Multiple values are separated by commas.

• Not in list – Show all documents that do not match the values entered in the list. Multiple values are separated by commas.

• No older than x number of days before now – The document is not older than x days before today. In other words, 5 days old or less.

• At least x number of days older than now – The document is x many days older than the specified date. In other words, show everything prior to the last 5 days.

• Between - Search for values that are within a set of values, given the minimum and maximum values.
The following table describes the type of search operator selectors that are available for each metadata field type:

<table>
<thead>
<tr>
<th>Metadata Field Type</th>
<th>Available search operator selectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Contains in FTS, Does Not Contain in FTS, Contains in DB, Does not Contain in DB, Equals, Not Equals, Is Blank</td>
</tr>
<tr>
<td>Drill down menu</td>
<td>Contains in FTS, Does Not Contain in FTS, Contains in DB, Does not Contain in DB, Equals, Not Equals, Below, Is Blank</td>
</tr>
<tr>
<td>Drop down menu (FileHold managed and database lookup)</td>
<td>Contains in FTS, Does Not Contain in FTS, Contains in DB, Does not Contain in DB, Equals, Not Equals, In the List, Not in the List, Is Blank</td>
</tr>
<tr>
<td>Date</td>
<td>Equals, Not Equals, In the List, Not In the List, Between, &gt; (greater than), &lt; (less than), &gt;= (greater than or equal to), &lt;= (less than or equal to), At least, No older than</td>
</tr>
<tr>
<td>Number / Currency</td>
<td>Equals, Not Equals, In the List, Not In the List, Between, &gt; (greater than), &lt; (less than), &gt;= (greater than or equal to), &lt;= (less than or equal to), Is Blank</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Equals</td>
</tr>
<tr>
<td>URL</td>
<td>Contains in FTS, Does Not Contain in FTS, Contains in DB, Does not Contain in DB, Equals, Not Equals, Is Blank</td>
</tr>
</tbody>
</table>

**TIP:** For multiple selections in lists, select the check box next the value name.

### 7.7. SAVED SEARCHES

You can save your advanced search templates as a Saved Search. Every time the search is invoked any new documents that meet the query are brought into the results view.

Saved searches can be made personal or public. An Administrator can create “Public Saved Searches”. Public saved searches can be made available to all users or can be assigned security rights so that only certain groups and users can use the public saved search.

Personal searches saved by the user are called My Saved Searches. These personal saved searches can only be used by the user that created them.

There are three types of saved searches:

- **Regular saved search** – The search template is saved with all of the search criteria including operators and values for the selected criteria.
- **Quick search** – The search template is saved with only one empty variable in the template. When a user runs a quick search, they are required to enter the search term for the empty variable while all other search criteria remain fixed.
- **Empty search** – The search template is saved with empty values for all the search criteria. The user is forced to enter the values prior to running the search.

A **default view** can be set for each type of saved search so that the search results appear with the correct columns and metadata information.
7.7.1. Regular Saved Searches

A regular saved search repeats a pre-defined search when invoked. All of the set values and operators in the template are used in the search.

**TO SAVE A REGULAR SAVED SEARCH**

1. After performing an advanced search, click **Save as Saved Search**.
2. In the My Saved Searches window, enter a **Name** for the search.
3. If you want to make the search accessible to other users, select the **Make this saved search public** check box (available to administrators only).
4. If this is a public saved search, click **Next**. Select the groups and/or users that can use this public Saved Search and click **Add**. Public saved searches can only be created by library administrators or higher roles.
5. Click **OK**. The Saved Search name is now in the Library hierarchy under Search > My Saved Searches or My Public Saved Searches with an icon 🗄.

**TO USE A REGULAR SAVED SEARCH**

1. Click on the named of the saved search in the My Saved Search or My Public Saved Searches area.
2. The results of the search are displayed. You can modify the search query by adding, changing, or removing any of the filters.

7.7.2. Quick Searches

Quick searches are a type of saved search that allows you to leave a single variable in the advanced search template empty while all other variables remain fixed. When a user runs a quick search, they are required to enter the search term for the empty variable that was set up in the template. The search results that are returned meet all advanced search criteria plus the quick search term the user entered.

Quick searches are useful for conducting searches in Mobile FileHold since search terms cannot be entered for regular saved searches (non-quick type saved searches). Quick searches can be made private or public by administrators just like regular saved searches. Public saved searches can be made available to other users while personal saved searches are only available to the individual that created them.

If a quick search has been set up and configured to be used in conjunction with a FastFind search, then this search cannot be deleted. See **FastFind** for more information.

A quick search can be integrated for use with external applications. See **Integrating FileHold Search with External Applications** for more information.

**CAUTION**: Search variables with an operand of Owned by Me, Checked out by Me, and the operator “Is Blank” cannot be used in quick searches.

**TO CREATE A QUICK SEARCH**

1. After performing an advanced search, click **Save as Saved Search**.
2. In the Save this Search window, enter a **Name** for the quick search or overwrite an existing search.
3. If you want to make the search accessible to other users, select the **Make this saved search public** check box (available to administrators only).

4. Select the **Quick Search Condition** check box and select the search variable that you want a user to be able to enter a search term for.

5. If this is a public saved search, click **Next**. Select the groups and/or users that can use this public Saved Search and click **Add**. Public saved searches can only be created by library administrators or higher roles.

6. Click **OK**. The Quick Search name is now in the Library hierarchy under Search > My Saved Searches or My Public Saved Searches with an icon 📷.

**TO USE A QUICK SEARCH**

1. Click on the name of the quick search in the My Saved Search or My Public Saved Searches area.

2. Enter a value for the single search term and click **Search**.

3. The results of the search are displayed. You can view or modify the advanced search query by clicking on the Advanced link in the header.

**7.7.3. Empty Search Templates**

When an advanced search is saved, all of the search criteria values can be left empty. This will force the user to enter the search values and click Search once the saved search is selected. This differs from regular saved searches which stores the search values in the template and runs the query automatically.

**TO CREATE AN EMPTY SAVED SEARCH**

1. After performing an advanced search, click **Save as Saved Search**.

2. In the Save this Search window, enter a **Name** for the quick search or overwrite an existing search.

3. Select the **Make this saved search empty** check box.

4. If you want to make the search accessible to other users, select the **Make this saved search public** check box.

5. If this is a public saved search, click **Next**. Select the groups and/or users that can use this public Saved Search and click **Add**. Public saved searches can only be created by library administrators or higher roles.

6. Click **OK**. The Empty Saved Search name is now in the Library hierarchy under Search > My Saved Searches or My Public Saved Searches with an icon 📷.

**TO USE AN EMPTY SEARCH**

1. Click on the name of the empty saved search in the My Saved Search or My Public Saved Searches area.

2. Enter the values for the search terms and click **Search**. The results of the search are displayed.
7.8. USING FASTFIND

FastFind is an optional feature that can search third party applications using hotkeys and return the search results in FileHold. Users can use keyboard shortcut shortcuts that perform searches directly from the chosen application in the document management system to find relevant data instantly.

Once FastFind is enabled you can use the hotkeys in any third-party application. The predefined hotkeys are:

- **Mouse search (Alt+S)** – Activates an on-the-fly screen scraper. When this is done a green bar appears in the bottom-left corner of the user’s desktop screen. Users can now start moving their mouse over screen form objects such as data fields or field labels. The text under the current mouse position is captured and displayed in the green bar. If a user wishes to search with the captured text they may left click to invoke the FileHold search. This initiates the Full Text Search and Metadata search in FileHold and the search results are displayed within the standard search results screen. Pressing the **ESC** button at any time will stop the mouse search mode.

- **Selection search (Ctrl+D)** - Selection Search is similar to the Clipboard Search (and in fact is using Clipboard Search as its internal mechanism), however, it uses a one step process to initiate the search after a user highlights their selection on a business application form or as a part of the content of a document opened in a 3rd part application. Invoking Ctrl+D is all that is needed to initiate search and display results within FileHold application.

- **Clipboard search (Alt+C)** – Users can copy any text from the screen to the Windows clipboard using traditional “Copy” menu option or the Alt+C shortcut available in most Windows applications and then by pressing the Alt+C combination they can activate the Full Text Search and Metadata search in FileHold and the search results are displayed within FileHold on the standard search results screen.

- **Enable screen OCR search (Alt + F)** – Allows you to do a search based on the Click to Tag functionality. Once the shortcut key is invoked, you can click on the text on the screen or draw a bounding box around the text. Then a search is performed in FileHold to meet the selected criteria from the screen.

Since FastFind uses the contents of the clipboard any string displayed on the screen which can be copied to the clipboard (similarly to when using the well-known Cut/Paste sequence in Windows), it can be used as the search criteria including partial highlights of the text strings.

FastFind searches can be based on a full text search (file and metadata search) or a quick search. If based on a quick search, it will only search on that specific search parameter and nothing else in the system (unlike a full text search which will search through everything). Advantages of using up a quick search with FastFind would be to be able to limit the search results. For example, if FastFind was only used to locate an invoice in FileHold from your accounting software, the search results would be limited to what documents would be found using “Invoice Number” quick search. See Quick Searches for more information on configuring quick searches.

FastFind must be a purchased option and enabled before the feature will work. You can also create your own FastFind templates that work with the system. See the Knowledge Base for more information.

**TO ENABLE FASTFIND**

1. Go to **File > Preferences and Settings > FastFind Preferences** and select the Enable FastFind check box. See more information about FastFind preferences.

2. Click Apply and then OK.
7.9. SEARCHING FOR PREVIOUS VERSIONS OF A DOCUMENT

For system performance reasons, only the most recent version of the document is included in the search scope. However, users can use the advanced search setting to include all versions of documents (most recent and all previous) stored in the document management.

TO SEARCH FOR A PREVIOUS VERSION OF A DOCUMENT

1. In the Advanced Search, select the Include All Document Versions check box.

7.10. SEARCHING FOR DOCUMENTS IN A WORKFLOW

You can refine your search criteria to search for documents based on their approval status. Using Advanced Search, the user can select the Approval Status metadata field for any document schemas as long as that schema has at least one workflow template associated with it that contains at least one approval activity. Use the Approval Status select box to choose whether or not the file being searched for is approved or rejected. The Approval Status field can be used in combination with any other metadata field criteria for searching.

NOTE: If the workflow has NOT been set to hide the file until approval is complete, the file will be able to be seen by all users with access to the document. If the workflow is set to hide the document until approval then it will not be able to be seen by users who are not participants in the workflow instance. All users will be able to see the file once it is approved and the workflow completed.

TO SEARCH FOR A DOCUMENT BASED ON APPROVAL OR REVIEW STATUS

1. Go to Advanced Search.
2. Click File or Metadata and select Workflow Status and select either Approval Status or Review Status.
3. In the search operator selector, select one of the following: Equals, Does not equal, In the List, Not in the List
4. In the search criteria value field, select an option from the drop-down list. For "in the list" or "not in the list" search operator selectors, use the check boxes to select multiple values. For approval status searches, the following options are available: Approved, Pending Approval, Not Approved, Not Submitted for Approval, or Approval Postponed. For review status searches, the following options are available: Reviewed, Pending Review, or Not Submitted for Review.
5. Add any other search criteria to the advanced search and click Search.

7.11. INTEGRATE FILEHOLD SEARCH WITH AN EXTERNAL APPLICATION

A saved quick search can be invoked through an URL address from an external application. Once the URL is clicked, the search results are displayed in the Web Client. A quick search is a type of saved search where the search template is saved with only one empty variable in the template. When a user runs a quick search, they are required to enter the search term for the empty variable while all other search criteria remain fixed.
A simple tool has been provided for users that do not want to build the URL manually. When a quick search has been created and saved, the URL for the quick search can be created with the URL Builder in the Web Client. In the URL Builder, the server address, the client type (Web Client or Portal Web Client), log in type (local or Active Directory user), UI type (normal, locked or XML), and the quick search value are specified and a URL is generated.

The UI type options determine how the search results are displayed:

- **Normal** means that the results are displayed in the normal Web Client UI.
- **Locked** means that the search results are displayed in an embeddable locked view of the web client where only the heading and the document list is found. There would be no processing options, though one of the columns in the search results could be a link to the document for web viewing or downloading. Additional settings are available for modifying the title bar and page numbering in the search results screen when using this option.
- **XML** means that the search results are returned as an XML document. This can be combined with an XSL style sheet or some other XML processing method to render the precise output the caller desires. The column heading names and column values would be included in the XML as defined in the search view. The XML output include the document ID which can be used to build links for viewing or downloading the documents.

Once the settings for the URL are defined, the URL can be generated. The URL defines the quick saved search name and value(s) for the quick search. For example:

```
http://<servername>/fh/filehold/webclient/qsearch.aspx?name=<quick_search_name>&value=<search_value>
```

Where:

- `<servername>` is the name of the server where FileHold is installed
- `<quick_search_name>` is the name of the quick saved search
- `<search_value>` is the operand value that is used for the search. If more than one value is needed, values can be delimited with a ; (semicolon).

Once the URL for the quick search is clicked from an external application, the saved quick search runs and displays the search results in the selected UI type option. If the user is not logged in, the login screen appears first or the user will be logged in using Windows Authentication (single sign on).

The quick saved search can have the default view defined so that the desired information is displayed in the search results every time the URL is clicked.

Here is a basic example of how it might look on company’s web site. For this example, the URL is specified in an iframe with the UI type in locked mode.

```html
<iframe src="http://yourservename/FH/FileHold/WebClient/qSearch.aspx?name=Doc+Name&value=fh*&ui=lock" width=600 height=400>
```
Using the UI Type option that returns XML, the page can be formatted how you want if XML can be interpreted on your website.

The return page for the Web Client can be manually entered to include a returnPath parameter. For example, the user can be returned to the Add Document Wizard:


If you are using the UI in Lock mode, the returnpath can also be entered in the web.config file in C:\Program Files\FileHold Systems\Application Server\WebClient under the <appSettings> area:

<add key="qSearch_ReturnPage" value="Search_ReturnPage_PLACEHOLDER" />

If a value is entered, it is the default place the return button will take the user. If the path is not fully qualified, it is relative to the FileHold server.

To make the Return button invisible, set the value for qSearch_ReturnPage key in web.config to empty. For example:

<add key="qSearch_ReturnPage" value="" />

**TO CREATE AN URL TO RUN A SEARCH FROM AN EXTERNAL APPLICATION**

1. Create a quick search and save it as public saved search. Ensure you assign the correct permissions to the saved quick search.
2. In the Web Client > Public Saved Searches area, right-click on the quick search name and select URL Builder.

3. In the URL Server Part field, enter the path to the FileHold server.

4. In the Client Type area, select if the link is accessed through the Web Client or the Portal Web Client (anonymous portal).

5. In the Login Type area, select if the user is logging in using a username and password, or using single sign on (Active Directory integration). Note that if you are not using Active Directory integration, the single sign on option will not be available.

6. In the UI Type area, select if the results are displayed in normal (Web Client), locked (embedded locked mode) or XML (highly customizable mode).

7. If Locked UI mode was selected, fill out the following information:
   - Select the Disable title bar check box if you do not want the Search by URL title bar displayed in the search results.
   - Enter a Custom Title bar if needed such as "Documents to be approved". The default title is "Search by URL".
   - Select the Disable summary bar if you don’t not want the number of search results displayed. For example, "Search Results 1-10 of 52".
   - Select the vertical position of the page numbers in the Page Bars Vertical Position drop down: Top, Bottom, or Top and Bottom.
   - Select the horizontal alignment of the page numbers in the Page Bars Horizontal Alignment drop down: Right, Left or Center.

8. In the quick search parameter area, enter the value to be searched on Click Generate URL.

9. In the URL Builder Result area, the URL address is displayed. Click Go To Link to test the link.

10. Once the link is verified and working, copy and paste the link into the external application. Note that there is no way to save this link so you will need to copy and paste it into a Notepad file or similar to retain the link address.

   In the example below, a quick search on Approval Status was created with the search value set to Approved. The resulting URL is:


   ![Page numbers](image)
Note: The number of search results displayed on a page is set in the View Preferences for the Search Results view.
8. VIRTUAL FOLDERS

A virtual folder does not contain the actual document; it only holds a pointer back to the document. All virtual folders are private (i.e. unique to the user) unless they are made public. Public virtual folders can be seen by users with the correct permissions to the documents.

- Regular Users can create virtual folders for their own use. They cannot be made public.
- Library administrators or higher roles can create virtual folders and make them private or public. Public virtual folders are seen by all users that are given access. Users with access to a virtual folder will still need the proper permissions to access any documents that are listed.
- Users have access to Public (or shared) Virtual Folders in both the Web Client and FileHold Desktop Application. These folders are created and populated by library administrators to collect and disseminate documents to multiple users. Public Virtual Folders are a perfect way for documents located throughout the FileHold library to be displayed in one place for access by all users that are given access to by library administrators who assign the membership when creating virtual folders. Library administrators can change their personal virtual folders to public and back again.

Virtual folders can be deleted at any time. The documents contained in a virtual folder are not deleted from the system. They will still be located in their original folder.

TO CREATE A VIRTUAL FOLDER
1. Right click on the Virtual folder section in the FileHold Desktop Application and select Add Virtual Folder.
2. Enter the name for the Virtual Folder.
3. If you are a library administrator, you can set the folder as public or private.
4. Do one of the following:
   - Click OK if a private folder.
   - Click Next if a public folder.
5. If the Virtual Folder is a public folder, set the security to allow user access and click OK.

TO DELETE A VIRTUAL FOLDER
1. Right-click the Virtual Folder name from the list and select Delete.
2. Click OK on the warning message to proceed with the deletion process.

TO ADD A DOCUMENT TO A VIRTUAL FOLDER
1. Select one or more documents that you want to add to a virtual folder. You can use the SHIFT or CTRL keys to select multiple documents in the FDA. Check the box next to the document name to select documents in the Web Client.
2. Right and select Send To > Virtual Folder.
3. Select the virtual folder to which you want to add the documents or create a new virtual folder.
4. Click OK. The shortcuts to the documents will now be in the virtual folder.
   - ALTERNATIVELY, you can drag and drop one or more documents into the virtual folder.
TO REMOVE A DOCUMENT FROM A VIRTUAL FOLDER

1. Select one or more documents in the virtual folder that you would like to remove. You can use the SHIFT or CTRL keys to select multiple documents in the FDA. Check the box next to the document name to select documents in the web client.

2. Press the CLEAR button at the top of the file list to remove the documents from the virtual folder. This will not delete the documents from the document repository.
9. THE LIBRARY STRUCTURE

All files in FileHold software are stored under the library icon (root folder) shown in the file structure located on the left-hand side of interface.

Taking a closer look at the file structure you can see that the document management software uses a real-world metaphor for filing. The Library is filled with cabinets that contain drawers that contain folder groups (optional) that contain folders. Only folders can contain documents.

![File structure diagram]

**NOTE:** Documents are displayed as a list in the display pane to the right of the file structure. Documents can be displayed by selecting the folder they reside in or by searching to gather files from multiple folder locations.

Documents can only be stored in folders in the document management system. Folders can be located directly within drawers or within folder groups.

Access to specific areas of the document management software is controlled by group and user memberships at the cabinet and folder levels. Only users that are members of a cabinet can see the cabinet to access its contents. Once inside the cabinet a user must also be a member of the folders it contains in order to access files contained within the folder. If the user is not a folder member they will not be able to see the folder. Users can see the membership associated with a particular cabinet or folder by right clicking on the cabinet or folder and selecting Properties. Once authenticated to access files inside a folder access to individual document schemas is by schema membership. Users must be a member of schema in order to view files associated with this document schema in the document management system.

**NOTE:** Users who are not members of a folder will not see the folder. To get access a user will have to be added by the owner of the folder or a library or systems administrator.

Along with memberships at the cabinet and folder level, the document management software system, maintains membership permissions by document schema. For example, users in the sales department can be restricted to only add, search for and access sales document schemas (invoices, purchase orders and contracts) while users in the HR department can be restricted to only add, search for and access only HR document schemas (expense reports, vacation requests and performance reviews) even if they are located in the same folder. Only a designated library administrator can change the membership associated with a document schema. See setting up and managing document schemas for more information.

In addition to the membership in cabinets, drawers, folders and document schemas, access to documents is controlled by roles that individual users are assigned to. All roles and their related permissions are described on the user role page.

The document level permission icons indicate operations allowed for a given role or provide some additional information regarding the statuses of the documents visible in the folder view.
9.1. CABINETS

Only library administrators, senior library administrators, and system administrators can create cabinets.

In order for a user to see a cabinet they must be a member of the cabinet. Only members of cabinets can see and access its content. In order to manage the access to a particular cabinet, the owner of the cabinet can add and remove member access and permissions. For more information on cabinets, see the Library Administration Guide.

9.2. DRAWERS

Only cabinet administrators, library administrators, senior library administrators, and system administrators can create drawers.

In order for a user to see a drawer they must be a member of the cabinet in which the drawer resides. The availability of actions is dependent on the rights that users have to the cabinet that the drawer resides unless further restrictions have been placed on the drawer by its owner, the library administrator or the Systems Administrator. For more information on drawers, see the Library Administration Guide.

9.3. FOLDER GROUPS

Folder groups are intended to be used as an extra layer of division in the Library structure but their use is optional. Like drawers that divide cabinets into more manageable size; folder groups divide drawers into more suitably sized portions. Folder groups contain only folders.

In order for a user to see a folder group they must be a member of the cabinet in which the folder group resides. The availability of actions is dependent on the rights that users have to the cabinet that the folder group resides unless further restrictions have been placed on the folder group by its owner, the library administrator or the Systems Administrator.

The following actions can be performed on folder groups:

<table>
<thead>
<tr>
<th>Action / Function</th>
<th>What the Function Does</th>
<th>Who Can Access the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Folder Group</td>
<td>Expands the folder group revealing its contents.</td>
<td>All users with access to the cabinet that the folder group belongs to.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows users to restrict their search to files located in the selected folder group.</td>
<td>All users with access to the folder group.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the folder group Properties.</td>
<td>All users with access to the folder group.</td>
</tr>
<tr>
<td>Set Default View</td>
<td>Allows user to select a default view that has been created in the View Preferences.</td>
<td>All users with access to the folder group.</td>
</tr>
<tr>
<td>Add Folder</td>
<td>Allows user to add a folder to the folder group.</td>
<td>Users with Publisher or higher access.</td>
</tr>
<tr>
<td>Move Folder Group</td>
<td>Moves the folder group to a different drawer.</td>
<td>Users with Organizer or higher access.</td>
</tr>
<tr>
<td>Action / Function</td>
<td>What the Function Does</td>
<td>Who Can Access the Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Copy Folder Group</td>
<td>Makes a copy of the folder group including all folders and files it contains.</td>
<td>Users with Organizer or higher access.</td>
</tr>
<tr>
<td>Clone Folder Group</td>
<td>Makes a copy of the folder group and the folders it contains. Does not copy documents in folders.</td>
<td>Users with Publisher or higher access.</td>
</tr>
<tr>
<td>Delete Folder Group</td>
<td>Deletes the folder group and all items it contains.</td>
<td>Users with Organizer + Delete or higher access.</td>
</tr>
<tr>
<td>Archive Folder Group</td>
<td>Manually sends the contents of the folder group to the Library Archive.</td>
<td>Library administrator or system administrators only.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports all documents in the folders contained in the folder group.</td>
<td>Users with Organizer or higher access.</td>
</tr>
</tbody>
</table>

**TO MANAGE FOLDER GROUPS**

1. Right-click on a cabinet and select Manage Folder Groups. The folder group list window opens with a list of existing folder groups.
2. To add a folder group, click Add Folder Group.
3. Enter a folder group Name.
4. Select a weight for this folder group from -10 to 10. The lower the weight (such as -10), the higher the folder group name appears in the Library. The higher the weight (such as 10), the lower the folder group name appears in the list. Leave the weight at 0 if you want the folder groups sorted alphabetically.
5. Click Save. The folder group name is added to the list.

**TO ASSIGN A FOLDER GROUP TO A DOCUMENT FOLDER**

1. Right-click on a folder in the Library and select Properties.
2. In the Folder Group field, do one of the following:
• Select the folder group to which you want this folder to belong from the list.
• To create a new folder group, select Add a New Folder Group and enter the name in the New Folder Group Name field.

3. Click OK. The folder is moved into the selected folder group.

**TO EDIT OR DELETE A FOLDER GROUP NAME**

1. Right-click on a folder group in the Library and select Properties.
2. Click Edit Folder Groups.
3. To edit a folder group name, double-click on a folder group.
4. In the Edit Folder Group window, enter a new name for the folder group and a weight (optional). The lower the weight (such as -10), the higher the folder group name appears in the Library. The higher the weight (such as 10), the lower the folder group name appears in the list. Leave the weight at 0 if you want the folder groups sorted alphabetically.
5. Click Save.
6. To delete the folder group, click Delete.

**9.3.1. Calculating the Folder Group Statistics**

You are able to see how many folders, documents, number of files and size of the repository that are contained within a folder group by looking at the statistics.

**TO CALCULATE THE FOLDER GROUP LEVEL STATISTICS**

1. Right-click on a folder group in the tree structure and select Properties.
2. In the folder group properties window, click Calculate. The number of folders, files (latest version), size (in MB), files (all versions) and size of all versions (in MB) is shown. Click Cancel to close the properties.

**9.4. FOLDERS**

Folders are the level in the library structure where documents reside. Documents can only reside at the folder level. The results for the total number of documents in a folder can be viewed in the header bar. Only users that are members of a particular folder can access the files that reside in that folder.

When a user with a role of Publisher or higher creates a new folder, they must associate groups (or users) with the folder in order to protect the contents of the folder from unauthorized users. ONLY groups (or users) associated with a folder will see and have access to the folder. Permissions can be further restricted once the groups or users are assigned as members.

The groups that are available to be members of the folder are inherited from the cabinet in which the folder resides. If you wish to add groups other than the ones that appear in the folder properties, the group must first be added at the cabinet level of the document management system. After the group is added at the cabinet level, the new group will appear in the Available FileHold Group listing in the folder properties security section.

Security on the folder can be modified using the advanced security option. You are able to give a user or group a role that is less than what is already designated to them. For example, you can modify a cabinet administrator’s role to reduce it to document publisher. If a group or user’s permissions are modified using the advanced security option, a red dot appears on the folder that has been modified when the user logs in.
The availability of actions is dependent on the rights that users have to the cabinet that the folder resides unless further restrictions have been placed on the folder by its owner, the library administrator or the Systems Administrator. The following actions can be performed on folders:

<table>
<thead>
<tr>
<th>Action / Function</th>
<th>What the Function Does</th>
<th>Who can Access the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Folder</td>
<td>Opens the folders and shows the files it contains.</td>
<td>All users with access to the folder based on the folder membership.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows users to restrict their search to files located in the selected folder.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays the folder properties.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Set Default View</td>
<td>Allows user to select a default view that has been created in the View Preferences.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Alert Me of Changes</td>
<td>Subscribes the user to be alerted when certain actions are performed on the folder by other users. The types of actions that trigger alerts are managed by the users Alert Preferences. Users can remove folder alerts from the My FileHold; Document alerts page OR select the 'Disable This Alert' option from the folder menu.</td>
<td>All users with access to the folder.</td>
</tr>
</tbody>
</table>
## Action / Function

<table>
<thead>
<tr>
<th>Action / Function</th>
<th>What the Function Does</th>
<th>Who can Access the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable This Alert</td>
<td>Disable the alert for the folder. The user will no longer be alerted when certain actions are performed on this folder. Reactivate the alert by clicking on the 'Alert Me of Changes' option in the folder menu.</td>
<td>All users with access to the folder.</td>
</tr>
<tr>
<td>Move Folder</td>
<td>Moves the folder to a different drawer or folder group.</td>
<td>Users with Publisher or higher access that are the folder owner.</td>
</tr>
<tr>
<td>Copy Folder</td>
<td>Makes a copy of the folder.</td>
<td>Users with Publisher or higher access that are the folder owner.</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>Deletes the folder and all documents it contains.</td>
<td>Users with Publisher and Delete or higher access that are the folder owner. If the user is Publisher and Delete role they must be also be the owners of all document versions in the folder before they can delete a document.</td>
</tr>
<tr>
<td>Clone Folder</td>
<td>Makes a copy of the folder group and the folders it contains. Does not copy documents in folders.</td>
<td>Users with Publisher or higher access.</td>
</tr>
<tr>
<td>Archive Folder</td>
<td>Manually sends the contents of the folder group to the Library Archive.</td>
<td>Library administrator or system administrators only.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports all documents in the folders contained in the folder group.</td>
<td>Users with Publisher or higher access and that are the folder owner.</td>
</tr>
</tbody>
</table>

## TO CREATE A FOLDER

1. In the Library, right-click a drawer or folder group and select **Add Folder**.
2. Enter a **Name** for the folder.
3. Select a **folder owner** for the list. Your permissions may be restricted to only allowing yourself to be the owner of the folder.
4. Select a **Default Schema** from the list. The list of schemas will be only those that you have access to.
5. Select a **Folder Group** from the list (if applicable).
6. Select a **Weight** for the folder. The lower the weight (such as -10), the higher the folder name appears in the Library. The higher the weight (such as 10), the lower the folder name appears in the list. Leave the weight at 0 if you want the folder groups sorted alphabetically.
7. Select a Color from the list. Options include: yellow (default), green, red, and blue. The folder is displayed in the library tree in the selected colour.

8. Click Next.

9. In the Security tab, do the following:
   - In the Group By field, select how you want the available FileHold Groups displayed.
   - In the Available FileHold Groups area, select the groups you want to be able to access the cabinet and click Add Groups. The group is added to the Current Members of Cabinet list.
   - In the Eligible Users in the FileHold Group, select the user you want to be able to access the cabinet and click Add User. The user is added to the Current Members of Cabinet list.
   - To remove a user or group from the cabinet, select the name from the Current Members of Cabinet list and click Remove Members.
   - To view all Groups and Users, click Group Members. A new All Groups/Users panel opens on the right side of the window.
   - To see which user roles the user or group belongs to, select the user or group name in the Current Members list and click Effective Permissions. The user role for that cabinet member will appear in the Effective Permissions list.
   - To set advanced security options on a user or group, select the user or group name in the Current Members list and click Advanced Security Options. To modify the rights, select a user role from the list and click Apply. To revert to the default user role, click Restore. Note that if a group or user’s permissions are modified, a red dot appears on the folder that has been modified when the user logs in.
   - Select the Inherit Security Permissions from Cabinet check box if you want to inherit the security settings from the cabinet that the folder will reside. If you select this check box, you cannot modify the members of the folder.

10. Click Next.

11. In the Auto-tagging tab, you can set the documents that are added to the folder to be automatically tagged (metadata automatically added). See the section Creating Auto-Tagged Folders for more information.

12. Click Save. The folder is added to the Library structure.

To edit the folder properties

1. Right-click on a folder in the Library and select Properties. The folder properties window opens.
2. Make any changes to the folder properties and click **Save**.

**TO DELETE A FOLDER**

1. Right-click on a folder in the Library and select **Delete Folder**.
   
   **NOTE:** You need to have delete permissions in order to delete a folder.

2. You will receive a warning message. Click **OK** to delete the folder. The folder is removed from the Library.

   ![Warning message]

**TO COPY A FOLDER**

1. To copy a folder, its security, and all of its contents *including documents*, right-click on the cabinet and select **Copy Folder**.

2. Enter a name for the copied folder and click **OK**. The copied folder appears in the Library hierarchy.

   **WARNING:** Copying large folders and its contents will cause the FileHold server to consume resources and may slow down the system. We recommend that you do this after business hours if copying folders containing tens of thousands or many hundreds of thousands of documents. The amount of time it will take to copy a folder and its contents is dependent on the server hardware that powers the system; the faster the server hardware the better.

**TO CLONE THE FOLDER STRUCTURE**

1. To clone a folder, its security, and all of its contents including drawers, folders and folder groups, right-click on the cabinet and select **Clone Folder**.

2. Select a destination in the Library for the cloned folder.

3. Enter a name for the cloned folder and click **OK**. The cloned folder appears in the Library hierarchy.

   **NOTE:** Cloning a folder does **NOT** copy the documents. Use **Copy Folder** to copy folders and documents.

**TO ARCHIVE A FOLDER**

1. To send a folder and its contents to the Library Archive, right-click on the folder name and select **Archive Folder**.

2. At the message prompt, click **OK**. The folder and its contents are moved to the archive.
**TO MOVE A FOLDER**

1. Right-click on a folder and select **Move Folder**.
2. Select the destination location by navigating through the Library in the dialog box and click **OK**. The folder is moved to the location.

**TO SET THE DEFAULT VIEW FOR THE FOLDER**

Administrators can create public views in the View preferences area and then assign the default view to each folder. Users can create personal views and assign it to a folder.

1. Right-click on the folder and select **Set Default View**.
2. Clear the **Inherit setting from parent container** check box.
3. Select the view you want to use from the drop-down list.
4. Click **OK** to save your settings.

**9.4.1. Viewing the Folder Statistics**

You are able to see how many documents, number of files and size of the repository that are contained within a folder by looking at the statistics.

**TO VIEW THE FOLDER STATISTICS**

1. Right-click on a folder in the tree structure and select **Properties**.
2. In the folder properties window, files (latest version), size (in MB), files (all versions) and size of all versions (in MB) is shown. Click **Cancel** to close the folder properties.

**9.4.2. Creating Auto-Tagged Folders**

When documents are added to the system, you need to set the document with metadata in order to store it in the Library. Auto-tagging removes the manual step of setting the metadata step out of the process. The metadata values to be automatically applied to all files placed in the folder with auto-tagging configured. Auto-tagging on a folder is set on a document schema; therefore, all files using that schema will use the predefined auto-tags.

Auto-tagging can be set at the cabinet or folder level. If some of the documents in the cabinet or folder belong to a different schema type than what has been defined in the auto-tagging tab, then the metadata will not be changed or overwritten.

When documents are added to a folder that is auto-tagged, they must follow the rule that is defined and no changes can be made to that rule. For example, if the auto-tagging rule is set to the Invoices schema, then no other document schema types can be added to that folder.

Auto-tagging rules are set up by the folder owner or higher roles.
TO SET AUTO-TAGGING ON FOLDERS (OR CABINETS)

1. When creating a new folder go to the Auto-Tagging tab or for an existing folder, go to Folder Name > Properties > Auto-Tagging.

2. In the Auto-Tagging tab, select the Enable Auto-tagging check box to have all documents in this folder automatically “tagged” with the same metadata based on the schema as they are added to this cabinet. This assumes that all of the documents that are being added to the cabinet have mostly the same metadata as all the other documents in the cabinet. This ensures a highly compliant filing system and standardization across all documents within the cabinet or folder. Users can select to have some standard repetitive metadata added automatically, manually, or a combination of both.

3. Select the Make this the default auto-tagging settings for all folders in this cabinet if desired if you are setting up auto-tagging at the cabinet level. This option is not available at the folder level.

4. In the Auto-Tagging Metadata area, select the document schema and the metadata. You do not have to set all the metadata fields; you can leave them blank for the user to enter them.

5. Click Save.

6. The folder with the auto-tagging rule has the letter “A” on the folder signifying that is being automatically tagged.

[Image: User Documentation - PDF]
10. DOCUMENT ACTIONS AND FUNCTIONS

A variety of actions can be taken on individual document versions. Actions are accessible from the contextual menu associated with a document by right-clicking on the document name.

The following actions can be performed on one or more documents at a time. The availability of actions is dependent on the rights that the user has.

<table>
<thead>
<tr>
<th>Action /Function</th>
<th>Description</th>
<th>Permissions needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open (FDA only)</td>
<td>Opens the selected document in its native application.</td>
<td>All users with access to the document.</td>
</tr>
<tr>
<td>Open in Brava viewer (FDA only)</td>
<td>Opens files in the Brava document viewer. This option is only available if the Brava viewer is installed and licensed for the user.</td>
<td>Users that have been assigned a Brava viewer license. Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.</td>
</tr>
<tr>
<td>Open in PDF/Image viewer (FDA only)</td>
<td>Opens the document in the PDF/Image Viewer.</td>
<td>All users who have been assigned a FileHold level 1 or level 2 viewer license.</td>
</tr>
<tr>
<td>Open in FileHold viewer (both FDA and Web Client)</td>
<td>Opens the document in the FileHold Viewer.</td>
<td>All users who have been assigned a FileHold level 1 or level 2 viewer license.</td>
</tr>
<tr>
<td>Make a Local Copy (FDA) Get a Copy (Web Client)</td>
<td>Creates a copy of the document to the user’s local machine. The copy is automatically sent to the My FileHold Documents folder.</td>
<td>All users with access to a file.</td>
</tr>
<tr>
<td>Check Out This Document (FDA) Check Out (Web Client)</td>
<td>Checks out the document and downloads it to your working directory which is typically My FileHold Documents folder.</td>
<td>Users with document publisher rights or higher.</td>
</tr>
<tr>
<td>Check In This Document (FDA) Check In (Web Client)</td>
<td>Checks documents back in the system and opens the “lock” on the document. Documents that are checked in are given a new document version number.</td>
<td>Users with document publisher rights or higher. However, only the user that has checked the document out of library OR the library system administrator may check it back in.</td>
</tr>
<tr>
<td>Action /Function</td>
<td>Description</td>
<td>Permissions needed</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| Workflow > Initiate workflow template name (FDA) | Allows you to select the workflow template name from the list and start a workflow. Selecting more than one document will start a multiple document workflow. See the *Workflow and Courier Guide* for more information. | Users with Document Publisher rights or higher and is owner of the document.*  
*Unless the 'Allow non document version owner to initialize workflow" permission setting is enabled. |
<p>| Workflow &gt; View Sign-Off Sheet | Listing of all users that either approved or rejected this version of the document, when they did it, and if they signed-off on behalf of someone else. See the <em>Workflow and Courier Guide</em> for more information. | Users that are participants or observers in a workflow. |
| Workflow &gt; View Review &amp; Approval History | View the history of comments for a workflow. See the <em>Workflow and Courier Guide</em> for more information. | Users that are participants or observers in a workflow. |
| Workflow &gt; Cancel Workflow | Cancels a workflow in progress. See the <em>Workflow and Courier Guide</em> for more information. | Initiators of a workflow or library administrators or higher. |
| Workflow &gt; Submit Approval | Allows you to approve a document. See the <em>Workflow and Courier Guide</em> for more information. | Users assigned to perform an approval task in a workflow. |
| Workflow &gt; Submit Review | Allows you to submit a review on a document. See the <em>Workflow and Courier Guide</em> for more information. | Users assigned to perform a review task in a workflow. |
| Courier &gt; View transmission status | Displays the Courier transmission report for the document. See the <em>Workflow and Courier Guide</em> for more information. | Senders of the transmission and cabinet administrators or higher role and are owners of the cabinet. |
| Courier &gt; Initiate <em>Courier template name</em>&gt; | Select the Courier template name from the list and start a Courier transmission. See the <em>Workflow and Courier Guide</em> for more information. | Anyone with a document publisher role or higher and has permission to use Courier. |
| Metadata and File Properties | Displays the <em>Metadata and file properties</em> for a file stored in the documents management software. | All users with access to the folder the document is in. |</p>
<table>
<thead>
<tr>
<th>Action /Function</th>
<th>Description</th>
<th>Permissions needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Metadata</td>
<td>Displays the Metadata and file properties for the selected files and allows you to edit the metadata en masse.</td>
<td>Users with document publisher rights or higher.</td>
</tr>
<tr>
<td>Link Documents (FDA) Link (Web Client)</td>
<td>Displays the Create Links window to link the selected documents together.</td>
<td>Users with document publisher rights or higher.</td>
</tr>
<tr>
<td>View Linked Documents</td>
<td>Displays all documents that are linked to a selected document.</td>
<td>All users with access to the folder the document is in.</td>
</tr>
<tr>
<td>Redact Document (FDA only)</td>
<td>Sends a file to the Brava viewer so that the user may redact (black out) portions of the text before sharing for security reasons.</td>
<td>Users with a Brava viewer license who have the role of Document Publisher or greater. Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.</td>
</tr>
<tr>
<td>Send to &gt; Document Tray</td>
<td>Send a document to the Document Tray.</td>
<td>All users with read only or higher.</td>
</tr>
<tr>
<td>Send to &gt; Virtual Folder</td>
<td>Send a document to a Virtual Folder.</td>
<td>All users with read only roles or higher.</td>
</tr>
<tr>
<td>Send to &gt; Local Folder (FDA only)</td>
<td>Downloads a copy of document to a folder on your local computer. You can browse to where you want the document downloaded.</td>
<td>All users with read only roles or higher.</td>
</tr>
<tr>
<td>Send to &gt; Export (FDA only)</td>
<td>Exports the documents to your local computer in their native format and an XML file containing the metadata, schema, and library location for the selected documents.</td>
<td>All users with document publisher roles or higher unless restricted by administration.</td>
</tr>
<tr>
<td>Send to &gt; Email</td>
<td>Emails the document as an attachment or a link to the document in the document management system.</td>
<td>All users with read only roles or higher unless restricted by administration.</td>
</tr>
<tr>
<td>Send to &gt; Email and Check Out</td>
<td>Emails the document as an attachment or a link and checks out the document at the same time.</td>
<td>All users with document publisher roles or higher.</td>
</tr>
<tr>
<td>Action /Function</td>
<td>Description</td>
<td>Permissions needed</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Send to &gt; Library Archive</td>
<td>Sends the document to the Library Archive.</td>
<td>All users with Library Administration or higher unless restricted by administration.</td>
</tr>
<tr>
<td>Send to &gt; Printer (FDA only)</td>
<td>Send the document to your printer. This function is available if enabled and user has a viewer license.</td>
<td>All users with document publisher roles or higher unless restricted by administration.</td>
</tr>
<tr>
<td>Send to &gt; Existing Workflow (Web Client only)</td>
<td>Adds a main or supporting document to an existing workflow.</td>
<td>Users with Document Publisher role or higher. User must have access to all added documents and be owner of the document version when adding main documents.</td>
</tr>
<tr>
<td>Publish As</td>
<td>Allows users to convert documents in FileHold to PDF, TIFF, DWF or CSF. This function is available only if you have the Brava viewer.</td>
<td>All users with document publisher role or higher unless restricted by administration. Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.</td>
</tr>
<tr>
<td>Notify Me</td>
<td>Create a Document Alert or Reminder and/or cancel ones that have been created.</td>
<td>All users with access to the document.</td>
</tr>
<tr>
<td>Create Shortcut</td>
<td>Allows the user to create a shortcut to a selected document in another Folder located in the document management system. Note that this functionality is disabled unless it is enabled by an administrator.</td>
<td>Users with Publisher access rights or higher that have access to the folder the document is in.</td>
</tr>
<tr>
<td>Go to Document Location</td>
<td>Takes you to the folder location of the selected document. This function is available when you are not in a folder such as in My Favorites, search results, virtual folder and so on.</td>
<td>All users with access to the document.</td>
</tr>
<tr>
<td>Action /Function</td>
<td>Description</td>
<td>Permissions needed</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Copy or Move</td>
<td>Make a copy of a document or move it to another location in FileHold.</td>
<td>Document Publisher and Publisher need to have ownership of the document. Organizers or higher permissions can move documents owned by anyone. Restrictions on where a document can be moved to will apply.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a document from the system.</td>
<td>All users with Document Publisher + delete permissions or higher (and in some cases, they can only delete their own documents. See User Roles for more information). Library administrators can recover deleted documents within the configured number of days.</td>
</tr>
<tr>
<td>Convert to Offline</td>
<td>Converts an electronic document to an offline document. Downloads the file to the local machine and deletes all versions of a file from the document management system.</td>
<td>Users with Cabinet Administrator rights or higher and are owners of the cabinet.</td>
</tr>
<tr>
<td>Rename</td>
<td>Rename a document.</td>
<td>Users that created the file or those with Document Publisher or higher permissions.</td>
</tr>
<tr>
<td>Change Document Owner</td>
<td>Change the owner of a document version. Ownership change can be done one document at a time.</td>
<td>Users with Organizer role and higher. Cabinet Administrators must own the cabinet.</td>
</tr>
</tbody>
</table>
| View Version History | Displays the usage logs for the selected document including:  
  - All versions of the document. Actions that users have taken on the document by document version.  
  - Edits to the document. | All users with access to the folder the document is in. |
<table>
<thead>
<tr>
<th>Action /Function</th>
<th>Description</th>
<th>Permissions needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download as Zip File</td>
<td>Downloads multiple documents as one zip file. Note: This command only appears if multiple documents are selected first. The zip file name will include the user name and the download date.</td>
<td>Users with access to the folder the document is in.</td>
</tr>
</tbody>
</table>

10.1. **ADDING DOCUMENTS TO FILEHOLD**

Users with Document Publisher and higher permissions can add files to the document management system. Documents can be brought into FileHold using several methods:

- **Drag and drop** — Drag and drop a document from your local computer.
- Directly within FileHold — In the **FDA** or **Web Client**.
- **Microsoft Office** applications — Use the integrated FileHold toolbar to add documents.
- **Microsoft Outlook** — Add emails using the integrated FileHold toolbar or the “watched folder”.
- **Watched Folders** — Documents can be brought into the system automatically from a scanner location. See **Watched Folders** for more information.
- Manage Imports — Documents can be brought into the system automatically using the Manage Imports tool. See the **Library Administration Guide** for more information.
- **WebCap** — Web-based scanning through the Web Client.
- For other ways to get documents into FileHold, see the **Knowledge Base**.

10.2. **DRAGGING AND DROPPING DOCUMENTS**

You can use Windows Explorer to drag and drop one or many documents into a folder or the Inbox of the FileHold Desktop Application (FDA). If dragging and dropping multiple documents, they will be automatically sent to the Inbox for processing. If dragging to a folder location, the destination folder will be automatically set.

You cannot drag and drop documents into the FileHold Web Client.

**To drag and drop documents**

1. In Windows Explorer, select the files to be transferred to FileHold from the local computer.
2. Drag and drop them to their destination folder or to the Inbox.
3. For files dragged to a folder destination, enter the metadata (unless the folder is auto-tagged) and click **Add**. The document is added to the location.
4. For files dragged to the Inbox, enter the metadata and select a destination.
   - Click **Set Metadata** and **Set Destination** to enter the metadata and select the destination folder.
   - Click **Send** or **Send All** to send the document(s) to the folder.

   - See [Entering Metadata for a Document](#) for more information on setting metadata on documents.

10.3. **ADDING DOCUMENTS DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION**

   There are many ways in which you can add one or documents directly from the FileHold Desktop Application:
   - Click the **Add File** (+) button from the Inbox or folder location.
   - Go to **File > Add File to Library**. This option allows you to add one or many documents.
   - Go to **File > Add Folder to Library**. Adds the entire contents of a folder (not the folder itself) to the Inbox.

   If you are adding more than one document at a time, then the documents will automatically go to the Inbox for processing.
TO ADD FILES DIRECTLY FROM THE FILEHOLD DESKTOP APPLICATION

1. Do one of the following:
   - From the Inbox or a folder location, click Add File (+ sign).
   - Go to File > Add File to Library.
   - Go to File > Add Folder to Library.

2. Select the file from the local computer and click OK.

3. If the file was added to the Inbox, the metadata and destination will need to be set. Click Set Metadata and Set Destination to enter the information. After the information is entered, click Send or Send All. See Entering Metadata for a Document for more information on setting metadata on documents.

4. If the file was added to a folder, enter the metadata and click Add.

10.4. ADDING DOCUMENTS THROUGH THE FILEHOLD WEB CLIENT

When adding documents via the web client, you can only add a single document at a time. If you need to add multiple documents, use the FileHold Desktop Application. Since there is no Inbox in the Web Client, you add a document from within the destination folder or use the Add Document Wizard.

TO ADD A DOCUMENT VIA THE WEB CLIENT

1. In the destination folder, click Add File to Folder.

   2. When the Metadata pane opens, select the Document Schema from the list.

   3. Select the format of the document, if applicable.

   4. Click Browse to locate the file that you want to add to the repository.

   5. Fill out the required metadata fields. See Entering Metadata for a Document for more information on setting metadata on documents.

   6. Click Save.

TO ADD A DOCUMENT USING THE ADD DOCUMENT WIZARD

1. In the Web Client, select Add Document from the library tree.
2. In the Select a File page, select the document type:
   - Add local file – Select this option to add a file from the local computer, network, etc.
   - Add offline document – Select this option to add an offline document.

3. Do one of the following:
   - If “Add local file” was selected, click **Browse** to locate the file to add to the repository.
   - If “Add offline document” was selected, select the **Use date/time** check box to use the date and timestamp as the document name or manually type a document name.

4. Click **Next**.

5. In the Select a Folder page, select a destination folder from the library tree or select the **Auto-file the document according to its metadata** check box to automatically set the destination. Note that auto-filing must be configured by your administrator in order to use it. If you try to use auto-filing and it has not been configured, you will receive a message stating "The selected document schema doesn’t have an associated auto-filing script."

6. Click **Next**.

7. In the Metadata page, select the schema and enter the metadata field values.
   - If an offline document was added, only the list of offline schemas appears in the list. To select an alternate schema format, select the **Show all document schema formats** check box.

8. Click **Submit**.

10.5. **ADDING DOCUMENTS FROM MICROSOFT OUTLOOK**

Users can save entire emails, including attachments or save just the attachment without the email. Emails can be brought into the system:
   - Drag and drop emails from Microsoft Outlook into the FileHold document management system.
   - Use the **Add to FileHold** button from the Add Ins toolbar in Microsoft Outlook. The email message has to be opened in order to use the Add to FileHold button as you cannot do it from the messages view.
   - Using a Microsoft Outlook ‘watched folder’ allows you to add any emails into the “watched folder” in Outlook so that the emails are brought into a folder on the local computer or network location. Then having a **watched folder** or managed import set up in the FileHold Desktop Application (FDA) (see the **Library Administrator Guide** for more information on managed imports), the emails automatically get brought into system for processing.

Emails are saved as msg files and open in Outlook with their attachments. The email header information (To, From, CC, Date, Subject and Attachment) may be automatically extracted into the metadata fields, depending on what your administrator has configured. That way, you do
not have to type this information in; instead the system will do it for you. See Extraction Rules in the Library Administration Guide for more information.

For the watched folder in Outlook, you can set up special email rules in Outlook to ensure the correct emails are being moved into the document management system. You can also drag and drop emails into the watched folder. Once an email has been sent into the document management system, it can never be imported again.

**TO ADD EMAILS FROM MICROSOFT OUTLOOK**

1. Do one of the following:
   - From Microsoft Outlook, select one or more emails and drag and drop the files into either the Inbox or a folder location. Enter any required metadata and/or destination information. See Entering Metadata for a Document for more information on setting metadata on documents.
   - From Microsoft Outlook, open an email and go to the Add-Ins tab and click Add to FileHold (+ sign). Select the folder location and enter the metadata and click Add. See Entering Metadata for a Document for more information on setting metadata on documents.
   - Drag and drop or set up an Outlook rule to send documents to the Outlook watched folder. See below for more information.

**DRAGGING AND DROPPING EMAILS FROM OUTLOOK**

Drag and drop allows a user to move multiple emails from Outlook to the document management system FDA.

1. Select the email(s) that are to be moved to the document management system.
2. Drag and Drop to the FDA.
3. Emails will automatically be sent to the Inbox for processing.

**Remember:** Emails saved to the system can only be accessed by those with appropriate permissions to access the folder in the document management system where the email is saved.

**TO SET UP THE MICROSOFT OUTLOOK WATCHED FOLDER**

1. Create a folder in Microsoft Outlook that you want add the emails to.

2. On your local computer or network location, create a folder that you want FileHold to “watch” for new emails to be brought into the repository.

3. In the FileHold Desktop Application, do one of the following:
   - Set up the Watched Folder for the folder you just created on your local computer or network drive. See Watched Folders for more information. Note that if you are using a Watched Folder, the email header information is not extracted into the metadata fields of the schema. If you want the email header information extracted into the metadata fields, use a managed import instead.
• Have your library administrator set up a Managed Import for the folder that was created on your local computer or network. If using a managed import to bring emails into FileHold, ensure that the import format has been set to “Quick Scan Pro” in the user preferences. If the import format has been set to “Both” in the user preferences, ensure that the import format is set to “QuickScan Pro” on the individual managed import. See the End User Guide for more information on the User Preferences setting or the Library Administration Guide for more information on Managed Imports.

**NOTE:** If you are using the “Both” option in the user preferences, ensure that folder you select for the import profile contains only one type of XML files. The rule also applied for any of its subfolders. The XML files for the import formats cannot coexist in the same folder tree.

4. In Outlook 2010, select the Add Ins tab in Outlook and click FileHold Watched Folder.

• In Outlook 2007, click FileHold Watched Folder in the toolbar.

5. In the FileHold Watched Folder Configuration window, click the Enable Outlook Watched Folder check box.

6. In the Watched Folder in Outlook field, click Browse to select the watched folder you created in Microsoft Outlook.

7. In the Destination Folder for Export field, click Browse to select the watched folder on your local computer or network drive.

8. To create an XML file when the emails are exported, select the Export XML files in Document Import compatible format check box. This XML file is created for each .msg file and can be using in conjunction with the Manage Imports tool to import emails into the repository. The XML file contains the following message header information: To, From, CC, Date, Subject, and Attachments. Note that this does not need to be turned on to work with FileHold Watched Folders. The XML files do not get imported into the repository.

9. Click OK.
10. Test your configuration by adding an msg file to your Outlook watched folder. Then go into FileHold to ensure that the file has been brought into the Inbox for processing or sent to the folder, depending on your configuration settings in the Watched Folder or Managed Import. If you are setting up a managed import for emails, ensure that you have an email schema and an email extraction rule configured.

TO ADD ONLY AN ATTACHMENT FROM AN EMAIL

If attachments are saved to the system without the email they are stored in their native format. 

NOTE: You cannot drag and drop an email attachment. You will need to use the Send to FileHold command.

1. In Microsoft Outlook, select and open an email with an attachment.
2. Right-click on the attachment and select Add to FileHold.
3. Select a destination for the document.
4. Enter the metadata for the document. See Entering Metadata for a Document for more information on setting metadata on documents.
5. Select the following options, if applicable:
   - Close the document before I add it — Closes the document in the application you are working in after you have added the file.
   - Delete the local copy of this file after it has been successfully added — Deletes the copy of the file from your local computer after it is added.
   - Email notify all folder members that this document has been added to this folder — Sends an email alert to all the members of the selected folder.
6. Click Add or Auto-File if the document was added to a folder that is auto-tagged.

10.6. ADDING DOCUMENT FROM MICROSOFT OFFICE APPLICATIONS

FileHold has integration with Microsoft Office applications such as Word, Excel, PowerPoint, Visio, and OneNote (2010 and higher). The integrated toolbar can be found on the Add Ins tab of the Office applications.

The FileHold Office Client (FOC) window is used when adding, browsing, checking in, adding attachments or approving documents in FileHold from within Microsoft Office applications.

It is not necessary to save the document prior to adding the document to the library. If the document has not been already saved, then a generic file name, such as “Document1” is given to the file. This name can be changed in FOC window or a custom naming pattern on the schema can be used to automatically rename the documents.
TO ADD FILES FROM MICROSOFT OFFICE APPLICATIONS (EXCLUDING MICROSOFT OUTLOOK)

1. Create or open a document in a Microsoft Office application such as Microsoft Word.
2. In Microsoft Office 2007, select the Add-In tab and click Add to FileHold (+ sign) or Send to FileHold > Add Document.
   - In Microsoft Office 2010 or 2013, select the FileHold tab and click Add to FileHold (+ sign).
3. The FileHold Microsoft Office Client window opens. Enter a new file name manually, if required, in the blue file name bar area.
4. Select a destination folder and enter the metadata.
5. Select the following options, if applicable:
   - Close the document before I add it — Closes the document in the application you are working in after you have added the file.
   - Delete the local copy of this file after it has been successfully added — Deletes the copy of the file from your local computer after it is added.
   - Email notify all folder members that this document has been added to this folder — Sends an email alert to all the members of the selected folder.
6. Click Add or Auto-File if auto-filing has been configured on the schema.

10.7. ADDING OFFLINE DOCUMENTS

An offline document is something that cannot be stored in the document management system such as a map, book, or blueprints. An offline document can also point to documents that are not yet in electronic form such as a location of a folder in a filing cabinet in a historical records room. You will need to create an offline document schema in order to add offline documents
that have a metadata field that states where the offline document is stored. The schema simply points to where the document is physically stored.

Offline documents are tracked in the system so you can see who has the document out or in other words, who has taken the item from its physical location.

Offline documents can be:
- Checked out
- Converted to an electronic document
- Undergo a workflow
- View the version history

**TO ADD OFFLINE DOCUMENTS**

1. Do one of the following:
   - From a folder location or the Inbox in the FDA, go to File > Add Offline Document.
   - In the Web Client, select a folder and click Add File to Folder or use the Add Document Wizard.
2. Select the Offline Document Schema name. See the Library Administration Guide on how to create an offline document schema.
3. Fill out the required metadata fields and click Add.
4. Set a destination folder if adding the Offline document from the Inbox.

**10.8. EXPORTING DOCUMENTS IN A VIEW TO A CSV FILE**

From any folder view, search results or other FileHold view, you can export the columns and associated values to a CSV file. The CSV file contains information from the entire folder list columns except for the icons associated with the documents (i.e. favorites and permissions).

You can customize the view in order to export the data that you want by adding or removing columns, grouping, sorting, and so on, using the View Preferences. You can also perform an Advanced Search to achieve the data results you want to export.

**NOTE:** In the FDA, only the documents displayed on the current “page” will be exported to the CSV file. If you have additional pages of documents, you will need to export each page to CSV. You can also increase the number of documents displayed on a “page” in the View Preferences.

**TO EXPORT FOLDER CONTENTS TO A CSV FILE**

1. Open a folder or do a search to create a list of files to export.
2. Right-click in the column names header and select Export Grids to CSV.
3. Enter a name for the CSV file and select a location to save the document.
4. Click Save.
5. You can now open the document in a spreadsheet.

10.9. ENTERING METADATA FOR A DOCUMENT

The metadata pane displays the document schema and its associated metadata as well as system values in the version properties area. The metadata and version properties are unique for each version of every document in the system. All of these values are can be searched on in the system.

When documents are being added to the document management system, it requires two pieces of information prior the file being added to the library:
1. Values for all required metadata fields.
2. A destination folder.

The status of the document is “Info Required” until the information is entered. Once the required metadata is filled and a destination set, the status changes to “Ready to Send” and document(s) can be sent to the library.

When entering metadata for document, all fields marked with an asterisk * indicate that the field is mandatory and must be filled in. The type of metadata collected for a document schema is determined by how you set up your metadata schema. Metadata is set in the Metadata Pane.

TO OPEN THE METADATA PANE

1. In a folder or search results view, do one of the following:

- In the FileHold Desktop Application (FDA), click .
- In the Web Client or FDA, right-click and select Metadata & File Properties.
- Use the shortcut key Ctrl+Shift+P.

2. In the Inbox of the FDA, click Set Metadata or Edit Metadata or press the shortcut key Ctrl+Shift+P.
Once the metadata has been set, it is displayed in the Metadata Pane along with the file version properties associated with the selected file. The version properties are displayed below the metadata properties. Here, the document owner, version number, status, format, URL links, file type, library location, markup status, and file size can be viewed. All of the version properties of a file are searchable.

See the table below for details on the document version properties.

<table>
<thead>
<tr>
<th>Version Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Displays the number of versions for a document. Click the View All Versions link to see all document versions. See Version History for more information.</td>
</tr>
<tr>
<td>Owner</td>
<td>The user that initially added the file or the user that added the latest version of the file. Ownership is important when it comes to user roles and being able to delete, move, etc.</td>
</tr>
<tr>
<td>Library Status</td>
<td>States if the document is checked in or checked out. If it is checked out it will state who has checked out the document and when it was checked out.</td>
</tr>
</tbody>
</table>
### Version Property | Description
--- | ---
Has Markups | If any markups have been added via the Brava viewer, it states Yes. If there are no markups, it states No. Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.

FileHold ID | A unique ID number given to every document in the system. Documents are numbered sequentially as they are added. The number after the period (.) indicates the version number.

Format | Electronic Document – documents that can be checked out/in and modified. Electronic Record – records cannot be modified. There will only be one version of this file. Offline Document – physical items that reside in your office or point to documents that are not yet in electronic format in the document management system.

Library Location | The cabinet / drawer / folder group (optional) / folder location of the document.

Document URL | Links that can be used to point to the document. There may be different link types available depending upon what your library administrator has configured. To copy the link, click the link and paste the link into another document. Copy Default URL – link to where the document resides using the default URL configured by the administrator. For example, http://fileholdserver/FH/FileHold/WebClient/LibraryForm.aspx?docId=1 or fda://document/1. All URLs – Displays the list of URLs that are available for use. The list is configured by an administrator. If this option is not available, then only the Default URL can be copied. See your library administrator for details.

Type of File | States the file type such as Microsoft Word, PDF, TXT, JPG, etc.

Size | States the size of the file.

### 10.9.1. Entering Metadata for a Single or Multiple Documents

Before a document can be added to the library, it requires two pieces of information:

- **Values for all required metadata fields** - When entering metadata (also called tagging or indexing) for document, all fields marked with a * indicate that the field is mandatory and must be filled in. Metadata is set in the Metadata Pane.

- **A destination folder** - The folder in the library structure where the document will reside.

**IMPORTANT**: The maximum number of characters in a document name is 100. This limit is in place to reduce the risk of conflicts with filename and path length limits in Microsoft Windows. The maximum size of the filename and path in Windows is 260 characters. This means that the
longest path that will avoid conflict with Windows' limit when making a local copy of a document from the document management system is 160 characters. The user will see an error message if the limit is exceeded.

**TIP:** There may be cases where you would like the name of the document to be longer than 100 characters. You can create a metadata text field large enough to hold the large name and use custom naming to set the document name that would be used if the document is copied outside of the document management system. The L mask operator can be used to truncate the name to a length less than the maximum and an extra identifier like the document id or the document create date and time could be added to simplify identifying the document outside of the document management system.

**TO ENTER METADATA FOR A SINGLE DOCUMENT**

1. Add the file to the document management system. This can be done in the Inbox or a folder location.

2. Do one of the following:
   - Click the inline **Set Metadata** link.
   - Click the **Edit Metadata** button.
   - Right-click and select **Edit Metadata**.
   - Click the metadata pane button.

3. Select the **Document Schema** from the list. The metadata fields will change depending on which schema you have chosen.

4. Enter in all the required metadata information. This is marked with an asterisk *

5. Fill in the optional information if needed.

6. Select the check box to delete the local copy of the file after it is added to the Library if required.

7. Select the check box to email all folder members that a document has been added to the folder if required.

8. Click **Add** or **Save & Next** to add metadata to the next document in the list.

**TO ENTER METADATA FOR MULTIPLE DOCUMENTS AT A TIME (FDA ONLY)**

1. Add the files to the FileHold Desktop Application. By default, these documents will go to the Inbox.

2. Select the files to be tagged (indexed). Use the CTRL or SHIFT keys to select multiple documents.

3. Do one of the following:
   - Click the **Edit Metadata** button.
   - Right-click and select **Edit Metadata**.

**NOTE:** Do not click the inline Edit Metadata link. This will cause you to edit the metadata for just that selected document.

4. Select the **Document Schema** from the list. The metadata fields will change depending on which schema you have chosen.

5. Do one of the following:
- To enter common values for all metadata fields for all of the selected files, select the Check All check box and enter the metadata values.

![Metadata & File Properties](image1)

- To enter common values for only select metadata fields, select the check box next to the metadata field names.

![Metadata & File Properties](image2)

6. Select the check box to delete the local copy of the file after it is added to the Library if required.

7. Select the check box to email all folder members that a document has been added to the folder if required.
8. Click Save.

9. If there are any required metadata fields that were not filled out, enter in all the required values for the individual documents. Required fields are marked with an asterisk *.

10. Fill in the optional metadata fields if needed.

11. Click Save or Save & Next.

### 10.9.2. Entering Metadata Using Click to Tag

Click to Tag is a method of quickly assigning metadata to a document being added to the repository using the FileHold Desktop Application. It allows you to “click” or “rubber band” text, numbers, dates, etc. on the screen and inserts the value into the metadata field of the schema. When using Click to Tag, the mechanism OCR’s (optical character recognition) the selected area on the screen. This makes it possible to extract values not just from the document but also from any external application accessible on the user’s computer.

In order to use Click to Tag, it must be enabled in the User Preferences. Note that this setting may be overwritten by your administrator.

When Click to Tag is invoked in the metadata pane, the user is prompted to open the document in the FileHold viewer, the document’s native application, or to not to open the document. Not opening the document allows you to tag the document using an alternative file or from another application.

Once an option to tag the document is selected, the screen is covered with an opaque white mask called the “fold”. This indicates that the Click to Tag process is in effect. A tool tip displaying the metadata field name to tag is shown. You can then click or rubber band the value for the metadata field. After the first metadata field is tagged and validated, the next metadata field in the list can be captured. The process is repeated until all the values have been captured. The “fold” can be activated and deactivated at any time during the tagging process in the event that a document needs to be scrolled to other page, zoomed, or tagged from a different screen.

When tagging metadata fields, read-only and auto-tagged fields are skipped from the tagging process. Check box type metadata fields are also skipped. For drop-down or drill down type metadata fields, the information that is being selected on the screen must be an exact match. If no matching value is found, an error message is displayed. Similarly, date type fields will need to be properly formatted on the screen or an error message is displayed. If date, currency, number, or drop-down list values do not match what has been captured or is not formatted correctly, the system will prompt you to enter a correct value.

If no metadata fields are present in the selected schema, the Click to Tag button is not available.

Note that the quality of the documents that are being tagged using Click to Tag need to be reasonably high. For this reason, only documents that are electronic in origin should be used with Click to Tag. Prior to using Click to Tag, you should test the tagging process with your various electronic documents to ensure that it will work well.
Font/text size needs to be of a reasonable size as Click to Tag does not work well with small fonts. If Click to Tag is not working well with the current font size, zoom into the document to increase the size of the font on the screen. Due to various quality, font size, or font type reasons, some text may not be able to be read (ORC’d) from the screen and cannot be tagged using Click to Tag. In these cases, metadata values have to be entered manually.

Scanned documents may present issues in tagging due to poor quality scans so for this reason, the OCR capabilities of your scanning software should be used to tag the documents and not Click To Tag. See the Knowledge Base for more information on scanning documents and importing metadata into the document management system.

Click to Tag supports only the English language “out of the box”. This can be modified in the FDA.exe.config setting `<add key="ClickToTagLanguage" value="eng"/>`. For other language support, contact FileHold Professional Services at sales@filehold.com.

TO ENTER METADATA USING CLICK TO TAG

1. Add a new document(s) or select an existing document(s).
2. Select a Document Schema from the list if adding a new document.
3. In the metadata pane, click Click to Tag.

4. In the Click to Tag window, select one of the following options:
   - Open the document in the native application – The document opens in its native application. For example, if it is a PDF then it opens in Adobe Reader.
   - Open the document in the Brava viewer – The document opens in the Brava viewer in the FileHold Desktop Application. You may need to undock the viewer, adjust the size, or move it to another monitor in order to tag the document. You can do this by closing the “fold”. Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.
   - Open in the document in the PDF/Image viewer – Opens the document in the PDF/Image viewer in the FDA. You may need to undock the viewer, adjust the size, or move it to another monitor in order to tag the document. You can do this by closing the “fold”.


• Do not open the document – Does not open the document in any viewer or application. Use this open to tag the document from an alternative file or from another application.

**NOTE:** If you are tagging multiple documents at once, then this window does not appear. You will need to close the fold and open the document or application that you want to tag from and then open the fold again to proceed with tagging.

5. Once an option is selected, the “fold”, a white opaque mask, appears over the screen. This indicates the Click to Tag process is in effect. You may need to deactivate and activate the fold to undock the viewer, adjust the size, scroll through a document, zoomed, or move it to another monitor, and so on in order to tag the document. To deactivate the fold, click **Fold** in the bottom right corner. To activate the fold, click the **Unfold** button. See the example screen shots below:

• To deactivate or close the fold, you can also right-click on the activated fold and select **Fold**.

• To move between windows, use **Alt+Tab** or the task bar instead of deactivating the fold.

6. Once the document is opened in the selected viewer and the fold is activated, the first metadata field in the schema displays in a tool tip. Capture the value for the metadata field by:

• A single word is captured by clicking on it.

• Multiple words or lines are captured by dragging a rectangle round the words (rubber banding) All words located inside or intersecting the triangle are captured. See the example below:
7. Continue tagging the rest of the metadata fields in the schema using the click or rubber band methods. A tool tip displays each metadata field name.

8. If you need to change a value or skip to another metadata field, right-click on the fold while it is activated. The list of metadata fields for the selected schema is shown. Select the desired metadata field name from the list. The metadata field that is currently being tagged has a check mark next to its name.

9. If the value of the metadata field is not valid (does not match drop-down or drill down list value, invalid date format or check box) or cannot be read due to reasons (such as poor quality, font size, font type, and so on) an error message is shown stating the value is not
valid. Click OK to retry tagging the value. When tagging a currency, number, drop down list, or date value and Click to Tag does not recognize the value, a window opens prompting the user to enter the correct value.

Click To Tag Correction

The selected text was not recognized as a valid date. You can manually correct the value and try again.

OCR Text: 25

OK Cancel

10. Once the tagging is completed, right click on the activated fold and select Close.

- Alternatively, click ESC to end the Click to Tag process.

11. Click Save in the metadata pane to save the information.

10.9.3. Entering Metadata Using Database Lookups

Metadata information can be automatically populated into many metadata fields based on a single metadata “look up” value that comes from a database such as an accounting database or an ERP system.

If the administrator has configured the schema to use database lookups, you will see a Lookup button in the Metadata pane. Clicking this button after entering or selecting the value from the configured database drop down list metadata field retrieves any mapped values from the database into the remaining metadata field values of the schema. This can reduce the amount of time it takes to index a document with metadata.

When the list retrieved from the database is presented to the user in the drop-down list, only the first 100 items will be displayed in the FDA and the first 25 items in the Web Client. As the user scrolls through the list or starting typing the value, more values will be loaded into the view but is limited to viewing 100 (FDA) or 25 (Web Client) values at a time.

If there are any blank required fields after the lookup is performed, you will need to enter those manually. The values of any read-only or automatically tagged fields are not affected by the database lookup.

The Lookup button in the metadata pane is shown when adding a single document or when editing the metadata of a single document. You cannot do database lookups for several documents at once from the Inbox; look ups have to be done one document at a time.
When configuring database drop-down lists, up to four “search by” fields can be set to help users choose the correct value from the list. Often the single lookup value is not sufficiently descriptive so selecting the correct value from the list can be difficult due to having similar names, long names or numbering. “Search by” fields help simplify the selection process. Once the “search by” fields are configured, the end user has the ability to click the “search” button in the metadata pane. In the search by window, the user has ability to view the search by information, and filter and sort the data in order to select the correct value from the list. For example, when putting employee information into the system, the lookup is done on the unique employee number field. However, remembering the employee number for each employee is not practical. Using this solution, the user can see the employee’s first and last name, title, department and so on to ensure the correct employee number is selected.
Up to five lookup fields can be configured for the metadata fields. For example, a customer is classifying construction documents for a property. Construction is related to a lease and can include one or more jobs. The customer would like the document to have the lease id, lease name, job id, and job name metadata information populated. When the lease id and the job id is selected from the drop-down list in the metadata pane and the Lookup button is pressed, then the system retrieves both the lease and job names.

For more information on creating database drop down list metadata fields or setting the database lookup on a schema, see the Library Administration Guide.
TO ENTER METADATA USING DATABASE LOOKUPS

1. Do one of the following:
   - Add a single document to the document management system.
   - Select a single document in the Inbox.
   - Edit the metadata of a document in the library.
3. Enter or select the value for the database drop down list metadata fields that are configured to do the lookups. There can be up to five database drop-down lists configured in a schema.
   - If you enter a value in the wrong metadata field, you will receive an error message "Missing value for <metadata field name>".
4. If the “Search by” feature is configured, click the Search button to display a table with related database information. The table can be sorted and filtered in order to select the correct value from the list. See How to manipulate the Batch Job report View for information on how to manipulate the table view.
5. Click Lookup. All of the metadata fields that are configured will pull in the values from the database.
6. Enter values in any other required metadata fields or modify any of the values that were retrieved.
7. Click Add or Save.

10.9.4. Editing Metadata

If you have sufficient permissions (Document Publisher or higher role), you are able to edit the metadata for a document.

TO EDIT METADATA

1. Locate the document whose metadata you want to edit and open the metadata pane.
2. Click Edit and make any changes to the existing values.
3. Click Save.

10.9.5. Copying Metadata

You can copy metadata values when the metadata panel is in its editable or non-editable form.

TO COPY METADATA

1. Select a document and open the metadata pane.
2. Right-click and select Copy.

10.9.6. Using the Document URLs

You can use the URLs provided in the Version Properties area of the metadata pane to send links to other FileHold users instead of sending the entire document.
Depending on how your library administrator has configured it, you may be able to copy only the default URL or all configured URLs.

Click the link to copy the URL. The link is copied and you can paste the link using Ctrl+V.

**To link FDA and Web Client URLs to a web page**

You can link both Web Client URLs and FileHold Desktop Application (FDA) URLs to a web page; however, these links still use the security set on the document. The user attempting to open a URL must have the cabinet, folder, and schema permissions in order to access the document.

1. Open the metadata pane for the document's link you want to copy.
2. Under Version Properties > Document URL, click **Copy URL** for the web client URL or click **Copy FDA Link** for the FileHold Desktop Application link.

   **TIP:** Due to browser security, in order to copy links in Mozilla FireFox or Google Chrome, you will need to right-click on the link and select **Copy Link Location.** You can then paste the link into an email or document.

3. You can paste these links into your web page using CTRL+V.
4. When the URL link is clicked from a web page, you will need log in to FileHold; either the web client or FileHold Desktop Application, depending on the link type. Both the FileHold Desktop Application (FDA) URL and the Web Client URL are maintained.
5. Once you are in FileHold, the document will appear highlighted in the folder list. You can get a local copy, check out, view version history, etc.

**10.10. Setting the destination folder**

You will need to determine which folder the documents will reside in the library structure. You can set the destination for one or more documents at a time from the Inbox.

**TIP:** You can use the Recent Folders list if you are always adding documents to the same folder location.

**To set the destination folder for documents**

1. Do one of the following:
   - From the Inbox, select a single document and click **Set Destination.**
1. From the Inbox, select one or multiple documents to be filed under the same folder and click **Edit Destination** from the toolbar. If setting the destination for multiple documents, do not use the Set Destination link.

2. Alternatively, drag and drop one or many documents to the folder location in the library tree.

2. From the Select Location window, browse to the folder location in the library tree and click **OK**. The destination for the documents will be shown in the Inbox.

### 10.11. DELETING FILES

You may only delete files if you the correct permissions and are owner of the document. You can also delete previous versions of a document.

**TO DELETE A FILE**

1. Select the document name and click **Delete X**.

### 10.12. CHECKING IN AND CHECKING OUT DOCUMENTS

Document version control ensures that changes made to documents are not accidentally overwritten by other users. Checking out a document “locks” the document and prevents others from making changes. Users can still get a local copy of the document (read-only) when a document is checked out.

A unique copy of every version of a file checked into the system is retained to ensure that documents can be reverted back to a previous version if needed. To view all versions of a document, see the Version History.

It is important for users to remember to check documents in once they are finished editing. Users cannot view your changes or check the document out until the document is check in. To view all of the documents that you have checked out, go to **My FileHold > Checked Out Documents**.

When the file is checked out, its status is set to **Checked Out**. In the Version Properties area of the Metadata pane, you can see who checked out the document and the date and time it was checked out. When a document is checked in, its status is set to **Checked In**.

**TO CHECK OUT A DOCUMENT**

1. Locate the document you want to check out in the Library and do one of the following:

   - Click **Check Out** from the toolbar.
End User Guide

FileHold 16.0

June 2018

93

- Right-click and select **Check Out This Document.**
- To check out and open the file in its native application, hold the **CTRL** key and double-click the document name.

2. The document status changes to Checked Out and is downloaded to your working folder. Your working folder is typically `C:\Users\username\Documents\My FileHold Documents`. The working folder location is set in your User Preferences.

- If you selected to check out and open the file, it will open in its native application. For example, a .doc document will open in Microsoft Word.

**10.12.1. Checking in Documents**

Only the user that checked the document out of the records management system can check the document back in. You can check in a document from anywhere the document shows up in the system such as the folder location, My Checked out Documents, or a Microsoft Office application.

Documents can be deleted automatically upon check in if the setting “By default delete documents that I Check In to FileHold” is enabled in the User Preferences. It may also be locked down by an administrator and cannot be modified.

It is possible to enable the setting “Edit metadata upon Check In action” in the User Preferences so that the metadata pane opens for editing after checking in a document into the document management system. If configured to do so, then the metadata pane automatically opens upon check in so the values can be modified. This option can be locked down by a system administrator. See the System Administrator Guide for details.

Metadata field values may be cleared upon check-in if the option “Clear at Check In” has been enabled in the schema. If enabled, then any required metadata fields (marked with an asterisk *) in the schema are cleared forcing you to enter new values upon check in. See your library administrator for details.

**To check in from my checked out documents**

1. Select document and do one of the following:
   - Click **Check In** from the toolbar
   - Right-click on the document name and select **Check In This Document.**

2. Click **Browse** to go the folder location where the document that you are checking in located, if needed. FileHold keeps track of where the document was downloaded to so if the document is still in the same location, the path is automatically entered.

3. Select any of the following options, if available/applicable:
   - **Edit metadata for these document(s) before check-in** – This option opens the metadata pane so the metadata field values can be edited. This option may be automatically selected if the option “Edit metadata upon Check In action” is enabled in the User Preferences. It may also be locked down by an administrator and cannot be modified.
   - **Delete the local copy of this file after it has been successfully checked in** – This option removes the local copy of the file from the user’s computer. This option may be automatically selected if the option “By default delete documents that I Check In to FileHold” is enabled in the User Preferences. It may also be locked down by an administrator and cannot be modified.
   - **Email notify all folder members that these documents) have been checked in** – This option sends an email to all users and groups that have access to the folder. This option may not
be available, depending on the Library Administration settings. See the *Library Administration Guide* for more information.

3. Click **Check In**.

4. If the options “Edit metadata upon Check In action” or “Clear at Check In” are enabled, fill out the required metadata values in the metadata pane and click **Save**.

**TO CHECK IN DOCUMENTS FROM MICROSOFT OFFICE AND OUTLOOK**

1. From a Microsoft Office application, select **Send to FileHold > Check In Document** or click the **Check In** icon from the FileHold toolbar.
   - In Office 2007 and 2010 these commands are located in the **Add-Ins** tab.

**TO CHECK IN AN UNCHANGED DOCUMENTS (UNDO CHECKOUT)**

1. After checking in a document, a window will prompt you to select the new version the document. At the top of the box is the option ‘I have not changed these document(s). Please undo the check out of these files’. Select the check box to undo the checkout leaving the last version of the document as the most recent version.
   - If this option is not selected the when the user clicks the Check-In button, the “new” file will upload to the documents management system as the latest version of the file.

**TO CHECK IN MULTIPLE DOCUMENTS**

1. From the My Checked Out Documents view, select the documents to check in and click **Check In**.
   - This option is not available through the Web Client.
2. Alternatively, use the **Working Documents** feature to check in multiple documents at once.

**10.13. COPYING OR MOVING FILES**

The Copy or Move function in FileHold allows you to make a copy of a document and/or move it to another location in the library.

In order to move or copy documents, Document Publishers and Publishers need to have ownership of the document. Users who are Organizers or higher permissions can move documents owned by anyone. Restrictions on where a document can be moved to will apply.

**TO COPY OR MOVE A FILE**

1. Select one or many documents.
2. Right-click and select **Copy or Move**.
3. In the Copy/Move window, select one of the following options:
   - Move files to a new location in the library
   - Copy files to a new location in the library
4. Click **Next**.
5. Select the destination in the library for the documents or folder and click **OK**. The documents are moved and/or copied to the new location.
10.14. MAKING A LOCAL COPY

You can make a copy (download) of a document to your local machine. The document is downloaded to the working folder location specified in your User Preferences. This is typically in the location C:|Users|username|Documents|My FileHold Documents.

TO MAKE A LOCAL COPY OF A DOCUMENT

1. Locate the document in the Library and do one of the following:
   - In the FDA, click Make a Local Copy from the toolbar.
   - In Web Client, select the check box next to the document name and click Get Copy.
   - In Web Client or FDA, right-click on the document and select Make a local copy.
2. The document is downloaded to your working folder location.

10.15. EMAILING, AND EMAILING AND CHECKING OUT DOCUMENTS

You are able to email and “email and check out” documents from the Library. When sending files from the document management system, it is important to send the file in a manner that allows the other user to access the information while keeping sensitive data safe.

When emailing a link or attachment, emails retain the properties of your Microsoft Outlook messages including signature blocks and other added items like legal disclaimers.

There are two ways to send files:
   - Send as an attachment – Attachments are the most common way of sharing files via email; however, they are the least secure as anyone who receives the attachment can open the document.
   - Send as a link – Links are not as common as attachments when sharing documents; however, they are the most secure. Those that do not permission in the document management system to access the file will be unable to open the document via the link. In other words, in order to access a file via a link, the recipient must also have access to the
document in the system. Both the Web Client URL and FDA link are appended to the body of the email.

Administrators can configure how emails will be sent from FileHold — either links or attachments or both.

Emails can be sent either through Microsoft Outlook or via the built-in email client in the Web Client. When emailing from Microsoft Outlook, emails retain the properties of messages including signature blocks and other added items like legal disclaimers.

**NOTE:** Users can also send a link using the Copy URL or Copy FDA Link in the Metadata pane. The link can then be pasted into an email. See Adding Metadata and File Properties for more information.

**TO EMAIL A DOCUMENT FROM THE FDA**

1. In the FDA, locate the file you want to email in the Library and click Email on the toolbar.
2. In the Email Attachment Settings window, select one of the following and click OK:
   - Attachments to the email – Sends the document as an attachment to the email.
   - Links at the end of the email body – Appends the FDA and FOC (web client) to the body of the email. When a user clicks on the link, the user will need to login to FileHold to access the document. If the user does not have the correct permissions they will not be able to access the document.

**NOTE:** The library administrator can configure the system to send files as either an attachment or as a link or allow the user to decide. If the function is set to allow the user to decide then they will be prompted to select an option. If not, the file will automatically be inserted into the email in the format chosen by the library administrator. See the Library Administration Guide for more information.
3. The email message is created in Microsoft Outlook with either the attachment or the links appended to the body of the email.

**TO EMAIL A FILE FROM THE WEB CLIENT**

The Web Client uses its own email client to email documents. Documents are emailed from the email address that the user is logged into the Web Client with.

1. In the Web Client, select the documents that you want to send by selecting the check box next to the document name.
2. Select **Send to > Email** or **Email and Checkout** from the FileHold toolbar.
3. The FileHold email client page opens. If configured, you can change to send the type of email sent: as attachments or links.

4. Click **Send**.

**TO EMAIL DOCUMENTS FROM MICROSOFT OUTLOOK**

1. Create a new message in Microsoft Outlook.
2. From the **FileHold integration toolbar**, click the **Add Attachment from FileHold** icon.
3. The FileHold Office Client (FOC) window opens. Select the files that you want to attach.
4. Click **Attach**.
5. The files are attached to the message as attachments.

**TO CHECK OUT AND EMAIL A DOCUMENT**

1. Locate the file you want to email in the Library and click **Check Out and Email** on the toolbar.
2. In the Email Attachment Settings window, select if you want to send the document as an attachment or a link and click **OK**. See the previous section for details.
3. The email message is created in Microsoft Outlook with either the attachment or the links appended to the body of the email. The document is also checked out of the system and the status is changed to “checked out”.

![Image of Microsoft Outlook with checked out status]

10.16. LINKING DOCUMENTS

The ability to link documents together is a key feature that helps to organize documents into logical groups. Links give users quick and efficient access to files that are related to the document they are working with no matter where the file is stored in the Library. For example, a master contract document may be linked to its amendments.

The Linked column is visible in most views and shows the total number of documents that are directly linked to that document. These links may be of either parent or child relationship.

Linking maintains a parent-child relationship between the documents that are linked together. In other words, one document, the “parent”, will serve as the main document that all other files, the “children”, will refer to. When linking two or more documents together the user must specify the parent document in the linking relationship.

You are able to link documents that are in the same folder or from disparate areas of the library such as the search results, virtual folder, or document tray.

TO VIEW DOCUMENT LINKS

1. From the Linked column, double-click on the linked number.

2. The Documents linked to Document Name panel opens. All of the documents that are linked to the selected document are shown.

3. Click on the Up or Down arrow in the Parent/Child column to view the parents (Up arrow) or children (Down arrow) of the linked document.
TO CREATE A LINK BETWEEN TWO OR MORE DOCUMENTS IN THE SAME FOLDER

1. Select the files that are to be linked within a folder. At least two files must be selected.
2. Click Link.
3. In the Create Links Between Documents window, select the “parent” document from the list and click Link. The other files are considered “children” to the “parent” file. The documents are linked.

TO CREATE LINKS BETWEEN DOCUMENTS FOUND IN A SEARCH

1. Run a search.
2. Select the documents to link together and click Link. At least two files must be selected.
3. In the Create Links Between Documents window, select the “parent” document from the list and click Link. The other files are considered “children” to the “parent” file. The documents are linked.

TO REMOVE DOCUMENT LINKS

1. From the Linked column, double-click on the linked number.
2. The Documents linked to Document Name panel opens. All of the documents that are linked to the selected document are shown.
3. Select the document and click Remove Link. The link will be removed.

TO LINK DOCUMENTS IN THE DOCUMENT TRAY

1. “Move” all of the documents you want to link into the Document Tray.
2. In the Document Tray, select the files you want to link and right-click to select Link Documents.
3. In the Create Links Between Documents window, select the “parent” document from the list and click Link. The other files are considered “children” to the “parent” file.
4. The documents are now linked. You can see how many files a document is linked to in the Linked column.
TO SEARCH FOR LINKED DOCUMENTS

1. From the Advanced Search screen, select the search criteria Special Fields > Has Link.
2. Select Yes or No from the drop-down list and click Search.

10.17. CHANGING THE DOCUMENT VERSION OWNER

Every document has an owner. A document owner is the user who has added that version of the document into the repository. The owner may need to be changed during the life of a document.

Organizers and cabinet administrators, for cabinets they own, can change the ownership of a document version. You can change ownership for one document at a time; it cannot be performed en masse. Cabinet administrators and higher roles can change ownership en masse using a utility.

This is useful when certain users need to initiate workflows and the system administrator permission setting “Ignore document version ownership when initiating workflows or sending Courier transmissions” is not enabled. For example, in a workflow template, the task can automatically be assigned to the document owner instead of having to set the user name each time a workflow is initiated. See Manually Initiating a Workflow for more information.

TO CHANGE THE OWNERSHIP OF A DOCUMENT VERSION

1. In the FDA, right-click on the document and select Change Document Owner.
2. In the Web Client, using the context sensitive menu, select Change Document Owner.
3. In the Find People window, enter a first and/or last name and click Find Now.
4. In the search results, select the user and click Select. The ownership of the document is changed to the selected user.

10.18. CREATING SHORTCUTS TO DOCUMENTS

Document shortcuts allow you to create and place shortcuts to documents in any folder that the user has access to in the Library. Users with Publisher role or higher can create shortcuts between several folders that they have access to.

Creating shortcuts does not make a copy of the document; it is only a link to the original document location.

WARNING: This functionality may be disabled. Contact your system administrator for information.
TO CREATE A DOCUMENT SHORTCUT

1. Right click on the document and select Create Shortcut.
2. Choose a folder in the Library that you want to put the shortcut in and click OK.

3. The location of the document shortcut opens. The document will have an icon with an arrow on it indicating that is a shortcut.

10.19. RENAMING DOCUMENTS

You are able to rename documents in the Library if you have access and have a role of Publisher or higher.

Note that you cannot rename a document if the schema has a custom file naming pattern configured. See your library administrator for details.

TO RENAME A DOCUMENT

1. Right-click on a document and select Rename.
   - You can also click the Edit link that is in line with the document name in the folder or search view.
   - You can also edit the file name in the Metadata pane.
2. Enter a new name for the document and click Save.

10.20. EXPORTING DOCUMENTS IN THE FDA

You can export all documents from a cabinet, drawer, folder groups, or folders using the Export option. You can also export one or more documents from a folder. Once the Export command is selected, you can select where you want to export the documents on your local machine.

When documents are exported, they are exported with an XML file and a Documents folder containing all of the exported documents in their native format. The folder name and xml file
that is generated is named with a date and timestamp appended to the end. For example: documents201510082302.

The XML file stores the metadata of all the selected documents in a FileHold compatible format. This allows for the importation of the documents back into the document management system. For example, if you are exporting documents out of a demo system and importing them back into a production system.

Exporting can be done by users with a Document Publisher role or higher if they have access to those areas and are dependent on the role that you have:

<table>
<thead>
<tr>
<th>Role</th>
<th>Can export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Publisher, Document Publisher + Delete</td>
<td>Documents that they own.</td>
</tr>
<tr>
<td>Publishers, Publisher + Delete</td>
<td>Documents, folder groups, and folders that they own.</td>
</tr>
<tr>
<td>Organizer, Organizer + Delete</td>
<td>Any documents, any folder groups and any folders for the cabinets they have access to.</td>
</tr>
<tr>
<td>Cabinet Administrators</td>
<td>If not a cabinet owner: documents, folder groups, and folders that they own. If a cabinet owner: all drawers, folder groups, folders, and documents.</td>
</tr>
<tr>
<td>Library and system administrators</td>
<td>All areas of the library structure and documents.</td>
</tr>
</tbody>
</table>

To export documents from the document management system:

1. Right-click on a cabinet, drawer, folder, folder group, folder or document(s) name and select Export or Send to > Export.
2. You will receive a warning message asking if you want to continue with the export: “If you are attempting to export x number of documents. Are you sure you want to continue?” Click OK to proceed with the export.
3. Browse for the folder location where you want to export your documents and click OK. The documents are exported to the selected location in the Documents folder along with the XML file that contains the metadata information for each document. Both folder containing the documents and the xml file are named documents[date][time] and documents[date][time].xml, respectively.

10.21. Downloading Documents to a Local Folder

You can download a copy of document to a folder on your local computer. You can browse to where you want the document downloaded. Users with a document publisher role or higher can access this function.

To download a document to a local folder:

1. Navigate or search for the document you want to download.
2. Right-click on the document name and select Send To > Local Folder.
3. Select the folder location on your local computer and click OK.
4. A copy of the document is downloaded to the folder.
10.22. VIEWING VERSION HISTORY

The document management system retains a unique copy of each version of each file as it is checked out and back into the Library. When a document is checked in and changes have been made, FileHold automatically creates a new version of the document. FileHold versioning are simply numbered as 1, 2, 3, 4, and so on. You can create your own numbering system with document control and version control numbers. See the Library Administration Guide for more information.

When viewing a list of documents (folder view, search view), only the most recent version of the document is displayed. The ‘Ver’ column shows the number of versions of a given document. You can view previous versions of a file through the version history.

When document is added to the library, it starts as version 1 and is "owned" by the person who added the document. As the document is checked out and checked back in, that number increases by 1 and the "owner" of the version changes to the person who has checked the document in. For example, Paul added a file to the document management system. That file starts as version 1 and is owned by Paul. Sally has access to the file and decides to check out the file in order to modify it with the latest report information. Sally checks the file back into the system. That file is now at version 2 and is owned by Sally.

10.22.1. Viewing Previous Versions of a Document

When viewing the version history of a document, the "History of Document Versions for Document Name" window opens with the list of the previous versions of the document shown. The document name, document schema, number of linked documents, version number, status, last modified on date, owner, and approval status is shown in the view. This view cannot be modified.

You can get a copy, delete, or email older versions of documents. You cannot check out, check out and email, or link older versions of documents. In order to work with an older version of a document, you can reinstate it as the current version (see below) or download a copy and upload it into the document management system as a new document.

TO VIEW PREVIOUS VERSION OF A DOCUMENT

1. Select a document and click on the number of versions link in the Ver column.
   • Alternatively, click on View all versions in the Version Properties area of the Metadata Pane.
2. A list of the previous versions will appear. To go back to the folder list, click Back to Folder.

10.22.2. Deleting Previous Versions

Library administrators or document owners that have Document Publisher + Delete permissions are able to delete previous versions of files. Document owners may only delete the previous version of a document whereas library administrators can delete any version(s) of
the file in the document management system. This means that the versions shown in the version history list are the ones that have not been explicitly deleted.

**TO DELETE A PREVIOUS VERSION OF A DOCUMENT**

1. View the Version History of a document. Select the version you want to delete and click Remove (X).

2. In the Delete Files window, select a deletion option:
   - Delete only the versions of the files I have selected.
   - Delete all versions of each file that I have permission to delete.

3. Click OK. The version of the document is removed. If you need to recover the document, contact your library administrator.

**10.22.3. Reinstating a Previous Version as the Latest Version**

When viewing previous versions of a document the user can reinstate any of the previous versions of the document as the latest version. This allows users to work with older versions of documents such as checking out, initiating a workflow, or linking to other documents. For example, the current version is 5 but a lot of mistakes occurred in that version and you would like to restart from version 4. Since you cannot check out version 4, you can reinstate it as the latest version (which would be 6) in order to check out and work on the document.

**TO REINSTATE A PREVIOUS VERSION AS THE LATEST VERSION**

1. Select a previous version of a document and click Reinstall as Latest Version.

2. In the Reinstall as Latest Version window, select one of the following options:
   - Yes, reinstate the selected version’s metadata.
   - No, keep current metadata values.
3. Click **OK**. The document is reinstated as the latest version. In other words, the version number will increase by 1 with the older document as the latest version.

**10.22.4. Viewing Edits to Metadata for Older Document Versions**

The system logs all edits to metadata for each version of a document.

**TO VIEW EDITS TO METADATA**

1. To view the metadata edits for a version of a document, select the version(s) from the history of versions list and click **Edits to Metadata**.

2. To view a detailed description, click **Show Metadata Edits** link in the Metadata Change History view. The metadata pane opens with a list of who made the metadata change, when it was made and what was changed. Any changes are shown in bold font.

**10.22.5. Viewing the Document Usage of Document Versions**

You can view how one or more of a document version has been used. The document management system tracks how a document has been used. For example, if a document has been emailed, checked out, linked, viewed, and so on you can see what actions have been taken on a document. You can see who the action performer is and when the action was performed plus any details pertaining to the action (such as a change in ownership).

Library administrators can also use the Document Usage Log to see how documents were used.

**TO VIEW THE USAGE OF A FILE**

1. In the Version History list, select one or more (using the CTRL or SHIFT keys) document versions and click **Usage of File**.

2. The File Usage for Document Name window opens with a list of all of the actions taken upon the document versions, which user performed the action and when the action was performed.

3. To return to the version history, click **Version History**.

**10.22.6. Viewing the Sign Off Sheet**

The Sign Off Sheet shows a list of all users that either approved or rejected this version of the document when they did it and if they signed-off on behalf of someone else.

If this was a multi-document workflow, all documents that were a part of the approval process will be shown in the sign off sheet. For more information on workflows, see the *Workflow and Courier Guide*.
**TO VIEW THE SIGN OFF SHEET**

1. In the folder or search view, do one of the following;
   - Right-click on a document and select **Workflow > View Sign Off Sheet**.
   - In the Version History screen, click **Sign-off Sheet**.
2. The Sign Off Sheet pane opens below with a list of all users that have approved or rejected all of the documents in the workflow.
3. Click X to close the Sign Off Sheet pane.

**10.22.7. Viewing Workflow Reviews and Approvals**

The review and approval history show each task that was completed in the workflow. The first level in the workflow shows information about the workflow instance itself. Information includes the type of workflow (the workflow template name), the name and version of the document, who the initiator is, when the workflow started and when it is due and if the workflow resulted in the document being approved or not.

To expand the workflow details, click the + sign in the FDA or the > arrow in the Web Client next to the document name. In the task details, the percentage completed, the comments or feedback documents provided by participants, the completion date, the due date, and status (reviewed or approved) is shown.

The review and approval history can only be seen by those users who have completed the task and senior administrators.

For more information on workflows, see the **Workflow and Courier Guide**.

**TO VIEW THE WORKFLOW REVIEWS AND APPROVALS**

1. In the folder or search view, do one of the following;
   - In the FDA, right-click on a document and select **Workflow > View Review and Approval History**.
   - In the Web Client, click the arrow next to the document name and select **Review and Approval History**.
   - In the Version History screen, click **Reviews & Approvals**.
2. The Document Review and Approval History window opens with a list of all workflow tasks.
3. To print the list of reviews and approvals click **Print** (FDA only). Note: The report will be printed exactly how it appears on the screen.
4. To export the list of reviews and approvals click **Export** (FDA only). When exporting the report, you can choose to export only the workflow or you can include both the workflows and the tasks. The report can be exported to CSV or HTML. Note that for the HTML report, the workflow must be expanded in the Workflow Status Report results to print the tasks. In other words, the HTML report will be exported to look exactly how it appears on the screen.
5. To return to the version history, click **Back to Version History**.
6. To return to the folder, click **Back to Folder**.
10.23. SETTING DOCUMENT ALERTS AND REMINDERS

Document alerts allow you to be alerted of changes that occur to files or folders kept in the library. For example, a user in payroll subscribes to an Expense Reports folder that notifies them of when an expense report needs processing by sending an alert. You can choose to set alerts on both folders and/or documents. Once changes have been made to either the folder or the document, you receive an alert in the Document Alerts area of My FileHold. You can set the type of document or folder changes you want to be notified of and the email address to send the notifications to in your Alert Preferences.

Document reminders allow you to be reminded of when a document requires attention in the future. For example, you can be reminded monthly to update expense reports or to review yearly employee contracts that are up for renewal. Once a reminder comes due, you receive an email (if configured) and an alert in the Document Reminders area of My FileHold. You can set reminder preferences in your Alert Preferences.

TO SET AN ALERT ON A FOLDER OR DOCUMENT

1. Right-click on a folder or document and select:
   - Alert Me of Changes on a folder.
   - Notify Me > Alert Me of Changes on a document.
2. You will receive a message stating that “You have subscribed to be alerted when this file changes”. Click OK.
   If you subscribed to a folder, the folder icon will have an email icon on it indicating you are subscribed to the folder.
3. You will receive email notifications about your alerts if the system has been configured. You can also view and manage your alerts in My FileHold > Document Alerts. See how to manage your alerts.

TO SET A REMINDER ON A DOCUMENT

1. Right-click on a folder or document and select Notify Me > Set a Reminder on a document.
2. In the Add Reminder for Document Name window, enter the date in which you wish to receive the reminder.
3. Enter the frequency in which you wish to receive the reminder: Once Only, Daily, Weekly, Monthly, Quarterly, Bi-Annually, or Annually.
4. Click OK.
5. You will receive email notifications about your reminders if the system has been configured. You can also view and manage your alerts in My FileHold > Document Reminders. See how to manage your reminders.

10.23.1. Managing Alerts and Reminders

Users can view and manage their document subscriptions (alerts and reminders) in the Document Alerts and Document Reminders areas of My FileHold.

Document reminders are those documents that require attention on a certain date and time period. You can view your document reminders in My FileHold > Document Reminders. You may also receive an email notification if your alert preferences are configured to do so.
Document alerts are those documents or folders that have been set to trigger an alert. You can view your document alerts in My FileHold > Document Alerts. You may also receive an email notification if your alert preferences are configured to do so. Folder alerts are triggered when:

- New documents are added to the folder.
- Documents are transferred to the folders.
- Documents are deleted from folders.

Document alerts are triggered when:

- A new version of a document is checked in.
- Metadata values are updated.

In order to receive any new alerts on a document, the current alert must be "marked as read". Once documents are marked as read, then any new alerts are emailed and appear in the Document Alerts folder.

Users must be subscribed to the folder or document prior to receiving an alert. See Setting Document Alerts and Reminders.

You can determine which type of alerts you want to receive by setting the Alert Preferences. See Alert Preferences for more information.

**TO MARK AN ALERT OR REMINDER AS READ**

1. Go to My FileHold > Document Alerts or Document Reminders and select an alert or reminder.
2. Click Mark as Read. The alert or reminder is removed from the list.

**TO REMOVE AN ALERT OR REMINDER**

1. Go to My FileHold > Document Alerts or Document Reminders and click Manage Alerts or Manage Reminders.
2. In the Manage My Alerts or Manage My Reminders window, select the file or folder you want to remove the subscription to and click Remove X.
TO DISABLE AN ALERT ON A FOLDER

1. Right-click on a folder that has an alert and select **Disable this Alert**.
11. LIBRARY ARCHIVE

The Library Archive is the area where documents that are no longer in use but still need to be kept for historical record purposes reside. The advantage of archiving is that it keeps your current documents in the Library and search results uncluttered with old or obsolete information. Once documents are in the Library Archive, they can still be searched using the Include Archive in Search check box under the Advanced Search area.

Documents can be archived using two methods:

- Manually archiving. Users with a cabinet administrator role or higher can move electronic documents manually from the library into the library archive. Cabinet and library administrators must be the owners of the cabinets in the library archive area in order to move documents in and out of the archive. You need to enable the permission setting in the Administration Panel.

- Using a scheduled event to automatically archive documents. See the Library Administration Guide for more information on scheduled events.

Documents that have been placed in the library archive:

- Left in the library archive indefinitely.
- Deleted from the library archive using an Event Schedule. See the Library Administration Guide for more information on scheduled events.
- Moved back into the Library manually should the need arise.

When documents are sent to the archive, the cabinet/drawer/folder group/folder structure is automatically duplicated. There is no need to recreate the structure. The security settings at the cabinet and folder levels are also maintained.

TO MANUALLY SEND A DOCUMENT, CABINET, DRAWER, FOLDER GROUP, OR FOLDER INTO THE ARCHIVE

1. Right-click on a folder and select Archive Folder or document and select Send to > Library Archive.
2. The documents and/or folders are sent to the Library Archive and the cabinet/drawer/folder group/folder structure is copied as well.

TO MOVE ARCHIVED ITEMS BACK TO THE LIBRARY

1. In the Library Archive, select the document or folder and select Copy or Move.
2. Select the Move files to a new location in the Library option and click Next.
3. Select the destination in the Library for the documents or folder and click OK.
4. At the alert message click OK. The documents and/or folder are moved back to the Library.
12. USING THE DOCUMENT TRAY

The Document Tray allows users to collect and perform actions on documents that are filed in various folders throughout the system. The document tray behaves much like a shopping cart in an e-commerce application in that it provides a temporary holding bin for documents that users wish to perform actions on.

The Document Tray helps users perform the same actions on documents that are stored in different folders. All actions available on the toolbar and right click commands are supported in the document tray including get copy, check out, move/copy, email, link and delete.

NOTE: Documents that are in the Document Tray are not copied or moved. The Document Tray is only making reference to the documents located elsewhere in library.

TO OPEN THE DOCUMENT TRAY

1. In FDA, click on the Document Tray icon on the lower right side of the screen.
2. In the Web Client, click Document Tray located at the top of the hierarchy panel.

The Document Tray opens at the bottom of the screen. In FDA, you can adjust the size of the Document Tray using the slider arrow. The Document Tray in the Web Client is self-adjusting. It will expand to fit the documents automatically.

To add documents to the Document Tray

1. There are many ways to send documents to the FileHold to the Document Tray. Do one of the following:
• In FDA or Web Client, select the document you wish to add to the document tray. Right-click on the file and select Send to > Document Tray. You can select multiple documents and send them to the Document Tray en masse.

• In the Web Client, place a check mark next to the documents you want to move into the Document Tray and select Sent To > Tray.

• In FDA, drag and drop document(s) from one or more folders and into the Document Tray.

WARNING: You cannot drag and drop documents in the Web Client.

TO CLEAR FILES FROM THE DOCUMENT TRAY

Removing documents from the document tray does not delete the file from the library. The document will remain in the same location.

1. Select the documents you wish to remove from the tray and click Clear.
13. USING THE DOCUMENT VIEWERS

Viewers have many user features and many benefits that increase productivity and save companies money. Viewers come included with each registered user license and assigned to registered users by the system administrator. Different viewers are available for use with FileHold:

- **PDF/Image Viewer (FDA only)**
- **FileHold viewer level 1 (web and FDA viewer)**
- **FileHold viewer level 2 (web and FDA viewer)**

If a user is assigned a FileHold viewer level 1 or level 2 viewer license, then they are also able to use the PDF/Image viewer in the FDA.

Viewer behavior can be configured in the User Preferences > Viewer tab.

**NOTE:** Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application. See the Knowledge Base for more information on how to use the Brava viewer.

13.1. FULL AND PARTIAL SCREEN VIEWS IN THE FDA

The interface of the FileHold Desktop Application (FDA) can be modified to accommodate seeing more information in the library tree and metadata pane when the viewer is in use.

Both the library tree and the metadata pane can be set to “full” or “partial” view mode when the viewer is open. Full mode extends the panes to the bottom of the screen where partial mode decreases the pane size to the same level as the viewer pane. This full mode feature allows users to look at more information in these areas while still viewing a document.

The Full and Partial buttons appear in the Library Tree and Metadata Pane only when the viewer is activated. Full mode is useful when looking at a document and entering metadata at the same time.
The FDA with the library tree in "partial" mode and metadata pane in “full” mode

13.2. PDF/IMAGE VIEWER

The PDF/Image viewer supports the following file formats:

- PDF
- TIFF (single or multi-page)
- Image files (jpg, png, gif, bmp)

The PDF/Image viewer can be used in the FileHold Desktop Application and allows users to do a number of actions on files.
<table>
<thead>
<tr>
<th>Action</th>
<th>PDF/Viewer Function</th>
</tr>
</thead>
</table>
| Modify a PDF or TIFF file | - Reorder pages using drag and drop  
- Insert a PDF or TIFF file into the current PDF or TIFF file.  
- Drag and drop pages between PDF and TIFF documents (of the same format) if the option to open documents in separate tabs is enabled. This can be enabled in the User Preferences > Viewer tab.  
- Delete pages  
- Publish as a PDF as a new document, a new version of a document, or as a local document.                                                                                   |
| Modify how the file is viewed | - Open multiple documents at a time. Each file is shown on a separate tab. Note that the tabbing feature needs to be enabled in the User Preferences > Viewer tab.  
- View thumbnails pages of a document. The thumbnail pane can be expanded or collapsed using a button on the toolbar.  
- Change the orientation of the thumbnail pane. It can be set to the top, bottom, left or right side of the viewer pane. The orientation of the pane is set in the User Preferences > Viewer tab.  
- Select multiple pages of the document via the thumbnails.  
- Undock the viewer so it is in its own window.  
- Pages can be rotated 90 degrees clockwise or counter-clockwise.  
- The size of the image can zoomed and can be set to a fixed zoom level. For example, 100%, 150%, page width and so on.  
- Scroll between pages.                                                                                                                                          |
| Modify an image file    | - Append an image to the current image file.  
- Insert an image from one image file to another image file using drag and drop.  
- Save the image file as a jpeg file or publish as a TIFF file.  
- Delete images.                                                                                                                                               |
| Other actions           | - Print the document.  
- Open documents in FileHold or from your local computer.  
- Open documents in the Brava viewer (if you are assigned a license).                                                                                             |
If a user is assigned a Brava viewer license, they can also use the PDF/Image viewer with the Brava viewer, with the Brava viewer being the default viewer. They can use the function Open to Reorder Pages/Images to open the document in the PDF/Image viewer. Note that starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use.

**NOTE:** If you have the "Automatically open Document in Viewer" options selected in the [User Preferences](#), the documents will only be opened in a single pane as you scroll through the documents.

### 13.2.1. Modifying a PDF or TIFF File

The following actions can be taken on a PDF or TIFF file:

- Reorder pages using drag and drop
- Insert a PDF or TIFF file into the current PDF or TIFF file.
- Drag and drop pages between PDF and TIFF documents (of the same format) if the option to open documents in separate tabs is enabled. This can be enabled in the [User Preferences > Viewer tab](#).
- Delete pages
- Publish as a PDF as a new document, a new version of a document, or as a local document.

**TO USE THE PDF/IMAGE VIEWER TO REORDER PAGES OR IMAGES**

1. Right-click on a PDF or multiple page TIFF file and select Open to Reorder Pages/Images. The document opens in the viewer.
2. Move the pages around using the drag and drop method.

**TO DRAG AND DROP A PAGE BETWEEN TWO FILES**

1. Have two PDF or TIFF files open in separate tabs in the PDF/Image viewer. In order to do this, you will need the “Open documents in the Document Viewer using separate tabs” option selected in the [User Preferences > Viewer tab](#).
2. Select one or more page from the originating document.
3. Drag and drop a page from one tab to the other tab and select a location for the page(s) in the thumbnail view. A black bar is shown where the page(s) will be moved to.

**To publish as a PDF document**

1. After modifying a PDF document in the PDF/Image viewer, go to File > Publish to PDF.
2. Select one of the options:
   - Save this published version as a new local document - Saves the document to your local computer. Save or open the file to the local computer.
   - Save this published version as a new document in FileHold - Saves the document as a new document to the library. If saving as a new document in the library, set the folder location for the document and fill out any related metadata and click Submit.
   - Create a new version of the file you are publishing – Creates a new version of the document. A new version is automatically created.

**To delete pages from a file**

1. Select the page or pages you want to delete in the thumbnail images. You can multi-select pages using the CTRL or SHIFT keys.
2. Go to Edit > Remove Pages or click the Remove Pages button.

**To insert a PDF or TIFF file into a PDF or TIFF file**

1. Open the document to be modified.
2. Select the page in the thumbnail view that you want to insert pages before or after the currently selected image.
3. Go to Edit > Insert File Before or Insert File After.
4. Select the file to be inserted. It can be a local file or a file from the FileHold library. The file is inserted into the current document.

### 13.2.2. Modifying an Image File

The following actions can be taken on image files (jpg, gif, png, bmp):

- Append an image to the current image file.
- Insert an image from one image file to another image file using drag and drop.
- Save the image file as a jpeg file or publish as a TIFF file.

**To insert an image file into an image file**

1. Open the document to be modified.
2. Select the page in the thumbnail view that you want to insert pages before or after the currently selected image.
3. Go to Edit > Insert File Before or Insert File After.
4. Select the file to be inserted. It can be a local file or a file from the FileHold library. The file is inserted into the current document.
TO DRAG AND DROP AN IMAGE FILE INTO ANOTHER IMAGE FILE
1. Have two image files open in separate tabs in the PDF/Image viewer. In order to do this, you will need the "Open documents in the Document Viewer using separate tabs" option selected in the User Preferences.
2. Drag and drop an image from one tab to the other tab.

TO SAVE A PAGE AS AN IMAGE FILE (JPEG)
1. After modifying a PDF document in the PDF/Image viewer, go to File > Save Page As.
2. Save the current page to your local machine as a jpeg file.

13.2.3. Other Actions of the PDF/Image Viewer

TO PRINT A DOCUMENT
- Go to File > Print or click the Print button.

TO UNDOCK THE VIEWER
- Click the Undock Viewer button.

TO CLOSE A DOCUMENT IN A TAB
- Click the X in the tab or go to File > Close File.

NOTE: If you have the "Automatically open Document in Viewer" options selected in the User Preferences, the documents will only be opened in a single pane as you scroll through the documents.

13.3. FILEHOLD VIEWER LEVEL 1 AND 2

The FileHold level 1 and 2 viewers allow users to view files in both the Web Client and FileHold Desktop Application (FDA). Each registered user account comes standard with a FileHold level 1 viewer. A system administrator can change this to a level 2 viewer in the user account, if purchased.
See the table below for features supported by the level 1 and level 2 viewers.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Level 1</th>
<th>Level 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open multiple documents</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Publish document to local computer</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Publish document to FileHold</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Print document</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Automatically open documents in folders and search results</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Basic annotations and markup</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Search and highlight search results</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>High fidelity rendering</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Manipulate pages</td>
<td>X (limited to PDF and image files)</td>
<td>X (all supported file types)</td>
</tr>
</tbody>
</table>

The following file formats are supported by the level 1 and 2 viewers:

docx, rtf, txt, pdf, svg, emf, wmf, docx, rtf, txt, gif, cut, dds, dib, dicom, exif, exr, fax, g3, hdr, iff, ico, j2k, j2c, jb2, jbig2, jif, jif, jng, jp2, jpeg, jpg, jpe, koa, lbm, mng, pbm, pcx, pcm, psd, png, ppm, ppm, ras, rle, sgi, tga, targa, tiff, tif, wbmp, wap, wbm, xbm, xpm, 3fr, arw, bay, bmq, cap, cine, cr2, crw, cs1, dc2, dcr, drf, dsc, dng, erf, tff, hdr, ia, iic, k2c, k25, kdc, mdc, mef, mos, mrw, nef, nrw, orf, pef, ptx, pxn, qtk, raf, raw, rdc, rw2, rw1, rwz, sr2, srf, sw, slf.

The level 1 viewer uses low fidelity rendering for docx, rtf, and txt files.

The level 2 viewer supports all the formats listed above plus: doc, docm, dot, dotm, dotx, xml, fopc, odt, ott, mobi, htm, html, mhtml, mht, xhtml, xht. This viewer uses high fidelity rendering for docx, rtf, and txt files.

The FileHold viewers are primarily used with a mouse but supported browser keystrokes can be used such as arrows, home, end, page up, and page down buttons for scrolling page in the viewer panel. Copy (Ctrl+C) can be used when text is selected in a document and Enter when the focus is either in the text search or the page navigation text input.
With the FileHold viewer, some features of some of the supported file formats are not supported for viewing. It is recommended that you test your documents in the viewer in order to determine how your documents are rendered.

Note that the FileHold viewer level 2 supports high fidelity rendering which means documents are converted to PDF format before being displayed in the viewer. These temporary PDF files are stored in a cache and are cleaned up in the scheduled task “FH clean web viewer cache”. By default, the task runs once per day. The number of days to store the cached documents can be configured in the web config file setting “ViewerCacheLife” in C:\Program Files\FileHold Systems\Application Server\LibraryManager. The default number of days to store the cached files is 1095 days.

To enable external links in the documents viewed in the FileHold viewer level 1 and 2, set the "EnableExternalLinksForHtmlViewing" key to “true” in the C:\Program Files\FileHold Systems\Application Server\DocumentRepository web config file.

NOTE: The help link for the FileHold viewer in the FDA does not work on Windows Server 2012R2 nor 2016.

13.3.1. FileHold viewer level 1 and 2 – Page manipulation

Pages in a document can be manipulated, such as adding, deleting, copying, dragging and dropping pages, rotating, and flipping, in the FileHold viewers level 1 and 2.

Some Level 1 viewer manipulation is limited to only PDF and image files. Level 2 viewer supports PDF, image, docx, rtf, and txt files.

One or more pages can be selected in the thumbnail view. To select multiple pages, use the SHIFT and/or CTRL keys.

TO USE THE FILEHOLD VIEWER

1. Using the contextual menu, select Open in FileHold Viewer. The document is opened with thumbnails displayed on the left side of the viewer. The currently selected page is displayed in the main part of the viewer.

2. To manipulate the pages, use the toolbar buttons to zoom in and out, navigate between pages, and close the viewer to return to the list of documents. See the table below for a complete list of functions and descriptions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish document</td>
<td>Add document as a PDF into the FileHold repository as a new document, as a new version, or save as a local copy of the document. Also available from right-click menu on thumbnail.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the document.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add pages</td>
<td>Adds one or many files before or after the selected page. Files can be added from a local file, clipboard, or the FileHold library. Also available from right-click menu on thumbnail. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Copy to clipboard</td>
<td>Copies selected pages to the clipboard. Also available from right-click menu on thumbnail. Once the page is copied, it can be added back into the document using Add Pages &gt; Clipboard option. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Delete pages</td>
<td>Deletes the selected pages. Also available from right-click menu on thumbnail. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Previous Page</td>
<td>Previous image is displayed in the document.</td>
</tr>
<tr>
<td>&lt;page number&gt;</td>
<td>Enter a page number to show the image.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Next image is displayed in the document.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Zooms in on the image.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out from the image.</td>
</tr>
<tr>
<td>Fit to Width</td>
<td>Adjusts the image on the screen to fit the full width of the image.</td>
</tr>
<tr>
<td>Best Fit</td>
<td>Adjusts the image on the screen so the entire image is displayed.</td>
</tr>
<tr>
<td>Full Size</td>
<td>Shows the full image size.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rotate Left 🔄</td>
<td>Rotates page(s) 90 degrees to the left. Also available from right-click menu on thumbnail. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Rotate Right 🔄</td>
<td>Rotates page(s) 90 degrees to the right. Also available from right-click menu on thumbnail. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Flip Horizontal 💗</td>
<td>Flips the page(s) horizontally. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Flip Vertical 💗</td>
<td>Flips the page(s) vertically. Limited to PDF and image files for level 1 viewer.</td>
</tr>
<tr>
<td>Close Viewer ✗</td>
<td>Closes the viewer and returns to the folder. Available in the Web Client only.</td>
</tr>
<tr>
<td>Copy text from screen</td>
<td>Select text from a text searchable document and right-click &gt; Copy text.</td>
</tr>
<tr>
<td>Highlight</td>
<td>Select text from a text searchable document and right-click &gt; Highlight.</td>
</tr>
<tr>
<td>Strikeout</td>
<td>Select text from a text searchable document and right-click &gt; Strikeout.</td>
</tr>
<tr>
<td>Underline</td>
<td>Select text from a text searchable document and right-click &gt; Underline.</td>
</tr>
<tr>
<td>Drag and drop</td>
<td>One or many pages can be dragged and dropped into a new position in the thumbnail view. Use the CTRL and/or SHIFT keys to select multiple pages. Limited to PDF and image files for level 1 viewer.</td>
</tr>
</tbody>
</table>
13.3.2. FileHold viewers level 1 and 2 – Highlight search results

FileHold can display the search terms highlighted within searchable documents. Searches can be conducted from the FileHold library or using the Search pane directly in the FileHold viewer. Search results are highlighted in green.

In the Search pane, whole word and case-sensitive options are available. Searches can be done in current page only or in the entire document.

The Search feature is available in both level 1 and 2 viewers.

TO HIGHLIGHT RESULTS IN DOCUMENTS FROM LIBRARY SEARCHES

1. Execute a simple, advanced, or saved search.
2. In the search results, right-click and select Open in FileHold viewer.
3. The FileHold viewer opens with the search terms highlighted and the Search pane. Scroll through the search results using the Search pane in the viewer.

TO SEARCH IN THE FILEHOLD VIEWER

1. In the FileHold viewer, select the Search icon.
2. Enter the search term.
3. Select any of the following options:
   - Whole word – Disabled by default.
   - Case sensitive – Disabled by default.
   - Any word – Disabled by default.
   - Current page – Search through the current page only.
   - Whole document – Searches through the whole document. This is the default setting.
4. Click Search. The search terms are highlighted.
### 13.3.3. FileHold level 2 viewer – Annotations

Annotations are only available in the FileHold viewer level 2. The changes made to the annotation properties do not persist from document to document.

After the annotations are made, the annotated document can be published as a new document or new version in the library or saved locally. See [FileHold viewers level 1 and 2 – Publish as PDF](#) for more information.

#### TO USE ANNOTATIONS FOR THE FILEHOLD VIEWER LEVEL 2

1. Using the contextual menu, select **Open in FileHold viewer**. The document is opened with thumbnails displayed on the left side of the viewer. The currently selected page is displayed in the main part of the viewer.

2. To annotate the pages, select the **Annotations** icon 🖊️. To return to the thumbnails view, select the **Thumbnails** icon 📄.

3. Select the annotation option, fill out the related annotation properties, and then draw on the screen where the annotation is to be placed. Use the following table to learn more about annotations:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlighter</td>
<td>Allows you to add a rectangle highlighter annotation onto a document. A number of highlighter properties are available to set the colour and rotation.</td>
</tr>
<tr>
<td>Freehand highlighter</td>
<td>Allows you to draw a freehand highlighter annotation onto a document. A number of freehand highlighter properties are available to set the colour, rotation, and border width.</td>
</tr>
<tr>
<td>Rubber stamp</td>
<td>Allows you to add a rubber stamp annotation onto a document. A number of stamp properties are available such as font, colour, opacity, rotation, borders, radius, and line styles.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Allows you to add a rectangle annotation onto a document. A number of rectangle properties are available to set the colour, opacity, rotation, borders, radius, and line styles.</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Allows you to add an ellipse annotation onto a document. A number of ellipse properties are available to set the colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Line</td>
<td>Allows you to add a line annotation onto a document. A number of line properties are available to set the colour, start and end cap, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connected lines</td>
<td>Allows you to add a connected line annotation onto a document. A number of connected line properties are available to set the colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Freehand</td>
<td>Allows you to draw a freehand annotation onto a document. A number of freehand properties are available to set the colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Arrow</td>
<td>Allows you to add a line arrow annotation onto a document. A number of arrow properties are available to set the arrow height, width, colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Ruler</td>
<td>Allows you to add a ruler annotation onto a document. The total length of the line is displayed. A number of ruler properties are available to set the font, font size, colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Polygon ruler</td>
<td>Allows you to add a polygon ruler annotation onto a document. The total length of the polygon is displayed. A number of polygon ruler properties are available to set the font, font size, colour, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Text</td>
<td>Allows you to add a text annotation onto a document. A number of text properties are available to set the measurement unit, colour, position, justification, opacity, rotation, borders, and line styles.</td>
</tr>
<tr>
<td>Sticky note</td>
<td>Allows you to add a sticky note annotation onto a document. A number of sticky note properties are available to set the font, font size, colour, position, justification, opacity, rotation, borders, and line styles.</td>
</tr>
</tbody>
</table>

**NOTE:** Closing the FileHold Viewer in the FDA will not remove any annotations. In order to clear annotations on the document, close the X on tab.
13.3.4. FileHold viewers level 1 and 2 – Publish as PDF

If a document has been updated through page manipulation or annotations, the newly updated document can:

- Published as a new document on the local computer.
- Published as a new document in the FileHold library.
- Published as a new version of the document in the library.

**To publish as a PDF document**

1. Click Submit.
2. Select one of the options:
   - Save this published version as a new local document - Saves the document to your local computer. Save or open the file to the local computer.
   - Save this published version as a new document in FileHold - Saves the document as a new document to the library. If saving as a new document in the library, set the folder location for the document and fill out any related metadata and click Submit.
   - Create a new version of the file you are publishing – Creates a new version of the document. A new version is automatically created.
3. Click OK.
14. ASSEMBLING DOCUMENTS

The assemble documents feature can be used to automatically construct new documents based on the rules set in the assembly configuration.

A user must have a FileHold viewer level 2 in order to use the assemble documents feature. This feature is only available in the FileHold Desktop Application (FDA). Any supported file types can be used to merge documents together; they do not have to belong to the same file type. The file types that are supported are:

docx, doc, docm, dot, dotm, dotx, rtf, txt, pdf, svg, emf, wmf, gif, cut, dds, dib, dicom, exif, exr, fax, g3, hdr, iff, ico, j2k, j2c, jb2, jbig2, jif, jiff, jng, jp2, jpe, jpeg, jpg, jpe, koa, lbm, mng, pbm, pcx, pfm, pgm, pdt, pict, pic, pcx, pcf, pdf, png, psd, psd, rle, rgb, rlp, tiff, tiff, tiff, tiff, wbmp, wap, wbm, xbm, xpm, 3fr, arw, bay, bmq, cap, cine, cr2, crw, cs1, dc2, dcr, dcr, dsc, dng, erf, fff, hdr, ia, iiq, kc2, k25, kdc, mdc, met, mos, nrw, nef, nrw, orfe, pef, ptx, pxn, qtk, raf, raw, rdc, rw1, rwz, sr2, srw, sti, xml, fopc, odt, ott, mobi, htm, html, mhtml, mht, xhtml, xht.

With the assemble documents feature you can:

- Create standalone documents
- Merge documents together
- Append and prepend documents
- Use converter templates to populate certain field information (similar to the workflow covert to PDF feature)
- Output documents to PDF, PDF/A-1A, or PDF/A-1B
- Order the documents for assembly
- Rename the newly assembled document
- Create new documents for the FileHold library
- Check in as new version of an existing document
- Create a temporary document for viewing
- Apply PDF security options
- View the assembled document in the FileHold viewer post-assembly
- Initiate a workflow post-assembly
- Initiate a Courier transmission post-assembly

Documents are placed in queue and assembled on the FileHold server. A scheduled task “FH process batch jobs” can control how often the batches are run. By default, the scheduled task runs every 10 minutes.

Renaming a document in "Do not merge" mode is allowed when only one input document was selected. If more than one document is selected, the document name and metadata for the assembled document is taken from the first document selected.

Renaming and ordering of the documents is allowed in "Merge all documents to one" mode. The metadata for the assembled document is taken from the first document in the document order list.

Due to the number of variables with the assemble documents feature, it is recommended that customers test the feature with their own documents in their FileHold environment. Note that larger number of documents or larger file sizes will take longer to assemble.
Users can see their jobs in the Batch jobs report in the FileHold Desktop Application or in the Web Client > Administration reports > Batch jobs. See Batch jobs report for more information.

Once the job has completed, the user receives an “Assemble documents batch job ready” email with links to the batch job details or open the document in the viewer if the option was enabled in the job settings.

**TO ASSEMBLE DOCUMENTS**

1. Select the documents that you want to assemble. They do not have to be the same file type.
2. Right-click and select **Publish As > Assemble to PDF**.
3. In the Input tab, select one of the following options:
   - Do not merge documents – This option is enabled if only one document is selected.
   - Merge all documents into one – This option is enabled if more than one document is selected.
4. If the Merge all documents to one option was selected, click … in the Order Documents field to set the order of the documents for the merging.
   - In the Order documents window, enter the output document name. Note that the newly assembled document copies the metadata from the first document in the list.
   - In the Order column, click in the row to set the order of the documents.
   - Click Close when done.
5. Click Next.

6. In the Output tab, select one of the following options:
   - Create new document(s) - Click … to select a library location for the document.
   - Create temporary document(s) for viewing – Opens the document in the FileHold viewer. Documents can be modified in the viewer prior to saving.
   - Check in as new version – To check the input documents as a new version, leave option as "Input document". Alternatively, click … to select a document from the Checked Out Documents list.

7. In the Output file format field, select one of the following options:
   - PDF
   - PDF/A-1a
   - PDF/A-1b

8. Click Next.

9. In the Assembly options tab, enter the following options:
   - Append page(s) from template – Click … to select a document from the library.
   - Prepend page(s) from template – Click … to select a document from the library.
   - Process tags in input documents – Select the check box if the input documents contain tags that should be processed. Tags allow information to be inserted into a document. See Using Template Tags when Assembling Documents for more information.
   - Set the template opening tag delimiter – Enter the opening tag delimiter for the PDF converter template. By default, this is [\[.]
   - Set the template closing tag delimiter – Enter the closing tag delimiter for the PDF converter template. By default, this is ]\].
   - Set the template tag field delimiter – Enter the field delimiter. By default, this is |.

10. Click Next.

11. In the PDF options tab, select any of the following options:
    - Allow printing - Allows printing of the document. Enabled by default.
• Allow high resolution printing - Allows high resolution printing. Enabled by default.
• Allow changing the document - Allows changing the document. Disabled by default.
• Allow content copying - Allows copying the content. Enabled by default.
• All content accessibility enabled - Allow accessibility software to use the document contents. Enabled by default.
• Allow document assembly - If this is disabled, inserting, deleting or rotating pages, or creating bookmarks and thumbnails is prohibited. Disabled by default.
• Open password for main documents - Specifies the password required for opening the encrypted PDF document. This can be left blank.

12. Click Next.
13. In the Actions tab, select any of the following options:
   • Open finished document(s) in viewer – Select the check box to view the newly assembled documents in the FileHold viewer.
   • Initiate workflow – Select the workflow template name from the list to initiate a workflow post-assembly.
   • Initiate Courier transmission – Select the Courier template from the list to initiate a Courier transmission

14. Click Next.
15. In the Summary tab, review the selected options. Click Previous to change any of the settings.
16. Click Assemble.
17. A message “Assemble document(s) (job number) job has been successfully initiated appears. The job status, queued time, batch job name, and user name is displayed.
18. To cancel the assemble job, click Cancel job.
19. To pause the assemble job, click Pause job.
20. To review the job settings, click Details.
21. After the processing is complete, click Complete user actions to view the document in the FileHold viewer.
22. To close the window, click Close.

TO VIEW THE DOCUMENT ASSEMBLY JOB
1. Right-click on a document that was included in the PDF assembly and select Publish As > Open batch job.
2. One of the following actions may occur:
   • If the batch processing has completed, the document will open in the viewer if the option was enabled in the job settings.
   • If the batch processing has not completed, the Batch job manager opens where you can cancel, pause, or view the details of the batch job.
3. Click Close.
14.1. USING TAGS WHEN ASSEMBLING DOCUMENTS

Tags can be strategically placed within a Microsoft Word document to insert information into the assembled PDF document. Information such as metadata field values, system information, and workflow information can be inserted into the newly generated document.

By default, the opening delimiter will be "[[". The closing delimiter will be "]". Tags include multiple delimited fields. By default, the field delimiter will be a pipe "|".

Each tag will have the following format: [[<type>|<name>|<format>|<nullreplacement>]]. <type> is one of "md" for metadata field values or "sys" for system information. For tags of type md, <name> is a metadata field name. Where tags are of type sys, <name> is one of the fields in the table below. <format> is standard dot net formatting codes for fields except signoff-sheet, which uses non-standard formatting codes listed below. <nullreplacement> is simply text that will be used in the event the field is not defined in the context where it is being used. For example, a metadata field tag where the metadata field does not exist in the document schema for the document being converted.

If processing several documents at once, the tag information is merged depending on the information type and separated by a comma. If assembling only one document, then the metadata values are taken from the single source document.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| signoff-sheet | This tag is output as a simple table similar to the signoff sheet available in the FDA or web client, it also offers a vertical format table, and a limited information list format.  

The horizontal and vertical formats will include the following document information: “Signer name”, “Approval date”, “On behalf of”, “Document name”, and “Workflow name”.

There are three formats codes for each of the different signoff sheet formats and one modifier. The format codes and modifier must be specified according to the following pattern: <formatcode>|<modifier>.

- **horizontal** – similar to the standard signoff sheet displayed in the client application.
- **vertical** – a vertically oriented version of the signoff sheet in the client application.
- **list** – a list of approvers. Each item in the list includes the approver name, approver title from the contact information, and the approval date and time.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>displayed in the regional format. Each approval is separated from the one before by a blank line. If the title field is blank, no title line is output.</td>
</tr>
<tr>
<td>all / –</td>
<td>When this modifier is included, the signoff sheet should include all workflows for the main document. The /all option needs to be included in the tag if you want the workflow information to appear in the generated document.</td>
</tr>
<tr>
<td></td>
<td>The following is an example signoff sheet field with the horizontal format and showing all workflows.</td>
</tr>
<tr>
<td></td>
<td>[[signoff-sheet</td>
</tr>
<tr>
<td></td>
<td>Shows the approvers in a list format along with titles and time of approval and showing all workflows:</td>
</tr>
<tr>
<td></td>
<td>[[signoff-sheet</td>
</tr>
<tr>
<td>approval-date</td>
<td>The date the main document was approved.</td>
</tr>
<tr>
<td>workflow-name</td>
<td>The name of the workflow for the main document. The workflow could have been manually named or automatically named through a naming pattern.</td>
</tr>
<tr>
<td>workflow-template</td>
<td>Name of the workflow template.</td>
</tr>
<tr>
<td>filehold-id</td>
<td>The internal document id of the main document.</td>
</tr>
<tr>
<td>document-version</td>
<td>User visible automatic document version number. Note that this is the version number of the source document. When the converted document is added, it will have a different version number.</td>
</tr>
<tr>
<td>version-control-no</td>
<td>The version control number.</td>
</tr>
<tr>
<td>document-control-no</td>
<td>The document control number.</td>
</tr>
<tr>
<td>workflow-initiator-name</td>
<td>The name of the user who initiated the workflow on the main document.</td>
</tr>
<tr>
<td>document-owner-name</td>
<td>The name of the user who is the owner of the main document.</td>
</tr>
<tr>
<td>document-name</td>
<td>The file name of the document.</td>
</tr>
<tr>
<td>metadata field</td>
<td>md</td>
</tr>
<tr>
<td></td>
<td>Ensure that the spelling is exactly the same in both the metadata field and the tag.</td>
</tr>
</tbody>
</table>

For example, I want metadata from my bicycle model manual to be included in the assembled PDF. The tags would resemble:

Product Details
Product ID: [[md|Product ID]]
Product Model: [Bike Model]
List price: [List Price]

14.2. **BATCH JOBS REPORT**

The batch jobs report displays a list of the documents that were constructed using the assemble documents feature. In the report you can view the status of the batch job and pause, cancel, or view the details of the job.

Only the last 7 queued days is visible. Users can view only the jobs they have added to the batch queue unless they have an administrator role.

**TO USE THE BATCH JOBS REPORT**

1. Do one of the following:
   - In the FDA, click the Batch jobs icon.
   - In the Web Client, go to Administration > Full Administration Menu > Administration reports > Batch jobs.

2. The following batch job information is displayed:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch ID</td>
<td>The batch number</td>
</tr>
<tr>
<td>Queued time</td>
<td>The date and time the documents were submitted for batch processing</td>
</tr>
<tr>
<td>Start time</td>
<td>The date and time the documents started to be processed</td>
</tr>
<tr>
<td>Status</td>
<td>Statuses include:</td>
</tr>
<tr>
<td></td>
<td>Queued – Job is added to queue</td>
</tr>
<tr>
<td></td>
<td>Paused – Job has been postponed by user</td>
</tr>
<tr>
<td></td>
<td>In progress – Job is being currently processed</td>
</tr>
<tr>
<td></td>
<td>User action pending – Job processing is done but waiting for user actions to be performed such as view document in FileHold viewer</td>
</tr>
<tr>
<td></td>
<td>Complete – Job processing is done and there are no user actions to perform</td>
</tr>
<tr>
<td></td>
<td>Cancelled – Job has been cancelled by user</td>
</tr>
<tr>
<td></td>
<td>Error – An error occurred during job processing</td>
</tr>
<tr>
<td>User name</td>
<td>The user who submitted the batch job to the queue</td>
</tr>
<tr>
<td>Batch job name</td>
<td>This value is always “Assemble document(s)”</td>
</tr>
<tr>
<td>End time</td>
<td>The date and time the batch processing completed.</td>
</tr>
</tbody>
</table>

3. To view the batch job details, double-click on the row.
4. To cancel the assemble job, click **Cancel** job.
5. To pause the assemble job, click **Pause** job. To resume a paused job, click **Resume**.
6. To review the job settings, click **Details**.
7. To view the document in the FileHold viewer (if the option was enabled), click **Complete User Action**.
8. To close the window, click **Close**.

14.3. **HOW TO MANIPULATE THE BATCH JOB REPORT VIEW**

The batch jobs report can be modified to add or remove columns, resize or change the order of the columns, sort ascending or descending, filter the results, and save these different views. The displayed information can be exported out of the system in order to do further analysis on user accounts.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort ascending/descending</td>
<td>Click on the column header to sort ascending or descending. Alternatively, click <img src="image" alt="column header" /> in the column header and select <strong>Sort Ascending</strong> or <strong>Sort Descending</strong>. An up or down arrow shows in the column header indicating the sort order.</td>
</tr>
<tr>
<td>Add or remove columns</td>
<td>Click <img src="image" alt="column header" /> in the column header and select <strong>Columns</strong>. Select the check boxes for the columns to be displayed. Clear the check boxes to remove the header.</td>
</tr>
<tr>
<td>Resize columns</td>
<td>Hover the cursor between the column headers to resize a column.</td>
</tr>
<tr>
<td>Filter</td>
<td>Click <img src="image" alt="column header" /> in the column header and select <strong>Filter</strong>. Select the filter options and click <strong>Filter</strong>. The filter options available depend on what type of column is selected. A white filter icon <img src="image" alt="filter icon" /> is shown in the header if the column is being filtered. To clear the filter, go to <strong>Filter</strong> and click <strong>Clear</strong>.</td>
</tr>
<tr>
<td>Change column position</td>
<td>Drag and drop columns to the desired position.</td>
</tr>
<tr>
<td>Group by a column</td>
<td>Drag and drop a column header to top blue bar that says “Drag a column header and drop it here to group by that column”. To remove the grouping, click the <img src="image" alt="X" /> next to the header name in the blue bar.</td>
</tr>
</tbody>
</table>
## Function

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll through pages</td>
<td>In the bottom left corner, use the scroll settings to: &lt;ul&gt;&lt;li&gt;Go to first page&lt;/li&gt;&lt;li&gt;Go to previous page&lt;/li&gt;&lt;li&gt;Go to next page&lt;/li&gt;&lt;li&gt;Go to last page&lt;/li&gt;&lt;/ul&gt; Adjust the number of items per page: 15, 30, 60</td>
</tr>
<tr>
<td>Refresh screen</td>
<td>Click Refresh in the bottom right corner.</td>
</tr>
</tbody>
</table>

## 15. Setting Preferences

Preferences and Settings allows you to modify the document management system to suit your personal needs. You can modify your password, document list views, document alerts, workflow (if purchased), and FastFind preferences (if purchased).

Some, none, or all of these settings may be determined and/or enforced by your system administrator. See your system administrator for details.

### To Set Preferences

1. Do one of the following:
   - In FDA, go to File > Preferences and Settings.
   - In Web Client, right-click on My FileHold to access View, Alert and User preferences. Right-click on Reviews & Approvals to access the Workflow preferences.
   - In the Web Client, go to Administration Panel > My FileHold.
2. Set the following preferences:
   - View Preferences
   - User Preferences
   - Alert Preferences
   - Workflow Preferences
   - FastFind Preferences (FDA only)
   - Reset My Password (Web Client only)
15.1. USER PREFERENCES

The User Preferences allows you to edit your contact and password information. This includes the users account information, contact information, company information as well as default language preferences.

The General tab contains user’s account setting information. The Contact and Company tabs contain user contact and company information respectively. The Advanced tab allows the user manage the functionality of the system. Some, none, or all of these settings may be determined and/or enforced by your system administrator. See your system administrator for details.

TO SET THE USER PREFERENCES

1. In FileHold Desktop Application (FDA), go to File menu > Preferences and Settings > User Preferences.
   - In the Web Client, right-click on My FileHold and select My User Preferences.
   - In the Web Client, go to Administration Panel > My FileHold > User Preferences.
2. The General tab contains the user account information. Use the following table to fill out the information in the General tab:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Your first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Your last name.</td>
</tr>
<tr>
<td>User Logon Name</td>
<td>You are not able to modify your user name in the User Preferences. Contact your system administrator if you need to change your user name.</td>
</tr>
<tr>
<td>Source</td>
<td>Local FileHold account or a domain account (synchronized with Microsoft Active Directory).</td>
</tr>
<tr>
<td>Default Language</td>
<td>Select the default language. This is typically English. If the language you want is not available please contact your system administrator and ask them about obtaining additional language packs from FileHold Systems.</td>
</tr>
<tr>
<td>Default page after log in (Web Client only)</td>
<td>Determines the window that is displayed after log in: Blank, Simple Search, Advanced Search, My Tasks, or Dashboard (if permitted. See your system administrator for details).</td>
</tr>
<tr>
<td>Edit metadata upon Check In Action (Web Client only)</td>
<td>When enabled, the metadata pane is displayed in edit mode after a new version is checked in. This allows the user to enter new metadata. If disabled, the user can check the document back in without editing metadata.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear required metadata fields upon Check In (Web Client only)</td>
<td>When enabled, any required fields in the schema are automatically blanked out (current value is deleted) when checking in a new version of a document. The users are forced to fill in the required field prior to checking in the document.</td>
</tr>
<tr>
<td>Number of expanded drawers (Web Client only)</td>
<td>The number of drawers that can be simultaneously expanded in the library tree can be set. The lower number of expanded drawers allows for a faster page loading time due to the lower number of permissions that needs to be calculated before displaying the library structure to the user. The last drawers that were opened by the user are preserved when the library is refreshed. The default is 3.</td>
</tr>
<tr>
<td>Reset all “Don’t Show This Message Again” reminders (Web Client Only)</td>
<td>If you have selected any “don’t show this message again” check boxes in various windows, you can have them reappear by clicking Reset.</td>
</tr>
<tr>
<td>Change Password (FDA only)</td>
<td>Click Change Password to change your password if you are using a locally-managed account. In the Set Password, enter your old password and a new password twice and click OK. NOTE: If you are using a domain user account (Active Directory), you will not be able to change your password. See your system administrator.</td>
</tr>
<tr>
<td>Default Local Working Folder (FDA only)</td>
<td>This is where your working documents are stored on your local machine. This is the path to where documents are checked out and downloaded. To change the path, click Browse and select the new working folder location.</td>
</tr>
<tr>
<td></td>
<td>NOTE: For the Web Client, documents are downloaded to the location that is set in your web browser settings.</td>
</tr>
</tbody>
</table>

3. In the FDA only, in the Advanced tab, select the settings you want enabled. **NOTE:** These options may be locked down by your system administrator.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default page at start-up</td>
<td>Determines the window that is displayed after log in: Blank, Simple Search, Advanced Search, My Tasks</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Format of document imports      | Select one of the following options:<br>• QuickScan Pro – select this option if you are using the EMC Captiva QuickScan Pro scanning software.  
• Capture – select this option if you are using SmartSoft Capture scanning software.  
• Both – select this option if any users could be using both QuickScan Pro and Capture at the same scanning station, for example sharing inboxes and imports, or using the Outlook Watched folder and Capture at this computer.  
If you are using the “Both” option, ensure that folder you select for the import profile contains only one type of XML files. The rule also applied for any of its subfolders. Capture and QSP XML files cannot coexist in the same folder tree.  |
| Number of expanded drawers      | The number of drawers that can be simultaneously expanded in the library tree can be set. The lower number of expanded drawers allows for a faster page loading time due to the lower number of permissions that needs to be calculated before displaying the library structure to the user. The last drawers that were opened by the user are preserved when the library is refreshed. The default is 3.  |
| Enable Click To Tag             | When enabled, the Click To Tag button appears in the metadata pane and allows you to “click” or “rubber band” text, numbers, dates, etc. on the screen and inserts the value into the metadata field of the schema.  
If disabled, the Click to Tag button does not appear in the metadata pane.  |
<p>| Show Welcome Screen at Startup  | Displays the FileHold Welcome Screen after you start the FDA: Blank, Simple Search, Advanced Search, Inbox, My Tasks, or Calendar.  |
| Prompt me for download location when I make copies of files | Allows you to select a location on your local machine to save your copied files.  |
| Prompt me for download location when I check out files | Allows you to select a location on your local machine to save your checked out files.  |
| Prompt me to remove files when sending them from the Inbox | A prompt will ask you if you want to remove the files from your local machine when sending them from the Inbox.  |</p>
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt me to clean up my FileHold working folder when I close the FileHold Desktop Application</td>
<td>A prompt will ask you if you want to remove the files in your working folder on your local machine when you exit out of FDA.</td>
</tr>
<tr>
<td>By default close documents that I add/check in to FileHold</td>
<td>Documents will be closed in their native application when it is checked in or added to the Library.</td>
</tr>
<tr>
<td>By default delete documents that I add to FileHold</td>
<td>Documents will be deleted from the working folder on your local machine after they are added to the Library.</td>
</tr>
<tr>
<td>By default delete documents that I Check In to FileHold</td>
<td>Documents will be deleted from the working folder on your local machine after they are checked into the Library.</td>
</tr>
<tr>
<td>Auto-send documents to Auto-Tagged folders</td>
<td>Documents in the Inbox will be automatically sent to their location in the Library if the folder is Auto-tagged. You will not need to click the Auto-File button.</td>
</tr>
<tr>
<td>Auto-send documents after completing metadata</td>
<td>Documents in the Inbox will be automatically sent to their location in the Library after the metadata has been sent. You will not need to click the Send or Send All button.</td>
</tr>
<tr>
<td>Move to recycle bin instead of permanently deleting</td>
<td>Documents that are set to be deleted after checking in or adding to the Library will be moved to the Recycle Bin on your local machine instead of being deleted.</td>
</tr>
<tr>
<td>Enable Smart Check In and Smart Check Out messages</td>
<td>Smart messages are the messages that appear when checking in and out a document using Microsoft Office applications. This setting is enabled by default. To turn off &quot;Smart Messages&quot;, clear the check box. Examples of smart messages that are displayed in Microsoft Office applications from FileHold are:</td>
</tr>
<tr>
<td></td>
<td>• When saving and closing a document without checking in a checked out document.</td>
</tr>
<tr>
<td></td>
<td>• When getting a local copy of a document, making edits, and saving without checking out the document.</td>
</tr>
<tr>
<td></td>
<td>• When checking out and opening a document and close the document after making no changes.</td>
</tr>
<tr>
<td></td>
<td>• When opening and checking out a document (CTRL+double-click) and closing the document without making any changes.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Edit metadata upon Check in action</td>
<td>When enabled, the metadata pane is displayed in edit mode after a new version is checked in. This allows the user to enter new metadata. If disabled, the user can check the document back in without editing metadata.</td>
</tr>
<tr>
<td>Clear required metadata fields upon Check In</td>
<td>When enabled, any required fields in the schema are automatically blanked out (current value is deleted) when checking in a new version of a document. The users are forced to fill in the required field prior to checking in the document.</td>
</tr>
<tr>
<td>Reset all &quot;Don’t Show This Message Again&quot; reminders</td>
<td>If you have selected any “don’t show this message again” check boxes in various windows, you can have them reappear by clicking Reset.</td>
</tr>
</tbody>
</table>

4. In the Viewer tab (FDA only), select the check boxes next to the features to enable. Note: These options may be locked down by your system administrator.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PDF/Image viewer only</strong></td>
<td></td>
</tr>
<tr>
<td>Orientation of thumbnail view</td>
<td>Select the position of the thumbnails in the <strong>PDF/Image viewer</strong>: Top, Bottom, Right or Left.</td>
</tr>
<tr>
<td><strong>PDF/Image viewer and Brava viewer</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically open in the Viewer selected document in Inbox</td>
<td>Any selected document in the Inbox will open in the Viewer automatically. If this option is selected, only one tab will be opened at a time. This prevents users from opening several tabs at a time and using up a lot of system memory in the process. <strong>NOTE:</strong> Starting in 2017, Brava viewer licenses are no longer available for new FileHold purchases. Previously purchased Brava viewer licenses are still available for use in the FileHold Desktop Application.</td>
</tr>
<tr>
<td>Open documents in the Document Viewer using separate tabs</td>
<td>Documents will be opened in multiple tabs in the viewer. <strong>NOTE:</strong> This option cannot be selected in conjunction with the “Automatically open in the Viewer selected document in folders and search results” or “Automatically open in the Viewer selected document in Inbox” options.</td>
</tr>
<tr>
<td>Allow opening one document in multiple tabs</td>
<td>A single document can be opened several times in multiple tabs using both Brava and PDF/Image viewers. <strong>NOTE:</strong> This option cannot be selected in conjunction with the “Open documents in the Document Viewer using separate tabs” option.</td>
</tr>
<tr>
<td><strong>All viewers</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically open in the Viewer selected document in folders and search results</td>
<td>Any selected document in the folder view or search results will open in the Viewer automatically. If this option is selected, only one tab will be opened at a time. This prevents users from opening several tabs at a time and using up a lot of system memory in the process.</td>
</tr>
</tbody>
</table>

5. In the Contact Information tab, enter your personal contact information. This is for both the FDA and the Web Client. This information may be filled out if you are an Active Directory user.

6. In the Company tab, enter your organization information. This is for both the FDA and Web Client. This information may be filled out if you are an Active Directory user.

7. Click **OK**.
15.2. **VIEW PREFERENCES**

You can create or modify “views” in order to suit how you want documents displayed. There are several different view types, such as the folder list, checked-out documents, Inbox, Document Tray, and so on. You can customize each view to display specific columns and determine how you want the view sorted and grouped. The views can be made private or public which allows other users to access them. Users can also set a default view which displays the documents according to the default type unless otherwise specified. Changes to your view settings will not affect how other users view their folders or lists.

The following is an example of a folder list view. You can change your view type by selecting an option from the Select View drop-down list.

![Folder List View](image)

The benefit of customizing the views is that the user is able to see key information on a file without having to open up the file or view its metadata. For example, if a user is working in an engineering department and the majority of documents to be stored in the library will have a ‘Part Number’ metadata value associated with it, then the part number field can be added as a column in the user’s folder display.

The number of documents that are displayed per “page” is set in the view preferences. In the FDA, there can be 5 to 1000 documents displayed per page. In the Web Client, there can be 5 to 30 documents displayed per page. The page numbers are shown in the right-hand top and bottom areas of the screen. The number of documents that are shown in the FileHold Office Client window when using the Microsoft Office Add-Ins can also be configured.

![Folder List View](image)

Library administrators can create views and set them as the system default for all users. They can also reset the personal views of other users to a global view of their choice. They can also assign default views to cabinets, folders, virtual folders, and saved searches.
View settings are exclusive to the user; however, Views can be made public allowing other users of the document management system to use them if you are an Administrator. Changes to one user's view settings will not affect how other users view their folders or lists.

**NOTE:** If you are logged in as an Administrator and are modifying a Public View (such as adding or removing columns), the document management software will automatically create a new Personal view using the changes made to the existing Public view.

**TO SET YOUR VIEW PREFERENCES**

1. Do one of the following:
   - In FDA, go to **File > Preferences and Settings > View Preferences**.
   - In Web Client, right-click on **My FileHold** and select **View Preferences**.
   - In the Web Client, go to **Administration Panel > My FileHold > View Preferences**.

2. In My Global View Preferences window, use the following table to fill out the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select View Type</td>
<td>Select the view type you want to customize: Checked Out Documents, Document Alerts, Document Reminders, Document Tray, Folder List, Inbox, Linked Document List, My Favourites, My Workflow Tasks, Recently Accessed, Recently Added, Search Results, Workflow Documents (Show Documents pane), and Virtual Folder. For example, Checked out Documents will customize the My FileHold &gt; Checked out Documents list. Inbox will customize the Inbox view.</td>
</tr>
<tr>
<td>Select View</td>
<td>Select a view from the list if it already exists for that view.</td>
</tr>
<tr>
<td>Add</td>
<td>Click <strong>Add</strong> to create new view. Enter a view name and select if it is a Personal or Public view and click <strong>OK</strong>. A personal view will only visible to you while public views can be seen by all users. Only Administrators can create public views.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click <strong>Edit</strong> to modify the name of the view. Rename the view and/or select a view type (personal or public) and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click <strong>Delete</strong> to delete a view. Click <strong>OK</strong> at the confirmation message. The view is deleted.</td>
</tr>
<tr>
<td>Set as System Default View</td>
<td>When logged in as Library or system administrator, you can add a new System Default View for the system. When creating a new System Default View, you must make the new view a Public view. Then click <strong>Set as System Default View</strong>. Now all users will see this view when logging onto the system.</td>
</tr>
<tr>
<td>Set as My Default View</td>
<td>When creating a new view, you can set it as your own default view. This view overrides the System Default View in any of the view types that do not have a designated view applied to them.</td>
</tr>
<tr>
<td>Create My Personal View</td>
<td>Create a personal view for a view type not seen by any other user such as personal search view or personal virtual folder.</td>
</tr>
<tr>
<td>Current Fields/Columns used</td>
<td>Lists all the column names, their descriptions, and the order they are sorted across the screen. To reorder the columns, select a number from the drop-down list. To remove a column, click the <strong>X</strong>.</td>
</tr>
<tr>
<td>in this view</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add a field (column) to the view</td>
<td>Select a metadata or system value to add to the view from the list and click Add Field. Once you have added a field, you can sort the order of the columns in the Order Column.</td>
</tr>
<tr>
<td>Sort view by</td>
<td>Select the column you want to sort by from the drop-down list and select if you want the documents displayed in ascending or descending order.</td>
</tr>
<tr>
<td>Group by</td>
<td>Select the check box and select how you want the documents grouped. Select a descending or ascending order. This is only available in the FDA. In the example below, the documents are grouped by Document Schema:</td>
</tr>
<tr>
<td>Show x items in this view (Web Client only)</td>
<td>Enter the number of documents you want displayed in the Web Client. Enter a value from 5 to 30.</td>
</tr>
<tr>
<td>Number of documents per page – Main FDA window (FDA only)</td>
<td>Enter the number of documents you want displayed “per page” in the FileHold Desktop Application. For example, if you have 4000 documents in a single folder, then 500 documents will be shown on a “page”. It is recommended that this value be set to 500.</td>
</tr>
<tr>
<td>Number of documents – FOC windows (FDA only)</td>
<td>Enter the number of documents you want displayed “per page” in the FileHold Office Client window. It is recommended that this value be set to 20.</td>
</tr>
</tbody>
</table>
3. Click Apply or OK to save the view settings.

15.2.1. Creating Ad-Hoc Views

You can modify any view by adding or removing columns, grouping documents, expand or collapse groups, or reorder columns “on the fly”.

To create ad-hoc views

1. In any view, right-click on a column header and select one of the following:
   - Group By – Group documents by document name, type, linked, version, status, or last modified date.
   - Add / Remove Columns – Add or remove columns from the view. All system values and metadata values can be added or removed from the view. All values with a check mark beside the name are shown in the view. To remove the column, select the value with the check mark.
   - Add / Remove Columns > Reorder Columns – This opens the Global View Preferences window. You can reorder the columns in the Order column. See View Preferences for more information.
   - Expand/ Collapse All Groups – This expands/collapses grouped documents. You can also click the +/- sign next to the Group Name.
1. For exporting the document list to a CSV file, see Exporting Documents in a View to a CSV File.

15.2.2. Showing the Review or Approval Status in the Folder View

Adding the Review and Approval Status field to a folder view allows the user to be able to tell at a glance the state of approval for all documents contained in that folder. These fields can be added (or removed) in all views including search results, my FileHold, or any other list customizable with the user’s personal view preferences.

TO ADD THE REVIEW OR APPROVAL STATUS COLUMN TO A VIEW ON THE FLY

1. Right-click column header and select Add/Remove Columns.
2. Select Review Status or Approval Status from the list. The Approval Status is added as a column to the view.

TO MODIFY THE VIEW PREFERENCES TO ADD THE REVIEW OR APPROVAL STATUS COLUMN

1. Go to View Preferences and select the view you want to modify from the list.
2. In the Add Field drop down list, select Approval Status or Review Status and click Add Field.
3. Click OK to save changes.

15.2.3. Setting the Default Cabinet Drawer, Folder Group, Virtual Folder, or Saved Search View

Cabinets, drawers, folder groups, virtual folders, and saved searches can have specific views created and assigned to them so that the views are displayed in a certain way. Administrators can create public views in the View preferences area and then assign the default view to the search. Users can also do this for their "My Saved Searches" and "My Virtual Folders" using personal views.

You can set a default view for a folder but it cannot be made default or forced.

TO SET THE DEFAULT VIEW FOR A CABINET, FOLDER, VIRTUAL FOLDER, OR SAVED SEARCH

1. Create a new view to be used. For folders, cabinets, public saved searches and public virtual folders, administrators will need to create a public view. For personal saved
searches (My Saved Searches) end users can create personal views. See View Preferences for more information.

2. Right click on the folder, cabinet, virtual folder or saved search name and select Set Default View.

3. Select the view you want to use from the drop-down list. To use the global default view, select the Use global default view check box.

4. To make this the default view all users, select the Make it the default setting for all users check box.

5. To enforce the use of this view for this saved search, select the Reset all users to use this default setting check box.

6. Click OK to save your settings.

15.3. ALERT PREFERENCES

You can set alert preferences so that you are notified when a change occurs to a document or folder. You can view alerts in My FileHold > Document Alerts and/or receive an email alert, if your system has been configured. In order to receive an alert, you must have set an alert on a document or folder. See Setting Document Alerts and Reminders for more information.

The alert preferences allow you to determine which type of change you want to be notified of, such as a document addition, change to metadata, or when a file is checked. Users can also be notified via email and alerts of specific date-based events call user defined events. For example, policies must be updated or reinstated at least once every three years. The policy team would like to review the documents 60 days before the three-year anniversary. The event can be set up so that every three years, the owner of the policy will be notified 60 days prior to the policy expiry date. User defined events are set on the document schema by the library administrator. For more information, see the Library Administration Guide.

Some, none, or all of these settings may be determined and/or enforced by your system administrator. See your system administrator for details.

TO SET ALERT PREFERENCES

1. Do one of the following:
   - In FDA, go to File > Preferences and Settings > View Preferences.
   - In Web Client, right-click on My FileHold and select View Preferences.
   - In the Web Client, go to Administration Panel > My FileHold > View Preferences.

2. In the My Alert Setting window, select the following folder alert options:
   - New documents/versions are added to folders I have subscribed to.
   - Documents are transferred to folders I have subscribed to.
   - Documents are deleted from folders I have subscribed to.

3. Select the following File (document) alert preferences:
   - A new version of a document I have subscribed to is checked-in.
   - Metadata values are updated for a document I have subscribed to.

4. In the Email Alert Preferences, select the check box if you wish to receive an email in addition to displaying alerts in the My FileHold > Document Alerts area.

5. Enter the email address that the alert should be emailed to.
6. Select an alert frequency:
   - Send email immediately – Sends the email as soon as the change is made.
   - Send a daily summary – Sends the email once per day with a summary of all the alerts.
   - Send a weekly summary – Sends the email once per week with a summary of all the alerts.
7. In the Reminders area, select the Send email… check box to have reminders emailed to the specified account.
8. Select an email reminder frequency:
   - Send email immediately.
   - Send a daily summary.
9. Click OK.

15.4. WORKFLOW PREFERENCES

You can set preferences to be notified via email when certain workflow events involving you occur and delegate your tasks to someone else if you are away from the office for a period of time. See the Workflow and Courier Guide for more information.

15.5. FASTFIND PREFERENCES

FastFind provides search capability from third party windows-based forms applications such as Windows Desktop Applications such as accounting or GIS software. FastFind works in conjunction with the FileHold Desktop Application (FDA). Users can use keyboard shortcut shortcuts that perform searches directly from the chosen application in the document management system to find relevant data instantly.

FastFind is relatively easy to set up and use by most users with some basic instructions; however, FastFind can be leveraged to perform a more dynamic search of the document management system by someone who can work with regular expressions. You can also set up FastFind templates to improve your searches from various third-party applications.

For example, a search in a Microsoft Word document for the term "FastFind" using the shortcut key CTRL + D, returns the search results in the FileHold Desktop Application. In the example below, there are 97 results found.

FastFind searches can be based on a full text search (file and metadata search) or a quick search. If based on a quick search, it will only search on that specific search parameter and nothing else in the system (unlike a full text search which will search through everything).

Advantages of using up a quick search with FastFind would be to be able to limit the search results. For example, if FastFind was only used to locate an invoice in FileHold from your accounting software, the search results would be limited to what documents would be found using “Invoice Number” quick search. See Quick Searches for more information on configuring quick searches.
NOTE: FastFind preferences can only be set in the FileHold Desktop Application. It cannot be set in the Web Client.

Some, none, or all of these settings may be determined and/or enforced by your system administrator. See your system administrator for details.

In order to use FastFind, you must purchase this optional feature. Contact sales@filehold.com to purchase the FastFind module.

To set the FastFind preferences

1. In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These options may be locked down by your system administrator.

2. To enable FastFind, select the Enable FastFind check box.

3. To have the FastFind templates updated when you log onto the document management system, select the Update FastFind templates… check box. Read more about FastFind templates.

4. Select the check boxes for the following shortcut key options:
   - Mouse Search (Alt + S) – Activates an on-the-fly screen scraper. When this is done a green bar appears in the bottom-left corner of the user’s desktop screen. Users can now start moving their mouse over screen form objects such as data fields or field labels. The text under the current mouse position is captured and displayed in the green bar. If a user wishes to search with the captured text they may left click to invoke the FileHold search. This initiates the Full Text and Metadata search in FileHold and the search results are displayed within the standard search results screen. Pressing the ESC button at any time will stop the mouse search mode.
   - Selection Search (Alt + D) – Highlighting a word or string or partial string in a third party application and pressing Alt + D will initiate a Full Text and Metadata search and display results within FileHold application.
   - Clipboard Search (Alt + C) – This uses a 2-step process to search for documents in the Library. First, you copy any text from the screen to the Windows clipboard using traditional “Copy” menu option or the Alt + C shortcut available in most Windows applications. Next, press Alt + C to use the contents of the Windows clipboard to activate a Full Text and Metadata search in FileHold. Since FastFind uses the contents of the clipboard, any string or partial strings can be copied to the clipboard and searched upon.
• Enable screen OCR search (Alt + F) – Allows you to do a search based on the [Click to Tag] functionality. Once the shortcut key is invoked, you can click on the text on the screen or draw a bounding box (rubber band) around the text. Then a search is performed in FileHold to meet the selected criteria from the screen.

5. In the Search using area, select one of the following:
   • File and metadata — Searches document name, metadata, document contents and file properties
   • Quick search — Searches for only the quick search parameter. Click … to select the quick search. To learn how to create a quick search, see Quick Searches.

6. To activate FastFind templates, select the check box next to the template name. Learn more about creating FastFind templates.

7. Click OK.

15.5.1. Changing the FastFind Keyboard Shortcuts

You can change the predefined keyboard shortcuts to a different shortcut key. You would do this if the default FastFind shortcut key conflicts with another preset shortcut key in the application that you are doing the searching from. For example, you can change the mouse search shortcut to Shift + F3 instead of using Alt+S.

TO CHANGE THE SHORTCUT KEY

1. In FDA, go to File > Preferences and Settings > FastFind Preferences. NOTE: These options may be locked down by your system administrator.
2. Click the keyboard shortcut type you want to change (mouse search, selection search, or clipboard search).
3. In the Change Shortcut screen, change the default keyboard combination and click OK.

15.6. RESET MY PASSWORD (WEB CLIENT)

A locally managed user (non-Active Directory user) can change their password at any time. This section describes the process on how to change a password via the Web Client.

To change your password in the FileHold Desktop Application, go to the user preferences.
Note: If FileHold is synchronized with Active Directory, this option is not available. See your system administrator to change your password if using Active Directory.

**TO CHANGE YOUR PASSWORD USING THE WEB CLIENT**
1. In Web Client, right-click My FileHold and select Reset My Password.
2. Enter your current password.
3. Enter your new password twice.
4. Click Update. The new password will take effect next time that you log in.
16. WORKING DOCUMENTS

FileHold makes managing the documents that users have downloaded to their local machine easy. These "working documents" can be ones that have been checked out of FileHold for edit or downloaded as local copies for local reference.

When the user wants to clean up the files that they have downloaded or checked out to their local machine they can do so by logging into the FileHold Desktop Client and using the Working Documents tool.

The Working Documents window displays the contents of the default "local folder"*. It lets users know if the file has been checked out, the local version number and whether it is the last version located in FileHold. This information helps users decide what action to take for each file.

NOTE: The "local folder" is the "My FileHold Documents" folder that is automatically created by FileHold when it is installed on a local computer. This is typically under /My Documents/My FileHold Documents folder.

In order to see documents that a user may have downloaded to folders other than the default folder, the user can clear the Show my local working folder only check box setting. The list of all documents that a user has downloaded or checked out will appear.

Users can then select files one at a time or in groups and using the Synchronize button at the bottom of the results screen, choose which local folder(s) clean-up function they would like to perform. Users have 3 functions to select from:

- Get newer version of files from the library — Downloads a more recent version of a document from FileHold to the local folder when the version on FileHold is newer than the one in the local machine.
• Check-in files that I have updated locally — Checks in files that users have updated locally but not yet returned to the system.

• Remove duplicate or older files that I have on my local computer—Checks for files that are duplicated or are older versions of documents that have newer versions available and deletes them from the local folder.

The Working documents list can be accessed when users are disconnected from the server and working offline, however they will not be able to synchronize the files until they are again hooked up to the server. This means that they may not have access to the very latest version of a document or that any updating that they do to a document offline will have to wait until they are reconnected to the server to be updated in FileHold.

TO ACCESS THE WORKING DOCUMENTS TOOL
1. Open the FileHold Desktop Application.
2. Select Tools > Working Documents. The list of working documents appears.
3. Click Synchronize.
4. Select from the options outlined above.
17. WATCHED FOLDERS

Watched folders create a kind of direct line that allows users to place their documents into the watched folders and from there they are automatically sent to the document management system. Users can create as many watched folders as they need. When a user creates a Watched Folder, the files that are placed there are automatically associated with an existing document schema and metadata and then sent either to the Inbox or to a mapped folder in the Library. Files configured to be sent to an existing folder in the Library can be sent ONLY if the schema selected does not have any required fields missing. If the fields are required and the values are missing, the files will go to the Inbox for processing even if a destination folder has been mapped.

The Watched Folder does not perform Auto-filing because in many cases the files will not have completed metadata values associated with them. However, documents can be tagged quickly en masse the Inbox. Once the files are prepared in the Inbox, the user can then click Auto-File in the Inbox to send all the files to their final destination.

Watched folders are typically used in conjunction with scanning stations; however, you can also use this feature to import a large quantity of documents into the system. When scanning documents, you can set an output folder for the batch and then configure the Watched Folder to watch that output folder for any new scanned images. FileHold will automatically import any new documents from the output folder into the Inbox of FDA or configured folder in the Library. A different output folder for each batch type should be created in the scanning software (QSP) as well as a corresponding Watched Folder should be created for each output folder. See the QSP Best Practices for more information on creating batches. Watched folders should be used when you are scanning documents with Full-Text OCR or no OCR batches. For Zonal OCR scanned batches, use the Manage Imports tool.

Watched Folders can only be created in the FileHold Desktop Application (FDA).

**NOTE:** The following file types cannot be brought into FileHold using Watched Folders: asp, asx, bas, bat, cer, chm, cmd, com, cpl, crt, csh, exe, fxp, hlp, hta, inf, ins, isp, js, jse, ksh, lnk, mda, mdb, mdm, mdw, mde, mdz, msb, msi, msp, bat, ops, pif, prf, prg, reg, scf, scr, sct, shb, shs, tmp, vb, vbe, vbs, vsmacros, vss, vst, vsw, ws, wsc, wsh, and wsh.

**TO CREATE A WATCHED FOLDER**

1. In FDA, go to **Tools > Watched Folders** and click **Add**.
2. In the Browse for Folder window, select the folder that you want to “watch” on your local computer or network drive. For example, select the output folder for a scanned batch of documents.
3. In the Watched Folder Properties window, the Folder Path to the Watched Folder is shown.
4. Select the **Delete input files** check box to automatically delete the files from the folder that is being watched. This keeps the folder clean and reduces the folder size; this could potentially get quite large if you are scanning a lot of documents.
5. To automatically send the files to a specific folder in the Library, select the **Automatically send files to selected folder in FileHold** check box and click **...** to select a destination folder.
6. To set the metadata for the documents, select the **Automatically set metadata for input files** check box and select the Document Schema name from the list.
7. Enter the metadata values. You can determine which metadata fields will receive a fixed value for all the documents by selecting the check box next to the metadata field name and entering a value. If the check box is selected and the metadata field is required, a value must be entered into the field. If the check box for the metadata field is not selected, a
value is not required even if the field is required. However, the “Automatically send files to the FileHold Library” cannot be enabled since the required value is missing and will need to be entered in the Inbox. If the metadata field is set to “read-only”, then you cannot select the check box; this field will always use the default initial value set up in the schema.

8. Select the **Automatically "Send files" to the FileHold Library** to automatically send the files to the set folder location. If you do not select this option, then all files will go to the Inbox instead of being automatically sent to the folder location. This option is not available unless the **Automatically set metadata for input files** is selected.

9. To delete the files that are successfully imported into the library, select the **Delete input files sent to library** check box.

10. Click **OK** when done.


12. To delete a Watched Folder, click the red **X** next to the Watched Folder name in the Watched Folders list.
18. VIEWING ALL FILES IN TRANSFER

If you are moving a bulk load of files into the system, you can view the files that are in transfer into the document management system. This is helpful when you want to see how the file transfer is progressing, or if you need to pause or cancel a transfer.

In the View Files in Transfer window, you can pause, resume, cancel, or clear completed and cancelled transfers into the system. You can also view only those files that are being sent into the Library at the current time.

**TO VIEW ALL FILES IN TRANSFER**

1. In the FDA, go to View > All Files in Transfer. The following table describes the functions in the All Files in Transfer View:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>Puts a hold on the transfer of a document.</td>
</tr>
<tr>
<td>Resume</td>
<td>Removes a pause on a document so it can be transferred into the Library.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels a document from being transferred into the Library.</td>
</tr>
<tr>
<td>Clear Completed and Canceled</td>
<td>Removes all completed and canceled transfers from the view.</td>
</tr>
<tr>
<td>Include “coming from” library</td>
<td>When enabled, all documents being sent to the library and downloaded from the library are shown. If disabled, only the documents that are or will be sent to the library are shown.</td>
</tr>
<tr>
<td>Status: Pending</td>
<td>Shows all documents that pending to be sent to the library with a status of “Scheduled to Send” when enabled.</td>
</tr>
<tr>
<td>Status: Completed</td>
<td>Shows all documents that have been sent successfully into the library with a status of “Completed” when enabled.</td>
</tr>
<tr>
<td>Status: Error</td>
<td>Shows any errors that occurred while sending documents into the library with the status of “Failed” when enabled. TIP: Hover over the “Failed” status to see why the document failed to be sent to the library.</td>
</tr>
</tbody>
</table>
19. REFRESHING THE FILEHOLD SYSTEM

If you have made changes in the Library Administration or System Administration areas of FileHold, you will need to update the FileHold Desktop Application by using the Refresh function. This will load your changes into the application.

**TO REFRESH THE FILEHOLD SYSTEM**

- Go to File > Refresh All.

20. ACCESSING SYSTEM AND LIBRARY ADMINISTRATION

To access the Library Administration or System Administration areas of FileHold:

- In FDA, select Administration > Administration Panel from the menu bar. You will be redirected to the Web Client.
- In Web Client, login and click the Administration Panel link at the top of the screen.

21. VIEWING FILEHOLD REPORTS

You are able to see the reports in the Library tree if the feature has been enabled and you have the correct permissions.

There are two preconfigured reports that can be downloaded from the Knowledge Base:

- Library List Report — Displays the contents of a cabinet.
- System Activity Report — Displays all the logon activities of users.

**TO VIEW REPORTS IN THE LIBRARY**

1. In the Library, go to Reports > FileHold Reports.
2. Select a report from the list and click Show Report. The Report Manager opens.
3. Select or enter the parameters you want to be shown in the report and click View Report. The report results are shown.
4. You can now export the report into a XML, CSV, PDF, MHTML, Excel, Tiff, or Word file.
22. FILEHOLD HELP

To read a help topic, click a question mark (?) in the window. You will be redirected to the relevant topic in the online help.

You can also access the home page for the online help by selecting Help > Help from the menu bar in the FileHold Desktop Application.
INDEX

A

Add Attachment from FileHold, 13
add document wizard
  web client, 71
Add documents, 26
Add File, 4
alert preferences, 148
alerts, 108
  disable on folders, 110
  mark as read, 109
  removing, 109
Assembling documents, 128
  batch jobs report, 134
  using tags, 132
Auto-File, 26

B

Batch jobs report, 134
  how to use, 135
Browse to FileHold, 13

C

cabinet administrator role, 20
cabinets, 55
  auto-tagging, 63
  managing, 55
calendar, 28
Capture, 139
Check out, 5, 8
Check out and Email, 5
Checked Out Documents, 27
Click To Tag, 83
  entering metadata, 84
  connection options, 2
  Convert to offline, 8
  CSV files
    exporting, 77

document owner
  changing, 101
  document publisher + delete role, 18
  document publisher role, 18
Document Reminders, 28
document tray
  clear documents, 113
Document Tray, 112
document URLs, 91
document viewer, 114
  full or partial views, 114
documents
  icon, 22
  actions and functions, 64
  add document wizard, 71
  adding, 69
  adding emails. See emails
  adding from FDA, 70
  adding from Microsoft Office applications, 76
  adding from Web Client, 71
  adding offline documents, 77
  alerts, 108
  cancel check out, 94
  change document owner, 101
  checking in, 93
  checking in from Microsoft Office applications, 94
  checking in multiple documents, 95
  checking in/out, 92
  checking out, 93
  creating shortcuts, 101
  deleting, 92
  downloading to local folders, 103
  drag and drop, 69
  emailing. See emails
  exporting, 102
  exporting to CSV file, 77
  grey dots, 22
  linking, 99
  make a local copy, 95
  managing alerts and reminders, 108
  move or copy, 95
  purple dot, 22
  rectangle with dots, 22
  red dots, 21
  red, yellow dots, 21
  red, yellow, green dots, 21
  reminders, 108
  removing links, 100
  renaming, 102
  setting alerts and reminders, 108
  setting destination folder, 91
  version history, 104
drawers, 55
  managing, 55
duo, 9

E
Edit Destination, 26
Edit metadata, 8
Edit Metadata, 26
electronic documents, 80
electronic records, 80
Email, 5
e-mails
adding, 72
adding only attachments, 75
e-mail and check out, 98
e-mailing attachments, 96
emailing documents, 95, See emails
e-mailing links, 96
extraction rules, 73
from Web Client, 97
Microsoft Outlook, 98
Microsoft Outlook Watched Folder, 73

F
FastFind
changing shortcut keys, 151
clipboard search, 150
enable, 46
mouse search, 150
preferences, 149
screen OCR search, 151
selection search, 150
FDA, 1
accessing, 1
connection options, 2
Inbox, 25
log in, 3
menus and toolbars, 4
refreshing, 158
shortcut keys, 5
FileHold
about, 1
accessing, 1
FileHold Desktop Application. See FDA
FileHold viewer
annotations, 125
highlight search results, 124
page manipulation, 121
publish as PDF, 127
files in transfer, 157
folder groups, 55
assigning to a folder, 56
delete, 57
deat, 57
managing, 55
statistics, 57
folders, 57
archiving, 62
auto-tagging, 63
cloning, 62
colour, 60
creating, 59
default view, 62
deleting, 61
managing, 57
moving, 62
properties, 61
statistics, 62

G
Get a copy, 8
limited user role, 17

H
help, 159
hotkeys, 5

I
icons
document permissions, 21
Inbox, 25
shared inbox, 25
shared inboxes, 6

L
library
cabinets, 55
drawers, 55
folder groups, 55
folders, 57
inbox, 23
library archive, 24
library tree, 24
My FileHold, 23
recent folders, 23
reports, 24
reviews and approvals, 23
search, 23
structure, 54
structure overview, 23
virtual folders, 24
Library Administration
accessing, 158
library administrator role, 20
library archive, 111
manually archiving, 111
moving documents back to library, 111
moving objects to archive, 111
scheduled archiving, 111
Link, 8
Link documents, 5
linking documents, 99
local copy documents, 95
log in
FDA, 3
multi-factor authentication, 9
webclient, 7

Make a local copy, 4
metadata
Click To Tag. See Click To Tag
copying, 90
database lookups, 87
document URL, 80
editing, 90
entering, 78
entering for a single document, 81
entering for multiple documents, 81
FileHold ID, 80
format, 80
has markups, 80
library location, 80
library status, 80
link to a web page, 91
owner, 79
size, 80
type of file, 80
version, 79
metadata pane, 78
mfa. See multi-factor authentication
Microsoft Office applications, 12
accessing, 1
adding documents, 76
checking in, 94
FOC window, 13
Microsoft Outlook
adding emails, 72
Move/copy, 8
multi-factor authentication, 7, 9
My Favorites, 27
My FileHold, 27

offline documents, 77, 80
organizer + delete role, 19
organizer role, 19

passwords
lost or forgotten, 14
reset, 15
user id, 15
PDF Image viewer

closing, 119
delete pages, 118
drag and drop, 118
drag and drop image, 119
insert files, 118
insert image file, 118
modify images, 118
modifying files, 117
printing, 119
publish as PDF, 118
reorder pages, 117
save image file, 119
undocking, 119
permission icons, 21
preferences, 136
publisher + delete role, 18
publisher role, 18

QuickScan Pro, 139

read-only role, 18
recent folders, 29
Recently Accessed, 28
Recently Added, 28
reminders, 108
mark as read, 109
removing, 109
Remove from Inbox, 26
reporting services
reports, 158
reviews and approvals, 107
roles and permissions, 17

scanning. See Capture, See QuickScan Pro
search, 30
"and" connector, 35
"not w/n" connector, 36
"not" connector, 36
"or" connector, 36
"w/n" connector, 36
# phonic, 35
% fuzzy, 35
& synonym, 35
* wildcard, 34
? matches any character, 34
~ stemming, 35
= matches any digit, 34
accessing, 30
advanced search, 37
Advanced Search, 30
boolean, 34
contains in db, 31
contains in fts, 31
empty saved search, 45
FastFind, 30, 46
for documents in a workflow, 47
for previous versions, 47
fts wildcard limitation setting, 33
full text search, 36
general usage, 32
integrated with external applications, 47
noise words, 32
proximity, 36
quick search, 44, 47
regular saved search, 44
request types, 33
saved searches, 43
search operators, 42
security, 31
simple search, 36
Simple Search, 30
url builder, 49
words and phrases, 35
Send, 26
Send All, 26
Send to > Email, 9
Send to > Email and check out, 9
Send to > Library archive, 9
Send to > Tray, 9
Send to > Virtual folder, 9
Send to FileHold > Add Document, 13
Send to FileHold > Check In Document, 13
Send to FileHold > Send Review / Approval Feedback, 13
senior library administrator role, 20
sign off sheet, 106
System Administration
accessing, 158
system administrator role, 21
user preferences, 74, 137

V
version history
deleting previous versions, 105
document usage, 106
reinstating previous versions, 105
reviews and approvals history, 107
sign off sheet, 106
viewing, 104
viewing metadata edits, 106
viewing previous versions, 104
version properties
document URLs, 91
view preferences, 143
ad-hoc views, 146
setting default view, 147
workflow views, 147
viewers
publish as PDF, 127
viewers, 114
annotations, 125
FileHold viewer, 119
level 1, 119
level 2, 119
PDF/Image viewers, 115
viewing
files in transfer, 157
virtual folders, 52
adding documents, 52
creating, 52
deleting, 52
removing documents, 53

W
watched folders, 155
web client, 7
accessing, 1
log in, 7
menus and toolbars, 7
Web Client
reset password, 152
workflow
reviews and approvals history, 107
sign off sheet, 106
workflow preferences, 149
working documents, 153